
ISSN 

0 744 70 92596 5 
Issue 4 •10 . 95 USD $13.50 CANADA 

155VE #4 





4 EASY WAYS TO ORDER 
1. In our online store at 

www.dmgpublishing.com 

3. Phone 1-888-778-9283 

or 1-702-990-8656 

2. Fax to 1-702-616-9647 4. Mail to: DMG Publishing 

Name 

2756 N. Green Valley Pkwy #261 
Henderson, NV 89014 USA 

Address __________________________________________ _ 

City/State 
Zip/Postal Code _________________ _ 

Count~------------------------------------------­
Telephone ------------ ----- ---
Email ____________________________________________ _ 

PAYMENT 
0 I'm enclosing a check in US Dollars payable to DMG Publishing 

0 I wish to pay by crediUdebit card 

Card# __________________ Exp Date ___ _ 

Signature _______ ___________ Date _____ _ 

Go to www.hdri3d.com for more info! 

ONLINE SPECIAL OFFER 
0 US $49 0 Rest of World $68 

Subscribe to HDRI 30 Magazine 
online before June 30, 2005 

to get this great discount! 

Six issues a year 

HDRJ3[] 
Issue #4 

PUBLISHER 
Alice M. Edgin alice@hdri3d.com 

EDITORIAL DIRECTOR 
Charles A. Edgin charles@hdri3d.com 

EDITOR-IN-CHIEF 
DanAblan 

MAYA EDITOR 
Dariush Derakhshani 

dan@hdri3d.com 

dariush@hdri3d.com 

SOFTIMAGEIXSI EDITOR 
Raffael Dickreuter raffael@hdri3d.com 

TECHNICAL EDITOR 
Brad Carvey 

MANAGING EDITOR 
Amber Goddard 

ART DIRECTOR 
David S. Wilkinson 

LAYOUT/DESIGN 
Sabre Design 

CONTRIBUTORS 
Tim Albee 
Deuce Bennett 
Bill Blakesly 
Andrea Carvey 
Brad Carvey 
Daniel Champion 
Charles A. Edgin 
Simon Goodall 
Aaron Kent 
Boaz Livny 
Peter Ratner 
Alexander Shareef 

bradcarvey@hotmail.com 

amberg@hdri3d.com 

david@sabredesign.net 

artists@sabredesign.net 

timothya@gci.net 
deuce@cimagineering.com 

bblakesley@shawscience.com 
andreacarvey@hotmail.com 

bradcarvey@hotmail.com 
dtr_champion@yahoo.com 

char1es@hdri3d.com 
simon@goodallarts.com 

kindofshiftless@yahoo.com 
blivny@visionanimations.com 

ratnerpj@jmu.edu 
shareef@dx-digital.com 

HDRI 3D MAGAZINE ADVISORY BOARD 
Timothy Albee • Akiko Ashley · Jack "Deuce• BenneN II 
Stephen M. Bums • Kevin Cahill • Dwayne J. Ferguson 

Todd Grimes • Ed Harriss • Varto Keshishian 
Po/icarpo • William Vaughan 

ADVERTISING SALES 1-702-990-8656 
advdmg@dmgpublishing.com 

SUBSCRIPTIONS & BACK ISSUES 
Online Store www.dmgpublishing.com 
Email mag@hdri3d.com 
Phone 1·702·990·8656 or 1·888·778·9283 

CHANGE OF ADDRESS moving@hdri3d.com 

HDRI 3D MAGAZINE 
(ISSN 1551-689X) 

is published bimonthly by DMG Publishing 
2756 North Green Valley Pkwy #261 

Henderson NV 89014 USA 

© 2005 by DMG Publishing. All Rights Reserved. 
No part of this publication can be reproduced or 
transmitted in any form or by any means, electronic 
or mechanical including photocopying, recording, 
or information storage and retrieval system without 
permission in writing from the publisher. 



DANABLAN 
EDITOR-IN-CHIEF 

INFORMATION 
IS POWER 

Many people that 
I train and deal 

with on a daily basis 
still have that excite­
ment about 3D. They 
find anything in their line 
of sight and get excited 
about modeling it. That's 
great! As I'm reading 

through the tutorials our awesome contributors 
have supplied for this issue, I'm actually feeling 
a bit of that excitement too. It doesn't matter what 
software application is being used -just seeing a 
cool technique can spark many ideas! 

Recently, I attended a Photoshop conference 
here in Chicago. It was cheap and close to my of­
fice, so I figured 'why not." I thought I knew how to 
use Photoshop, even though there are many areas 
I rarely touch. To my surprise, I learned quite a bit, 
and in fact, more than I expected. Something I've 
said many times before that I have to also remem­
ber is; you never stop learning. There is always 
another approach to something and always more 
to learn. 

With this issue of HDRI 3D, we've put together 
some exciting tutorials for you. Each one has 
something for you to learn from, and even if it's 
using a program that you don't use, read through 
it and soak it up. And what can you gain from this? 
Let me put it this way; one of the worst things you 
could be in life is narrow-minded. 

Take this scenario: Imagine your livelihood relies 
on selling training to people. You're doing this be­
cause you've burnt your bridges with studios around 
town and no one wants to work with you. In order for 
you to sell your wares, you rely on calling people 
you don't even know and instead of informing them 
of how they can learn from your past knowledge, 
you instead talk poorly about your competition and 
insult their work. However, people soon realize that 
not only do you have no talent, but you're a low­
class citizen as well. All the talk hides the true fact 
that you aren't doing the kind of work you wish you 
were. Deep down, you know it's all true. In the end, 
all you had to do was be open to new ideas. 

Try new things, and remember that you should 
never stop learning. You have a choice folks - never 
close any doors. 
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DARIUSH DERAKHSHANI 
MAYA EDITOR 

KOOSHLJNGS 

Recently, I started 
working on a feature 

at a studio with a dear ma­
jority of LightWave people. 
At first, until my desk was 
ready, I sat with the nice LW 
folks, fearing an attack at 
any moment from behind. 
A bat to the skull, a Wacom 
pen to the neck, mouse 

cord around the throat from the first second I launched 
Maya in a room full of LW screens. The pummeling 
never did come, but I did get into some of the most 
interesting conversations I've had in a while. 

I've been in this for some time, and into computers and 
software for a while before that. The argument I always 
catch, overhear, or tumble into is whars better than what. 
What package runs a better particle sim, which handles 
character work, but more so than anything else, what 
should I use for my studio? The thing is, between the 
time that that question starts and when it ends, things 
have radically changed in the CG landscape. We've 
gotten to a point where most packages can handle most 
tasks well. But the question that people shculd confront 
earlier is who and not what. 

I remember a long time ago, at an architecture firm far 
from this world, I helped integrate CAD into their work­
flow. One afternoon, one of the firm's partners standing 
over my shoulder and looking at some plans remarked, 
'Wow, this software does great work." I know what he 
was really saying with that, but I can't help but feel that 
people get lost in software. Whenever someone asks 
me what I recommend, I tell them what I think, but there 
is always a discussion that fol lows with more "buts" and 
'ors' than a canoe and ass party. 

But it comes down to this: everyone hates everything 
they work on, nothing does what it's supposed to, and 
everyone wants something better. Hell, if I could stom­
ach the implications I would love to hook my cortex up 
to a Firewire port and just lay down for the day. (No, use 
USB 2.0!) See what I mean? Applications don't matter. 

Clear and simple: with the right people you will get what 
you need from just about any of the leading packages. 
And the same goes for computer hardware. If I am wit­
ness to another PC v. Mac debate, I will have to bring 
about The Rapture. Work with what you got. If you are 
looking to get, get what you can afford and what those 
who you hire can use. Everything else is really sweating 
the small stuff. It should be about getting the best work 
out and not killing yourself or your people over it. 

SOFT/MAGE IXSI 
HAPPENINGS 

I f you are working in 
production, you know 

how much you can benefit 
from the skills of your team­
mates if you run into prob­
lems and they can quickly 

RAFFAEL DICKREUTER help you out. Usually, all 
SOFTIMAGEIXSI EDITOR the people within a team 

have their opinions about 
the software they are using and have tons of ideas what 
changes would make that software much better. At the 
first meeting of the new Los Angeles SOFTIMAGEjXSI 
user group in March, you could meet some of the most 
skilled SOFTIMAGEIXSI users around. Having all these 
skilled and experienced people from different studios 
such as Omation, Stan Winston Digital, Pixel Liberation 
Front, and others discussing production issues in a 
discussion panel session was certainly a highlight of this 
user group meeting. 

Other presentations were held by Kim Aldis and 
Bradley Gabe, who presented their thoughts on 
the challenges faced by large and small studios. 
By comparing the challenges, it showed, ironically, 
that larger studios need to find a way to scale down, 
while smaller shops need to introduce a semblance 
of linearity to their pipeline. 

Andy Jones of Pixel Liberation Front talked about 
their work on Sky Captain and the World of Tomorrow. 
He explained the use of render passes and a layered 
production prooess. Derek Fisher and Matt Young talked 
about their role in the production, as well. Cloud Painter 
Matt told a funny story about ironic feedback from the 
supervisors when he basically used real photographs of 
douds and they were seen as "not realistic enough." 

After the presentation by SOFTIMAGE Special 
Projects' Michael Isner and Thomas Kang, which 
included a .ma camera importer and the discussion 
panels, the guys from Omation Studios talked about 
the "Barnyard" production prooess. They amazed the 
crowd by showing a much extended and newly built 
Netview that would allow them to add a lot of tools 
for their artists. Helge Mathee, Jason Barlow, and 
Graham Clark were present to answer the questions 
the impressed crowd had, but couldn't reveal more 
about the production that is still in progress. 

SOFTIMAGE recently launched a new challenge 
called "Lock and Load," where aspiring 3D artists can 
submit mods they created using the free ModTool 
and win a lot of prizes. Besides that, they also 
released a new mod exporter for Unreal Tournament 
on the SOFTIMAGE Web site. 
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BY DAN ABLAN, RAFFAEL DICKREUTER, AND PART 2 - FX LINK 

DARIUSH DERAKHSHANI Using FX Unk and FX Unker to take something that 
is inherently difficult and make it fantastically simple. 

BD 6ALLERY BY ANDREA CARVEY 

FEATURING ALEX DINNIN, GUNTHER HEINRICH, 
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Boaz explains how to improve the detail in your 
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renders using mental ray's occlusion texture. 
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Part 2 of Peter Ratner's rigging portion of his 
Setting Up the Human Model for Animation series. 
BY PETER RATNER 
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The sculpting of Lord Richard Ribbitt in 

Two tutorials in one! A side-by-side comparison 
3D Digital space of the same techniques done in both Maya 
BY SIMON GOODALL AND DANIEL CHAMPION and LightWave. 

BY ALEXANDER SHAREEF 

55 UV MAPPIN6 A COMPLEX CHARACTER 
The nitty gritty of UV mapping. Bill highlights 
several iterations, complete w ith tips and pitfalls, 

71 RE-WRITING THE RULES- FACIAL ANIMA TIDN while mapping a full character. 

Tired of cumbersome workarounds? Still waiting BY BILL BLAKESLEY 

for software to do what you need it to do? Find 
66 LIGHT FUSION: 

out how Tim Albee stopped waiting and re-wrote 
DON'T OVERWORK YOURSELF 

the ru les for facial animation. 
Compositing for more flexibility and creative 

BY TIM ALBEE 
freedom. Deuce shares techniques as he takes you 

71 TOUCH AND GO 
through a recent project he did for a client. 
BY DEUCE BENNETI 

When it comes to fast and affordable data 
storage, just how new and improved is the 72 ARTERY DISPLACEMENT SURGERY 
Maxtor OneTouch™ II? Want to rustle up work in medical modeling and 
BY CHARLES EDG IN visualization? Learn how to model a human artery, 

create a texture map in Photoshop, then animate 
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THE SCULPTING OF LORD RICHARD RIBBITI IN 30 DIGITAL SPACE 

Excerpt from The life and Times of Lord 

Richard Rlbbitt: 

Playford River, deep within the 

heart of the rural Suffolk country­

side, is a sleepy little town - and Lord 

Richard Ribbitt likes it that way. No 

adventures for him. No strange visi­

tors, no nothing, just the trickle of the 

Rumble Falls and the rustle of his Am­

phibian Timesm. It's always the same 

for His Lordship - oh yes, in case you 

ever have the fortune (or misfortune) 

to encounter Lord Richard Ribbitt 

you must remember to refer to h im 

always as "His Lordship," for it is 

part of Playford legend as to the fate 

of the first frog to misplace the title 

in his greeting - the sun rose silently 

over the serenity of the river as it did 

yesterday and the day before. The 

dew dripped from the bushes over­

head. The clothed giants with their 

loud sticks could be heard far beyond 

the Fairway Fields. More pheasants 

would be plucked and gutted in the 

clothed giant's castles this evening. 

His Lordship turned from the sound 

with disgust and lifted the newspaper 

to his nose again. Squeezing his mono­

cle over his left eye, he returned to the 

story of the local painter who made his 

home further down the river. Lucius 

Lillywhite had apparently grown tired 

of painting the same fields, the same, 

bushes, and the same riverbank. He 

wanted it known that he intended to 

leave the river in search of brave new 

inspiration. He was to embark on an 

adventure. His Lordship looked up 

from the newspaper ... 

I 
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THE PHANTOM DESKTOP STYLUS 

I 
n this tutorial, I w ill explain how the 

Freef orm® Modeling Plus™ system 

was responsi ble for breathing life 

into His Lordship. 

The usage of the FreeForm® Modeling 

Plus™ system is revolutionizing the way we 

sculpt. The utilization of the PHANTOM® 

Desktop device, essentially a modeling 
knife in digital space, allows the user to 

miraculously feel the cyber clay he or she is 

sculpting, g iving the artist the freedom of 

reality within the digital language. 

Upon start-up of the Freeform Modeling 

Plus system, the artist will notice a large block 

of buff colored clay in the middle of the win­

dow. The clay can be moved using a mouse, 

keyboard keys, or the PHANTOM Desktop 

device. To use the mouse it's a simple left­

click over the clay to rotate it, a right-click 

to zoom it, and a middle-click to pan it. 

Keyboard users can employ their faithful 

arrow keys for the same functions and those 
w ith one foot in the 2:znd Century can show 

off with the PHANTOM Desktop device, the 

method of choice for most FreeForm Model­

ing Plus users. To grab the block of clay, a 

function ingeniously ca.lled '"grabbing," press 

and hold down the "g'' key on the keyboard 

and move the PHANTOM Desktop's stylus in 

any direction to move and tumble the view. 

PRELIMINARY SKETCH AND REFERENCE MATERIAL ARE PREPARED BEFORE SCULPTING 

The PHANTOM allows a full six degrees of 

freedom in movement (in and out, up and 

down, le.ft and right, pitch, roll, and yaw), and 

three degrees of force feedback (in and out. 

up and down, and left and right). 

The PHANTOM Desktop device can also 

be used as a mouse w ithin the FreeForm 

Modeling Pius system. With the selection 

of the Carve with Ball tool, for example, 

when the stylus is held by the artist (as you 

would a pen) over the clay, the cursor re­

mains a tool. When the stylus is held over 

any menu feature, i t becomes a recogniz­

able cursor. This simple device offers a.li 

the functions of the mouse and keyboard 

in one easy-to-use instrument. 

There are a plethora of tools available 

w ithi n the Freeform Modeli ng Plus sys­

tem, but for the sake of this tutorial, only 

the tools used to create this character 

w ill be discussed at length. These are the 

Carve w ith Ball tool , Smooth tool, Tug 
tool, and Smudge tool. I t can be said that 

there are no words adequate enough to 

communicate the sensation of working 

withi n this system, of designing and 
build ing w ith the PHANTOM Desktop 

device and of feeling every inch of clay 

without getting your hands di rty. it can 

also be said that working within 3D digi-

tal space w ill take some time to master, 

but practice makes perfect, and wi thin 

the FreeForm Modeling Pius system, 

perfection will become a standard. 

And so to the characters of Playford 

River and Lord Richard Ribbitt, master of 

all he surveys. His Lordship is essentially 

created in a number of separate pieces. 

This allows a great freedom in later 

stages with individual positioning and 

offers an almost limitless freedom in the 

relationship between neck and chin, arm 

and hand, hand and newspaper. 

Prior to the commencement of sculpt­

ing, research is carried out to build a 

library of reference material relating to 

the figure to be sculpted. in this case, 

a considerable amount of photographic 

reference is accumulated to help un­

derstand the external biology of Great 
Bri tain's common frog. 



STAGE ONE- IT'S ALL IN YOUR HEAD: 

Using a combination of keyboard 

shortcuts and the PHANTOM Desktop 

device, the selection of the Tug tool locks 

the digital sculpting knife onto the block 

or sphere of clay like a spoon on treacle 

and gives the artist the effect of pulling 

and pushing on a very strong elastic 

band. Releasing the clay at any given 

poi nt will leave i t at the desired position 

for the shape of the sculpture. In the case 

of His Lordship, a sphere of clay is used 

to mold his aggressive glare. Other tools 

come into play now: Carve with Ball (to 

scu lpt into the clay with a hard edged 

tool) and Smudge (to smooth the clay 

with less abrasive angles). The basic look 

of His Lordship is established in these 

initial movements, on one side of the clay 

only, with pulling and pushing working 

in unison to develop his wide mouth and 

crumpled eyelids. His Lordship's eyes 

w ill be created as separate images to be 

combined with the finished head during 

the final stages. Once the work on this 

side is complete, albeit in a crude form, 

the entire sculpture is duplicated for 

the other side by selecting Mirror Entire 

Image, to complete the symmetrical 

amphibian head. The mirror may appear 

in the workspace exactly where needed, 

but if not, can simply be moved by use 

of the Positioning Aids on the Dynabar (a 

combination of the words Dynamic and 

Toolbar) at the base of the workspace. 

This is a highly convenient feature of 

the Freeform Modeling Plus system and 

greatly reduces sculpt time, sig nificantly 

lightening the demands on the artist. 

STAGE TWO- SO MANY APPENDAGES: 

A new piece in the Object List and a 

larger sphere of clay are selected for 

His Lordship's ever increasing torso, 

which consists of his shirt collar and 

jacket molded over the bulk of his chest. 

The eyes. bowtie, legs. hands, news­

paper, and monocle are, as the torso, 

all individual elements to be combined 

later. The size and tightness of the shirt 

collar and jacket must be considered 

in the careful relationship between His 
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USING THE TUG TOOL TO SCULPT AND SHAPE THE HEAD 

USING THE MIRROR TO DUPLICATE ONE SIDE ONTO THE OTHER 

Lordship's head and separate body ele­

ments. These dimensions. although not 

measured with pinpoint accuracy, must 

be designed to sit comfortably under the 

chin to create the lived -in appearance of 

His Lordship's clothing. 

Once again, a new piece is selected 

from the Object List and the sculpting 

of His Lordship's left arm begins. This 

I 
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BLOCKING THE OVERALL SCULPT 
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CLAY COARSENESS IS REFINED ENABLING THE ADDITION OF GREATER DETAIL 

procedure is identical in terms of tools 

used and is repeated for the remaini ng 

elements: the hand, bowtie, monocle, 

string, and newspaper. 

As an addendum to this stage, it 

should be noted that in the case of the 

newspaper, the item could be sculpted 

using the Construction menu , which 

would allow measurements to be calcu-

lated with the aforementioned pinpoint 

accuracy. This intelligent feature wi ll 

probably become invaluable in the 

construction/ engineering business, but 

for the sake of emulating an organic 

environment for His Lordship, The Am­

phibian Times is simply sculpted using 

the tradi tional tools. 

Sf AGE THREE- IT'S ALL IN THE DET Al/S: 

Once initial blocking of His Lordship 

is complete, it's time to look deeper 

and begin to add the finer details: warts 

(don't tell His Lordship we refer to them 

as warts), wrinkles and folds in the flesh, 

nostrils, and rings around the eyes. The 

Attract tool is the best way to accomplish 

the bulk of this stage, and its usage 

couldn't be easier. Select the Attract 

tool and, while holding down the stylus 

button, run the tool across the area of 

the face that needs to be detailed. The 

clay pulls toward the tool and shaping 

becomes a matter of how far the clay is 

pulled. However much His Lordship likes 

to believe he's a complicated individual, 

he really is that simple. 

This stage also encompasses the tex­

turing for the jacket. A ser ies of curved 

lines are drawn over the contours of His 

Lordship's jacket to tell the program 

exactly where the tex tu re (embossed 

image) must adhere. In the Construct 

menu , Draw is selected and acts as a 

simple pencil , allowing curves to be ap­

plied onto the surface of the clay . 

Atten tion then turns to Special Effects 

found under Tools, and selecting Emboss 

with Image brings up a Dynabar at the 

bottom of the workspace. A thumbnail 

image of the texture to be used w ill 

appear in the Dynabar. To change the 

image (jpeg/ bitmap), simply click the 

thumbnail and choose from any image 

directory. Activating the curves on the 

clay will emboss the image and once ap­

plied, scale, distance, and direction can 

be manipulated by use of the stylus and 

stylus button (emboss.tiff). The texture 

adheres to each individual fold and 
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r ipple and His Lordship now has a fully 

fleshed out jacket. Mention should also 

be made to the painting of His Lordship: 

if you have ever used a paint program 

before, you know how to paint in the 

FreeForm Modeling Plus system. 

STAGE FOUR- MONOCLE, MY MONOCLE.: 

Essentially, a stage that can be completed 

at any point during the sculpting process 

due to the limitless resizing options in 

FreeForm Modeling Plus, the creation of 

His Lordship's monocle nevertheless, feels 

like the finishing touch. 

From the Construct tab, the Construct 

Environment is selected. This has its own 

menu from which the New Plane/Sketch 

icon is selected. The monocle is easily craft­

ed using two planes. From the Construct 

Environment, a New Plane is selected, and 

then w ith the Orcular Line tool, a single 

click on the plane affixes the curso r. Still 

using the sty lus, the cursor is pulled out 

from the center as far as desired to create 

a circle. The procedure is repeated to form 

a rim, a thick drcle between the two lines. 

With the monocle circles formed, the time 

for a W ire Cut is just around the corner. His 

Lordship is consulted at this point for his 

approval and distracting though he is, the 

tutorial is over halfway through, so the best 

thing to do is simply ignore him. 

So, once the planes are the desired dis­

tance apart. Create Inside is selected on the 

Wire Cut Dynabar; the FreeForm Modeling 

Plus system then creates the circle of clay 

and the planes disappear. 

The same procedure is followed for the 

creation of the frame with the leaves and 

happy little Dragonfly, sculpted w ith the 

Freehand Curve tool on the Sketch Toolbar. 

The leaves and twigs are also duplicated 

using the basic copy and paste procedure 

familiar to all PC users. 

STAGE FIVE - MANY POSmONS: 

His Lordship is now ready to be com­

bined. This is the part he dislikes the most 

- apparently it tickles. Each individual piece 

PCIJtJ ~- ~-J'P I J ~l~ 1 ~- 1~ I~ 
tier .......... 

PLANES USED TO DRAW WIRE CUTS AND CREATE SIMPLE OR COMPLEX GEOMETRIC SHAPES LIKE THE MONOCLE 

PIECES CAN BE SELECTED, COPIED, AND PASTED AS NEW PIECES LIKE THIS LEAF 

is listed in the O bject List: head, torso, arm, 

hand, etc., and by clicking on an item, 

the piece can be moved (within obvious 

amphibian limitations) to any space on 

the model. This is where knowledge of 

anatomy is most helpful, for example, in 

understanding the relationship between 

amphibian limbs and their correlation to 

each other in the more human form o f His 

Lordship. How high should his collar sit? 

• 
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HIS LORDSHIP IS POSITIONED AFTER LIGHTING, RENDERING PLANES, AND MATERIAL PROPERTIES HAVE BEEN SET 

How close should his arm be to his torso? 

How big should his hand be in relation 

to his arm? All these factors are carefully 

considered in this final construct to give 

the best, most organic representation to 

His Lordship. 

Sf AGE SIX - I'M READY FOR MY aDSE-UP: 

Now that His Lordship is successfully 

sculpted and a frame worthy of his regal 

features is complete, the rendering can 

begin. Figure and frame are rendered 

separately to achieve the right juxtaposi­

tion; lighting for His Lordship will appear 

quite natural while lighting for the frame 

will imitate an enclosed environment. In 

the Rendering menu, lights are positioned 

and created and Rendering Planes selected 

using the stylus. Because His Lordship 

was created in pieces, specific material 

properties can be applied to each separate 

piece. When selecting the .. head" from the 

Object List and the material properties on 

the Rendering menu, the Dynabar displays 

an array of options: readymade material 

properties such as glass, gold , and rubber, 

as well as the option to customize specific 

material by using the sliders to represent 

shine, gloss, reflection, and translucence. 

Color can also be applied, although His 

Lordship's head has already been painted 

so only slight shine and gloss is g iven to 

imitate his wet skin - of which, by the way, 

he is very proud. A matte, opaque quality 

is maintained for The Amphibian Times 

and His Lordship's clothing, and for the 

monocle, the readymade material "bronze" 

is chosen. 

The entire workspace is essentially a 

camera lens, so His Lordship is positioned 

according ly. The rendering planes are po­

sitioned close to the subject and enlarged 

for sufficient surface area to reflect enough 

light. Once satisfied with the lighting, 

material properties, position of the render­

ing planes, and subject, the quali ty of the 

render is defined. Selecting the Render 

Properties tab, the Dynabar offers three 

quality settings: Low, Medium, and High. 

The default is a fast test render with the 

quality set to Low , Light Quality 100, and 

Pixel Ratio 320x480. For this particular 

render (and being careful not to upset 

His Lordship), the overall quali ty is set to 

High, Light Q uality 2000, and Pixel Ratio 

1280x 10 24. Depending on PC spec. some 

higher settings may demand a very long 

wait, so beware His Lordship 's patience 

and short temper. 

When rendering is complete on His Lord­

ship and the frame, both are saved as Bitmap 

Images and imported into the photo edit 

program of choice. Little needs to be done in 

this stage and ifs safe to say this touch-up is 

all based on personal preference. 

LASf WORDS- U.APFROG TO THE RilURE: 

Lord Richard Ribbitt, now immortalized 

w ithin the dig ital realm can, at any point, 

be physically reproduced within the real 

world of Rapid Prototyping. This is w here 

His Lordship w ill feel the enormous possi­

bilities the FreeForm Modeling Plus system 

can afford him and those like him. ~ 

For this sculpture, a Dell Workstation running 
Windows2000 Pro was used. Dual Pentium 4 2GHz 
processor, Nvidia Quadro 4 750XGL graphics card, 
2GB RAM. 

The recommended minimum is: Intel Pentium single 
2.0 GHz or dual 1.0 GHz; 1 GB RAM; Windows2000 
SP3 or Windows XP Professional SP2; an EPP or ECP 
compatible parallel port; a qualified graphics card (a 
list of cards can be viewed at SensAble's Web site: 
www.sensable.com). 

Sculpture by Simon A. Goodall 
simon@goodallarts.com 

SIMON GOODALL WAS 
BORN IN IPSWICH, 
SUFFOLK, ENGLAND IN 
1975. SINCE CHILDHOOD, 
HE HAS HAD A FASCINA­
TION WITH ALL THINGS 
FANTASTICAL. HE HAS 
BEEN WORKING AS A 
SELF-EMPLOYED 'DIGITAL 

SCULPTOR' FOR NEARLY FIVE YEARS, AND HAS 
WORKED PREDOMINANTLY WITH SENSABLE'S 
FREEFORM MODELING PLUS SYSTEM SINCE 
1999. BEFORE ADVANCING HIS CAREER WITH 
COMPUTERS, HE HAD STUDIED AS A FINE 
ARTIST AND SCULPTOR AT THE UNIVERSITY OF 
HERTFORDSHIRE. UPON LEAVING ACADEMIC 
STUDIES, HE FELL INTO A JOB MODELING TOYS 
FOR POPULAR LICENSED BRANDS SUCH AS 
DISNEY AND HASBRO. OTHER CURRENT WORK 
INCLUDES CONCEPTUAL DESIGN ILLUSTRATION 
AND STORYBOARDING FOR TELEVISION. SIMON 
ALSO ENJOY PAINTING. 
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PART 2 • FX LINK 

I 
n the last issue, I examined FX Linker 

and used it to clone an object (in that 

case, either an apple o r banana) and 

shoot a bunch of clones into the air. Hope­

fully, you were able to duplicate my efforts 

without too much difficulty. As promised, 

FX Link will be explored in this issue. I w ill 

also provide a brief chart comparing the 

two similarly named effects. 

I will be using the same scene setup 

as w ith the FX Linker article so that it will 

be easier to d istinguish the difference 

between the two effects. 

Basically, you set up a particle emitter 

and then '"link" an object to the motion of 

one of the particles. The difference between 

FX Link and FX Linker is that FX Link creates 

a link between an individual object and a 

particle. As always, there are pros and cons 

for each of the tools, and which one you use 

will depend on what you need to do. 

SET UP THE HV EMmER 

BEGIN W ITH CLEARED SCENE 

ADD HV EMriTER 

1. Open the PartlcleFX Browser - Scene I 
FX_Browser (in the Tools/Dynamic section) 

2. Select '"HV Emitter" from the "Add"' 

drop-down menu (It must be clicked 

twice. once to access the d ropdown 

menu , another time to select the HV 

Emitter.) 

3. Oose the ParticleFX Browser 

A NOTE ABOUT STEP 2 
Either the HV Emitter or the Partigon Emitter 

will work, but Parligons that are not assigned 
to an object will render as tiny sparks, whereas 

particles from the HV Emitter will not be visible. If 

you want the sparks, no problem, but by changing 

the Surface Transparency of the Partigon Emitter 

to 100%, they become invisible. 

• 
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CREATE PARTICLE MOTION 

4. Select the HV Emitter 

5. Open the "'ParticleFX Emitter" w indow 

- Scene I FX Property 

6. Change the following default settings: 

Generator Tal>- Size Effect = Size (no change) 

Particle Tal>- Resistance = .25 

M otion Tal>- Vector (m/s) y = 3 m 

- Explosion (m/ s) = 3.0 

Etc. Tal>- Gravity (m/ s2) y = -2.0 

7. Oose the ··rarticleFX Emitter"· window. 

When you run the animation, particles 

should emit over 60 frames. 

NOTES ABOUT STEP 6 
GENERATOR TAB 

One weird quirk occurs occasionally. If one 
of the other "Size Effecr parameters is selected, 
(sometimes) only one particle seems to be emitted, 
which makes it seem like nothing is happening. 

PARTICLE TAB 
Under the Particle Tab of the PartideFX Emitter 

window, there is a parameter called "Particle 
Lifetime." This determines how long ~n frames) a 
partide ' lives" or is visible and moves. To prevent 
the object that is linked to a particle from stopping in 
mid-air, make sure that the Particle Lifetime is equal 
to or longer than the animation. 

SET UP THE saNE 

8. Load Object 

Use Lightwave / Objects / Food 1 Apple (or 

Banana, or whatever). 

9. Move Camera 

Suggestion: y ~ 1.25 m ; z = - Sm 

(Create keyframe at f rame "0 "). 

10. Size HV Emitter 

Select HV Emitter. 

Change "Scale" - Suggestion x, y, z, =. I (Items 

I Size). (Create keyframe at frame "'0 ".) 

I I. Save Scene (This is not crudal, as it is with 

FX Linker. With FX Unk, it is easy to link and 

unlink objects without having to recreate or 

reload the scene.) 
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LINK PARTICLES TO OBJECTS 

12. Select Object (apple or banana) 

(Now, here :S where things get different.) 

13. Open the Motion Options window 

(Items/Motion section). 

14. O.ick "Add Modifier" in the IK and 

Modifiers Tab (See figure p revious page). 

15. Select "FX_Unk" from the drop down 

menu. (The text "ParticleFXUnk<HVEmitter>O" 

is added to the Modifier window and the ob­

ject is now linked to one of the particles. The 

number indicates which particle the object is 

linked to, in this case, particle number ·'0".) 

Run the animation, and you should see the 

apple (or banana) fly up into the air all by it­

self (well, along with a bunch of particles, but 

not with a bunch of apple clones). Yowsa! 

Now, here's the neat part. Suppose that one 

of the particles has a particularly interesting 

trajectory and you want the banana linked to 

that particle. No problem! 

SPEOFY LINKED PARTICLE 

16. Select HV Emitter. 

17. A ctivate "show id" option (Scene/ FX 

Property/ Particle Tab). Now when you run 

the animation , each particle is identified by 

a number. 

18. Dec.ide which particle you want the 

object linked to. 

19. Select the Object. 

20. Open the Particle FX UNK window. 

(Items/Motion Options/ IK and Modifiers 

Tab, and double-dick on the text in the Modi­

fier field- "PartldeFXUnk<HVEmitter>O". 

21. E.nter the particle number in the 

"Node" field . 

22. Oick "OK". 

When you run the animation now, the object 

is linked to the particle that you designated. 
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STEP 15- SELECT FX LINK 

APPLE LINKED TO PARTICLE MOTION PATH 

<:; ParticleFX EmiHer -:;: 

STEP 17 - ACTIVATE "SHOW 10" OPTION I 

But wait! There's more! I suppose that 

you·ve noticed that although the apple is fly­

ing up into the air, it looks as if a steel rod is 

up its butt. Q uite unnatural. What it needs is a 

little bit of spin, but FX Unk itself does not pro-

I 
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vide for such control. Not to worry. You are 

able to control the rotation of the object using 

the Rotation tool and keyframes, ultimately al­

lowing a much greater degree of control than 

with FX Unker. Plus, if you want to change it, 

you don't have to reload the scene. (With FX 

Unker, you are able to designate a range of 

motion for the rotation and spin of the clones. 

However, you aren't able to control the clones 

individually; at least / haven't figured it out.) 

Try these settings: 

23. Select Object 

24. Activate "Rotate" tool. (Items/Rotate) 

25. Enter the following parameters: 

h = 0 

p = 1200 

b = O 

26. Create keyframe at frame 60. 

Voila! The apple will now spin around as 

it flies into the air. 

So, it's just that simple! Now you have 

some pretty neat tools to play around 

with. Each one has its own benefits and 

limitations, so you can use them together 

depending upon the situation. Not bad. 

That being said, there's one slight problem 

for both FX Unk and FX Unker. The motions 

of the particles are not saved with the scene. 

This means that if you save the scene and 

then re-open it, the motions are randomly 

recalculated. Bummer. Depending upon the 

circumstances this might not be a problem; 

however, it can be significant. But Ta-Da! 

There is a fix. 

FREEZING PARTICLE MOTIONS 

I. Select Emitter. 

2. Freeze particle motion (Scene/ FX_Start). 

LightWave calculates the motions. 

3. Save Motion in desired location (Scene/ 

FX_Property/File Tab/ "save motion" button). 

4. Save Scene. 

The particle motions should now be fixed 

and won't be different each time you open 

the scene, particularly handy when network 

rendering. 

So there you have it. I know it's kind of 

confusing because both FX Unk and FX 

Unker do similar things, use some of the 

same tools, yet are accessed from different 

menus. Go figure! Personally, I think of FX 

Link as "Object Linker" and FX Linker as 

"Gone Linker." Maybe that will help. 

As always, there are many parameters 

and adjustments with which you can play. 

Have fun. w 

BRAD AND ANDREA 
CARVEY HAVE BEEN 
DOING COMPUTER 
ANIMATIONS FOR A 
LONG TIME. IN 1969 
BRAD USED AN 
ANALOG COMPUTER, 

WHICH WAS THE SIZE OF A CAR, TO PRODUCE 
HIS FIRST COMPUTER ANIMATION. ANDREA, AN 
ARCHEOLOGIST, PREFERS TO DO SCIENTIFIC 
ANIMATIONS; HER CREDITS INCLUDE PROGRAMS 
LIKE DISCOVERY CHANNEL'S UNDERSTANDING 
CARS. BRAD IS AN ELECTRICAL ENGINEER AND 
AN EMMY AWARD-WINNING MEMBER OF THE 
VIDEO TOASTER DEVELOPMENT TEAM. HE PRE· 
FERS TO DO FEATURE FILM WORK. HIS CREDITS 
INCLUDE FILMS LIKE MEN IN BLACK, STUART 
LITTLE, BLACK HAWK DOWN, KATE & LEOPOLD 
AND MASTER OF DISGUISE. 

CORRECTION 
In the FX Linker article, I said that clones couldn't 

be linked to specific particles. Wrong! Although 
you can't specify which particles the clones are 
linked to when they are created, you can specify 
particles for each clone once they exist. Just select 
the clone and enter the desired particle number in 
the ·Node" field of the ParticleFX LINK window 
(Scene/FX_Property). However, it can get a little 
tedious when you have hundreds of clones. 

BRIEF COMPARISON OF FX LINKER AND FX LINK 

Access 

Objects 

Attach to Specific Particle 

Spin Control 

Undo 

FX Linker FX Link 

Scene I FX Linker I Particle 
IFX 
Creates Clones 

Yes (Limited Control) 

Reload Scene & Adjust(esp. 

wlzillions of clones) 

Items I Motion Options I lK & 

Modifiers I FX Link 
Uses Individual Objects 

No (Use Keyframes) 

Change Link 
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L 
ike many of us. when I first started 

working with CG, my goal was to 

develop modeling and animation 

skills. I was first introduced to mental ray 

with Softimage 3D and was extremely im­

pressed to see the quality and sophistication 

of rendering with mental ray; however, for 

most of us at that time. using mental ray was 

far from practical. 

My primary interest has always been the 

capability to simulate realistic lighting and 

shading properties; I believe that the quality 

of an image is g reatly determined by the 

quality of the render. Any model can look 

great, as well as aesthetically pleasing, using 

just an occlusion render, and even more so 

with great models! 

This article will examine how to quickly 

improve the detail in renders using the 

mental ray occlusion texture. The g reat 

benefit of rendering w ith occlusion is the 

abi li ty to achieve aesthetically pleasing ren­

ders to show off a model. using a simple 

shader and the occlusion texture. 

Today the rapid improvement in processor 

capabilities and rendering technologies have 

made mental ray, as well as other rendering 

software that mimics real light qualities by 

using advanced light simulations such as Ra­

diosity, Global Illumination, Caustics, or final 

Gather (FG), extremely practical for almost 

any production. In fact, the process has been 

further simplified with the ability to bake the 

lighting simulation into a mapped texture, 

thus preventing recalculating these costly 

simulations repeatedly. Essentially, mental 

ray has become a standard for commercials 

and has also been used in major films such as 

The Matrix Reloaded, The Hull<, Terminator 3 

and Star Wars: Episode 2. 

WHAT IS AMBIENT OCCLUSION? 

Ambient occlusion provides a way for 

adding realism to images by taking into 

account the influence of occluding objects 

while determining the color at every given 

point on a surface. Occlusion is the process 

of blocking or the blocking of a passageway; 

for example, blocking a flow of air. In our 

context, it is the process of objects blocking 

the flow of light from each other, which has 

an effect of darkening the surface area on 

an object as it gets closer to another surface. 

This also affects how a surface reacts to its 

own geometry, such as around folds or 

creases (self-shadowing). 

Occlusion greatly improves realism with­

out any expensive render simulations (such 

as photon casting). An occlusion texture 

examines the distance between different 

occluding surfaces and uses those distance 

values, between points on each of the sur­

faces, to determine the influence they should 

have on the resulting occlusion (darkening) 

value at each point on the surface. The oc­

clusion texture fakes the calculation of how 

much light is blocked from the surface based 

on the distance between surfaces - in other 

words, how much light is occluded by other 

objects. As surfaces get closer to each other, 

I 
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FIGURE 2 - EXAMINING A POINT ON A SURFACE 

the occlusion influence rises and the surfaces 

will get darker in the neighboring regions. 

WHAT IS OCQ.USION USED FOR? 

The process of ambient occlusion within 

mental ray uses a texture node, allowing 

us to use it in several interesting ways. The 

most apparent use for the occlusion texture 

is to retrieve the self-shadowing values- as 

well as influence from surfaces within close 

proximity - as a simple grayscale image 

that describes the diffusive occlusion color 

values across the surface (figure 3). We 

can choose to bake the diffusive ambient 

occlusion calculation into an image file, use 

it within a shader. or use it as a separate ren­

der pass for compositing (most common). 

The ambient occlusion texture can be used 

to retrieve diffusive and reflective occlusion, 

normal maps, and environmental sampling 

passes. We will examine all of these within 

this article. 

FIGURE 3.0 (TOP)- LOW SPREAD & FIGURE 3.1 (BOTIOM) - HI SPREAD 

THE AMBIENT OCOl.JSION TEXlURE NODE 

fortunately, the newest release of 

Maya (6.5) has included an occlusion 

texture that in previous versions of Maya 

required a custom installation. You will 

find the ambient occlusion texture under 

the mental ray nodes texture tab in the 

Hyper shade window. Ironically. it's the 

first texture on the list and probably one 

of the most important ones. 

If you examine the attributes of the 

ambient occlusion texture, you will see that 

you can set the quality of the occlusion by 

increasing the samples; a higher value will 

improve the quality of the render, but also 
increase the render time. The next two at­

tributes, Bright and Dark, give you the choice 

of colors to determine the color range for the 

occlusion. with Bright being the areas that 

receive no influence and Dark being fully 

occluded areas. 

The Spread and Max Distance define 

how much influence an occluding surface 

has on a given point (green surface, fig.2) 

and how far the rays travel to examine 

for occluding surfaces respectively (blue 

arrows, flg.2). A higher Spread w ill dark­

en out a larger region from a given point 

(Red arrows in fig. 2 and figures 3.0-3.1) 

The Mode attribute determines w hat 

type of pass we would like the occlusion 

texture to calculate: at 0 it is used for 

diffusive and reflective occlusion, at a 

value of I it will render an environment 

sampling pass (see environment sam­

pling), and at values 2 and 3 it renders a 

normals pass. 

It is important to understand that diffusive 

ambient occlusion tries to mimic the influence 

of occluded light by examining the distance 

between two surfaces and determining how 

to darken them based on the settings we 

choose. This is not a light simulation using 
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photons, but rather an affordable cheat that 

can greatly improve images and save time. 

DIFFUSIVE AMBIENr OCCLUSION 

SHADING NETWORKS 

We will now examine the properties of 

diffusive ambient occlusion, which is the 

process of getting an occlusion map for the 

diffuse light properties of a surface. To use the 

ambient occlusion for generating any occlu­

sion pass, you connect the out value from the 

occlusion node to the ambient color of any 

shader, typically the lambert shader or the 

out color of a Surface shader (Figure 4). 

The Surface shader in Nlaya provides you 

with a way of viewing the exact color on an 

object without any shading influence such as 

light. If you are not familiar with the Surface 

shader, when rendered it displays the exact 

color based on whatever you connect to the 

out color value, despite any lights in the scene 

(example, an image texture for a bacl<ground 

sky). So one of its many uses would be to 

apply a baked illumination texture to its out 

color value so you can render a sequence 

of frames with no heavy light calculations. If 

you've baked textures before, you may have 

noticed that Nlaya assigns baked textures to a 

Surface shader node by default. If you haven't 

used the Surface shader before, I recommend 

the following exercise: Load an image file 

into a scene with no illumination (disable the 

default light) and apply the image file to the 

out color attribute of a Surface shader. Con­

nect the shader to a simple plane and render 

an image. The result will clarify the strength 

of this shader. 

When examin-

ing the difference 

between 

Lambert 

using a 

(or any 

other typical shader) 

shading model vs. 

the Surface shader 

shading model for 

retrieving an occlu­

sion pass, we will 

notice the following 

behaviors: 

1 Using 

Lambert 

the 

shader 

or any other (Blinn, 

Phong) shading 

model, and connect­

ing the occlusion 

texture to the ambient 

color attribute on the 

shader. An ambient 

color value acts as a 

multiplier for the color 

value. The occlusion 

texture that is con­

nected to the ambient 

color value will render 

out details of darker 

I brighter based on 

occluding objects and 

then multiply it with 

the color attribute 

values to determine 

the color for each 

point in the rendered 

image. The rendered 

image will have also 

been influenced by 

the shading model 

attributes, such as the 

diffuse and specular 

color values as well as 

influence from lights 

in the scene (figure 

5.0). In the case of 

a Lambert shader, if 

you set the diffuse value to zero and the color 

value to white (figure 5.2) then the result will 

be the same as using a surface shader (figure 

5.I). This is because a shader with a zero dif­

fuse value w ill not be influenced by any lights 

In the scene. Also, you need to set the color 

value to white so that the ambient color is 

C• 

(• 

AND A WHITE COLOR VALUE 

multiplied with a color value of one (white). 

If you where to keep the default grey color 

value, the rendered occlusion would only be 

as bright as that value (grey value of 0.5). To 

explain this mathematically, a calculated value 

of I from our occlusion texture (one/white 

being the value of a non occluded area), is 
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multiplied by the value of the color attribute, 

lets say 05, thus the brightest point on the 

surface could never be brighter than a value 

of 0.5 (0.5* 1=0.5 which is the color value* 

ambient ocdusion =the max value). 

2 The Surface shader will provide a 

render where the values are solely 

driven by the occlusion shader, thus 
providing, in my opinion, a better render 

pass for compositing (figure 5.1). The 

Surface shader has an out color value 

that defines its rendered color value vs. 

other shading models that have ambient, 
diffuse, and other attributes that affect 

the final color values. 

As you can see, the Surface shader 

diffusive occlusion pass looks much more 

li ke the kind of pass we could use in a 

compositing tree. Note that you might 

want to adjust the Dark value so that 

when multiplied by the color value in a 

composite, the result won't completely 

darken the colors at the fully occluded 

areas. The Bright value should always 

remain white so there won't be any 

influence on the overall color at non­

occluded areas. 

AMBIENT REFLE.CilVE OCO.USION 

The occlusion texture lets you do 

much more than calcu late diffusive 

ambient occlusion, by allowing you to 

calculate reflective ambient occlusion. 

If we mimic realism, we wou ld simulate 

the properties of natural light being 

scattered off an object - this wou ld in­

clude d i ffusive reflected light as well as 

specular reflected light. Both take part in 

determining the color of a surface point 

by mathematically adding the reflection 

value onto the diffusive color value. So 

if you have a very dark surface color and 

you add the reflected color, you should 

see an almost accu rate reflection color 

value, however if you add a reflected 

color onto a bright color, the reflection 

might appear washed out (figu re 5.3). 

For example, shading a mirro r is best 

achieved by using a shader with a dark 

color and a low diffuse value. since we 

primarily want to see the color of the 

specular reflection. 

The technical difference between 

rendering a diffusive occlusion vs. a 

reflection occlusion pass is in how the 

occlusion is calculated. With the diffusive 

occlusion, the influence is calculated 

based on the surface normals, whereas 

the reflected occlusion is calcu lated based 
on the reflection rays. 

WHY WE NEED REFLE.CilVE OCCLUSION 

In CG, if the reflectivity value is set to full 

( 100% reflective), then each point on that 

surface will have the same amount of re-

flection. In real life, though. objects reflect 

unevenly based on their shape and physical 

properties, as well as how much light is oc­

cluded by other objects, folds, and creases, 

just as in the case of diffusive ambient 

occlusion. Reflective ambient occlusion 

provides a way to control the amount of 
reflection color along a surface based on 

the reflection rays. 

The primary consideration w ith re­

flective occlusion is how to control the 

amount of reflection at each point on the 

surface. The occlusion texture provides 

us with a grayscale map that can be used 

to vary the reflection values along the 
surface. In order for us to adjust the re­

flectivity amount based on the grayscale 
occlusion map, we must multiply the 

result of the reflected ambient occlusion 

(the grayscale map) with the overall 

reflectivity value at each point across the 
surface. The result would be a reflection 

pass that would scale the amount of 

reflection across the surface, based on 
the reflective occlusion map, rather than 

an overall linear value. 

COMPOSmNG REFLECTIVE AMBIENT 

OCCLUSION 

W hile compositing a standard color 

pass with a ref lection pass (figure 6.4), 

the reflection pass is a combination of 

both a fully reflected pass (figure 6.2) 
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TOP LEFT- FIGURE 6.0 - DIFFUSIVE OCCLUSION, TOP RIGHT- FIGURE 6.1 - REFLECTION OCCLUSION 
BOTTOM LEFT- FIGURE 6.2 - FULL REFLECTION (CHROME SURFACE), 

MIDDLE RIGHT- FIGURE 6.3- COMPOSITE- MULTIPLIED REFLECTION PASS WITH REFLECTIVE OCCLUSION PASS, 
BOTTOM RIGHT- FIGURE 6.4 - SHAKE : REFLECTION + REFLECTION OCCLUSION 

multip lied by the reflected occlusion 

pass (fig ure 6. 1) to give the reflection 

more variation on the surface. Then 

the resulting reflection pass (fig ure 6.3) 

is added to the color pass that is also 

mult iplied by a diffusive occlusion pass 

((Color*Di ffusive Occlusion ) + (Reflection 

• Ref lected Occlusion)). 

To clarify , a fully occluded point that is 

multiplied by its fully reflected pass, would 

yield a reflection value of zero for that 

point-no reflection exists at that point. 

So if the reflected ambient occlusion is 

equal to a value of zero (fully darkened 

area), the reflection value of one (fully 

reflected), mult iplied by an occlusion value 

of zero, will be equal to a value of zero 

and have no reflected color at that point (0 

occlusion • I reflection = 0 reflection). 

One of the no ticeable d if ferences 

between a reflection occlusion pass vs. 

a diffusive occlusion pass is the fact that 

the reflected occlusion pass yields more 

darkening in f lat areas (figures 6.0 - 6.1). 

Some CG artists refer to occlusion as dirt 

m aps because o f the way it provides 

darkening in tig ht spots on a sur face 

as well as the darkening in fluence from 

other objects. In such a case, you might 

prefer the reflected occlusion pass, as it 

has a more interesting darkening affect, 

as well as defines surfaces more clearly . 

The additional darkening is due to the 

fact that the reflective occlusion pass 

darkens areas based on the reflection 

rays, whereas the di ff usive occlusion 

pass calculates i ts affect based on the 

sur face normal. 

METHODS FOR RENDERING AMBIENT 

REFLECTIVE. OCCLUSION 

Before we examine reflective occlusion, 

I would just like to point out that I am us­

ing HDR Images with an IBL (image based 

lighting) light node, available from the 

mental ray render globals tab. Rendering 

reflective occlusion is as simple as enabling 

the reflective check box in the occlusion 

texture node; you can then render reflec­

tive occlusion in a number of ways: 

• You can render a reflective occlusion 

pass with the same network as used 
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before {figure 4 ), just with the reflective 

checkbox enabled. The resulting render 

is a reflective occlusion pass that can 
be used by multiplying the result with a 

reflection pass in a compositing package 

{Figures 6.1 - 6.4). 

• You can also combine the reflection 

and the reflective occlusion into a shader 
by driving the reflection amount over the 

surface in some of the following ways: 

1 Connect the out value from the occlu­

sion to an ''RGB to Luminance·· node 

and use the output as a reflectivity value 

{see shader setup 3). 

2Create a specular shading model that 

is multiplied w ith an occlusion texture 

using the ··multiply I divide·· node and then 

connected to the out color on a surface 

shader node {see shader setup 2). 

3Connect the occlusion texture out value 

to the specular colo r value of a shader 

{see shader setup 1). 

In summary, all of the above methods 

provide a way for controlling the reflection 

value across the surface, their purpose is the 

same: the scaling of the reflection value at 

each point across the surface based on the 

occlusion texture attributes. The main dif­

ference is whether you plan on com positing 

the reflection and reflective occlusion pass 
within a compositing package or whether 

you would rather create a single shader that 

has the occlusion texture multiplied with 

the reflection values at render time. The 

latter would be creating a specular reflective 

shading model that is multiplied w ith the oc­

clusion texture; this process will be clarified 
In the following shader examples that will 

show some of the different approaches you 

can take. Notice that the main difference 

w ill be in the approach to establishing the 
shading networks connections rather than 

the end result. 

SHADER SETUP 1 

Methodology: Assuming the reflection 

attribute is enabled, the specular color val­

ue controls the reflection amount along a 

surface. A black specular color is 

equal to no reflection, whereas a 

bright specular color w ill provide 

for full reflection. The following 

connection uses the reflective 

occlusion texture value as a map 

for the specular color that then 

acts as a scale for the reflection 

values across the surface based 

on the dark I bright occlusion 

texture values. 

Process: Enable the reflection 

checkbox, and then connect the 

ambient occlusion texture out val-

ue to the specular color value on 

a reflective shader such as a Blinn 

or Phong node. Make sure that the reflection 

value is set to a value greater than zero {try 

a value of one). Use the reflection value as an 

overall scale factor for the reflection. 

SHADER SETUP 2 {FIGURE 7.1 &.. 7.4) 

Methodology: Using a Surface shader to 

pipe out the reflection value multiplied by the 

reflective occlusion value. This is achieved by 

taking a fully reflective shader and then mul­

tiplying it with an occlusion texture, using the 

Multiply Divide node. The result is then passed 
to the surface shader out color that will show 

the combined result in the rendered image 

regardless of any existing lights. 

PROCESS: 

1 Create a reflective Blinn {black color 

with a low diffuse, high specularity and 

fully reflective) 

2Create a Surface shader, an occlusion 

texture and a multiply divide node {Maya 

utility node, make sure it is set to multiply) 

3Connect the Blinn out color to the 

multiply divide node input I 

4 Connect the Occlusion out value to the 

multiply divide node input 2 

5 Connect the out value from the multiply 

divide to the out color of the Surface 

shader {just middle mouse drag the multiply 

divide node onto the out color value) 

Note that the Blinn passes its out color 

to the Surface shader, this out color is the 

result of all the values from the Blinn's 

attributes {color, ambient color, reflection, 

diffuse .. . ), thus when using a fully reflec­

tive {chrome type) shader, w ith no diffuse 

and a high specular value, the resulting 

out color w ill be equal to a full reflection 

color pass thar is then multiplied with the 

multiply divide node, by the grayscale map 

from the occlusion texture. This method 

was demonstrated by Paolo Berte, from 

mental Images, in the 2004 A lias master 

class papers. 

SHADER SETUP 3 {FIGURE 7.2) 

Methodology: Using an RGB Luminance 
node we will convert the out value from 

the occlusion texture (which is an RGB 

value) into a single value that can be used 

as a scale for the reflectivity value, a single 
number value. For MEL users, we are con­

verting the color value (a vector) into the 

reflectivity single value (a float). 

PROCESS: 

1 Create a reflective Blinn (black with a 

low diffuse, high specularity and fully 

reflective) 

2 Create an occlusion texture and a RGB 

to Luminance node (May a utility node) 

3 Connect the occlusion out value to the 

RGB Luminance node in value 



4 Connect the luminance node out value 

to the Blinn's reflectivity value (make 

sure you connect to reflectivity not the 

reflection color attribute) 

5 Further, you can use the out color from 

the Blinn as a connection for the out 

color on the surface shader. Also, you can 

create a ramp that acts as a scale for the 

occlusion texture and therefore controls the 

range and contrast of the final render. 

SHADER SETUP 4 - QEARCOAT 

(FIGURE 7.3 &. 7.6) 

Methodology: This is just a quick ex­

ample of how the occlusion texture can 

be piped into a network to help achieve 

a more realistic effect. I am not going to 

explain how to create a clear coat shad­

ing network, as this is a common prac­

tice that is described in various tutorials 

and books, including the A lias Web site 

and the Alias rendering book. The clear 

coat in this examp le tries to improve the 

way the reflection is calculated across a 

surface, as the surface geometry bends 

away from the camera. In this case, 

I use two ramps that help define the 

reflection and specular values based on 

the surfaces direction from the camera 

(Sampler info node). The entire shader 

is then t ransferred to a multiply divide 

node and multiplied with the occlusion 

texture; the result Is the reflection pass 

with the affect of the clear coat shading 

characteristics, as well as the camera 

viewing angle (sampler info) influence 

and, of course, the reflective occlusion 

texture influence. 

Process: Using the same setup from 

shader setup 2, just replace the Blinn 

with a layered texture that is a clear coat 

shading network. 

ENVIRONMENT SAMPUNG AND 

NORMAL MAPPING 

Besides occlusion passes, the ambient 

occlusion texture provides a way to re­

trieve normals and environment sampling. 

These are enabled by choosing different 

rendering modes from the ambient oc-

elusion texture Mode attribute. I will not 

get into much detail, especially with the 

normal mapping, as it in itself is a topic for 

a lengthy article. 

Mode 1: Environmental sampling, this 

is the process of retrieving the influence 

from the environment on our model 

based on the diffusive or reflective 

occlusion lookup, this means that you 

can choose if you want to examine the 

environment influence based on the 

surface normals (di ffusive occlusion) or 

the reflection rays (reflective occlusion). 

I 
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In my opinion, it has many similarities to 

rendering with image based lighting, but 

rather than taking the time to calculate 

many lights, or use expensive render 

simulations such as final gather, it sim­

ply speeds up the process of getting the 

environments influence on each point on 

the surface. In the case of environment 

sampling, we retrieve color values from 

the environment and multiply them by 

our surface color; this in return can be 

used as a render pass or part of a pro­

cedural shading network. The following 

examples show the influence of differ­

ent HDR images on a model using the 

occlusion texture and a surface shader 

(figu res 9.0- 9. 1); figu re 10 shows figure 

9.0 composi ted with the clearcoat reflec­

tive occlusion pass (shader sample 4) . 



Modes 2 and 3: these modes enable ren­

dering normal mapping passes based on 

the world coordinate system (mode 2 ) or 

the camera coordinate system (mode 3). 

The colors represent the directions In 

the coordinate system you choose, where 

x , y, z are represented by red, green, and 

blue, respectively. If you are not familiar 

w ith the usage of normal maps, you can 

learn about this from tutorials available on 

many 3D sites. 

IN OCCLUSION: 

There are several different connections 

you can create based on these examples 

and some of your own added creativity. 

We examined much more than render­

ing ambient occlusion in this article; 

some of the information I covered refers 

to the usage of some very useful utility 

nodes as well as piping shading net­

works through the surface shader and 

understanding the composlting tree for 

occlusion using a node based composit-

ing software. I would like to point out 

that you can adjust the levels for the 

occlusion map to resolve any artifacts 

that may appear in the occlusion render, 

a.s well a.s control the overall occlusion 

darkening affect. 

The occlusion, in my opinion, is be.st 

used as a separate pass for composit­

ing, enabling you to make last minute 

changes to your image. Remember that 

a lesser reflection value doe.s not blur a 

reflection, it ju.st renders le.ss of it, or you 

may .say adds a lower reflection color 

value onto the diffusive color value, thus 

all it really does is darken (reduces) the 

reflection amount, which is why I would 

rather apply it in the composting stage. 

The diffusive occlusion is especially 

handy if you would like to present your 

models clearly, with some self-shadowing 

and an aesthetic render. Also, I find that 

the diffusive occlusion pass adds a lot 

of realism to character faces, which are 

naturally full of creases and folds. 

I hope you enjoyed this article. In the 

next article in this mental ray for Maya 

series, we will examine texture baking with 

mental ray. ~ 
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urn on 

U 
his is a continuation from the 

last article on setting up a 

human for animation. Since 

rigging is a very involved 

process, this tutorial will 

extend over several more issues. As a former 

UghtWave user (teaching it for over 10 years), 

I found many similarities as well as differences 

between the way rigging is done in Maya. 

Since the NewTek team is asking for sugges­

tions on how to improve future versions of 

UghtWave, some of you may find it useful to 

learn how Maya accomplishes certain rigging 

tasks so that you can request similar features 

in future upgrades of UghtWave. 

Before you start the rigging process, 

make sure that you have a high-res smooth 

mesh surface version of your person in one 

layer and the low-res proxy mesh type in 

another layer (Figures I and 2). 

Notice that the model is in the typical T 

pose. This is the position that makes modeling 

easier when using templates, since most of 

the time they are straight orthographic views 

of the model. The T pose also makes it easier 

to UV texture a character, since the geometry 

is already fadng directly on the X, Y, and Z­

axes, rather than at angles which can cause 

distortions in the extrapolated UV maps. 

Another important consideration is topol­

ogy. It is something that cannot be stressed 

enough when designing your character. If 

your polygons and their edges do not flow 

~~iii ~~ ISSUE 4 
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FIG. 1 (ABOVE LEFT}- THE TOPOLOGY OF THE LOW POLYGON MODEL (PROXY MESH) 
FIG. 2 (ABOVE RIGHT}- THE SMOOTH MESH MODEL THAT IS PLACED IN A HIDDEN LAYER. 

with the orientation of muscles and bones that 

are visible on the surface, then the model will 

not deform correctly when you are posing 

it. No matter how much you work with the 

weight maps, you are bound to run into all 

kinds of frustrations. Creating a model with 

the right kind of topology is also very impor­

tant for facial animation with blend shapes 

or morph targets. It is much easier to make 

these when the polygons flow in the same 

direction as the muscles of the face. Modeling 

a human with the right kind of topology w ill 

be discussed in a future issue. 

( CREATING THE. JOINTS (BONES) ) 

Using the model as our template for the 

placement of joints, the following steps show 

I 
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how to create the different components of 

the skeleton. This is probably the easiest part 

of the rigging process. 

Make your side view large and hide the 

hi-res smooth mesh layer so that you can 

only see the low-res proxy version (Figure 1). 

Make the shader of the low-res proxy semi­

transparent or go to the side view Shading 

menu and select Shade Options > X-Ray. 

STEP 1 

Create a new layer for your skeleton. Select 

the Joint by going to Skeleton > joint Tool > 

Options. In the options box, set the Orienta­

tion to None and close the box. Later, we will 

orient the joints to point toward the bones 

manually. In your side view, click with the tool 

at the hip area. If the 

first joint is too large 

or small, go to the 

Display menu and 

select Joint Size. Click 

at the knee to make 

the second joint. 

Click at the ankle for 

the third joint, the 

middle of the foot for 

the fourth one, and 

finally in front of the 

toe to complete the 

leg and foot joints. 

FIG. 3- STEP 1, USING THE JOINT TOOL TO 
MAKE THE LEG BONES IN THE SIDE VIEW 

STEPl 

Go to your front 

view, click on the 

top joint, and move 

the leg skeleton into 

the center of your 

character's left leg 

(Figure 4). 

1 

STEP3 

Label each joint by selecting the top and 

name it "L_hip ... Use your down arrow to 

select the knee joint and rename it "L_knee." 

Each joint should have the following names: 

L_hip 

L_knee 

L_ankle 

L_ball 

L_toes 

For those of you who are lazy about 

naming joints, try this. Select the top leg 

joint and go to Mocfify>f'refix Hierarchy 

Names ... Type "L_Leg_" and click OK. This 

will name all the joints in the chain w ith the 

"L_Leg_·· prefix. 

STEP4 

In the side view, starting slightly above 

the hip joint. use the Joint tool to create six 

spine bones, and one neck and one head 

bone (Figure 5). Starting at the hip area 

and working your 

way up, rename 

the joints with the 

following names: 

spine l 

spinel 

spine3 

spine4 

spineS 

spine6 

neck 

head 

skull 

FIG. 5- STEP 4. CREATING THE SPINE, NECK, 
AND HEAD JOINTS IN THE SIDE VIEW 

STEPS 

Now it is time to reorient the joints so 

that they point toward the same direction 

as the bones. Hide the layer that shows 

your polygon object. Select the root spine 

joint that you named "spine I" and go 

to Display > Component Display > Local 

Rotation Axes. If you have not done so 

already, you might want to make a shelf 

button for this command. 

Click the Select by Component Type 

icon in the Status Line to turn on the 

Component Selection mode, and also click 

the Miscellaneous (?) mask icon in the 

Status Line. Right-click the Miscellaneous 

(?) mask icon and turn on Local Rotation 

Axes (Figure 6). 

? 
·--=~----------------~ 

1

(81 Local Rotation Axes 
0 Image Planes 

FIG. 6 STEP 5, TURNING ON LOCAL ROTATION 
AXES IN COMPONENT MODE 

Select the Rota­

tion tool. Click on 

the X, Y, or Z-axes 

name o r the axes 

lines found inside 

the joint. Rotate 

the joint in the 

side view so that 

its Y -axis faces 

toward the bone 

above it. Only the 

joint should rotate, 

while the bone re­

mains stationary. 

Continue working 

your way up until 

all the joints have 

their Y -axes f ac­

ing toward the 

bones above them 

(Figure 7). 
z 

y 

FIG. 7- STEP 5 CONTINUED. USING THE SIDE VIEW 
TO ORIENT THEY LOCAL ROTATION AXES OF ALL 

THE JOINTS SO THAT THEY FACE TOWARD THE 
BONES ABOVE THEM 
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Orient the leg 

joints so that the 

upper and lower 

leg joints' Y -axes 

face in the same 

direction as the 

bones above them. 

The Z rotation axes 

of the ankle, ball, 

and toe joints face 

toward the bones 

next to them (Fig­

ure 8). 

FIG. 8-- STEP 5 CONTINUED. ORIENTING THE 
LEG JOINTS IN THE SIDE VIEW 

SfEP6 

Check to make sure the spine is in the 

middle of the figure. Connect the "hip" joint 

to the "spine I" joint by doing the follow­

ing. Set up your panels so that you can 

see the Outliner and Perspective views. In 

the Outliner, locate the joint named '"hip:· 

Middle-click/ drag it in the Outliner to drop 

it directly on the joint named "spinet:· The 

perspective view should now show them 

connected with a new bone (figure 9). 

FIG. 9- STEP 6, CONNECTING THE "HIP" JOINT 
TO THE 'SPINE1" JOINT BY MIDDLE CLICK­

DRAGGING IN THE OUTLINER 

SfEP7 

The next step involves making the arm 

and hand joints. Switch to the top view 

and select the joint tool. Star ting at the left 

shoulder, create a series of joints similar to 

the ones shown in figure 10. The last joint is 

at the end of the middle finger. 

FIG. 1(}-STEP 7, CREATING THE SHOULDER. ARM 
AND MIDDLE FINGER JOINTS IN THE TOP VIEW 

Make the pinky, ring finger, index, and 

thumb joints. Create these groups separately. 

When you finish one finger, click or select the 

joint tool again to start a new set of joints for 

the next finger. Refer to Figure I I. 

FIG. 11- STEP 7 CONTINUED, MAKING THE 
REST OF THE FINGERS AND THUMB 

The pinky, ring, index fingers, and the 

thumb will now be connected to the wrist joint. 

Select the base joint of the pinky finger and 

Shift-select the wrist joint. Press ··p·· or go to 

Edit > Parent to parent the two joints. This will 

create another bone connecting the two joints. 

Select the base joint of the ring finger and Shift­

select the wrist joint. Press ··p·· to parent these 

two. Parent the index finger and thumb to the 

wrist joint. Your hand bones should now look 

somewhat like the ones in Figure 12. 

Use your front and/ or side views to 

move the entire arm and hand skeleton up 

so that it is inside the arm of your model. 

Adjust the hand and finger joints by mov­

ing and rotating them until each is inside 

your character's hand. 

SfEP8 

Select the base joint of the arm bone at 

the shoulder. Shift-select the joint named 

"spine6." Press ··p" to parent so that you 

now have a shoulder bone similar to the 

one shown in Figure 13. 

FIG. 13- STEP 8, THE UPPER ARM JOINT IS 
CONNECTED TO THE "SPINES" JOINT 

CREATING A SHOULDER BONE 

THERE ARE MANY WAYS OF RIGGING 
AND IT IS UP TO EACH ANIMATOR TO FIND 

THE ONE THEY PREFER 
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Skin Constrain Mirror Joint Options 
Joint Tool 0 
IK Handle Tool 0 Mirror Across 0 XY ® YZ o xz 
IK Spline Handle Tool 0 
Insert Joint Tool 

Mirror Function ® Behavior 0 Orientation 

Reroot Skeleton 
Remove Joint 
Disconnect Joint 

Replacement names for..;d:.:u.::.pl;;.:ic:.:a.:.:te.:.d.:.;io;,;.in.:.:ts,;..: _______ 
1 

Search For: ~L============~ 
Mirror Joint 

Replace With: II.!:R,__ ___________ _. 

Click on the hip joint and go to Skeleton 

> Mirror joint > Options. In the Mirror Joint 

Options box, for Mirror Across, select the 

YZ-axes. Next to "Search For:" type L_. For 

"Replace With:" type R_. Click the Mirror 

button. You should now have a skeleton 

for the right leg that is connected to the 

"spine I" joint (Figure 14). 

STEP 10 

The local rotation axes of the hand 

and arm should be adjusted. In order to 

test the way the lingers curl , use the Mel 

script "select -hi.'' You should already 

have a shelf button for this if you started 

with last issue's tutorial "Setting Up the 

Human Model for Animation" (check 

under the heading Selecting a Skeleton's 

Hierarchy with a Mel Script). 

Click on the base joint of each linger, 

click the "select -hi " shelf button, and 

rotate the joint to make the lingers curl 

into a closed position. If the fingers rotate 

in the right direction, then y ou will not 

have to make any adjustments to the local 

rotation axes. 

To adjust all the joints' rotation axes, 

follow the steps in "Setting Up the Hu­

man Model for Animation " under the 

Close 

FIG. 15-STEP 10, ADJUSTING THE LOCAL ROTATION 
AXES OF THE THUMB AND INDEX FINGER 

heading Toggling Local Rotation Axes. 

TheY-axis should point straight up, the 

X-axis should point toward the next 

bone, and the Z-axis should stick out to 

the side. Toggle back and forth between 

Object and Component mode (F8) using 

"select -h i" to test each fingers rotation. 

For the thumb, have the Y -axis point up 

and the X-axis to the outside at about a 

45-degree angle. This will slant the thumb 

toward the palm when it is curled in. Fig­

ure IS shows the joints and rotation axes 

of the thumb and index finger. 

Adjust the local rotation axes of the 

w rist joint so that the Y -axis points up, 

the X-axis points toward the middle linger 

and the Z-axis points to the side. Adjust 

the rotation axes for the upper and lower 

arm joints. TheY -axis should point straight 

up, the X-axis has its direction toward the 

bone next to i t , and the Z-axis points 

toward the side. 

STEP 11 

Name the arm, linger, and thumb joints: 

L_Shoulder 
L_UprArm 
L_LwrArm l 
L_LwrA rm2 
L_W rist 
L_Thumb 
L_ThumbTip 
L_lndexFinger 
L_lndexFingerMiddle 
L_lndexFingerTip 
L_MiddleFinger 
L_MiddleFingerMiddle 
L_MiddleFing erTip 
L_RingFinger 
L_RingFingerMiddle 
L_RingFingerTip 
L_rinkyFinger 
L_rinkyFingerMiddle 

L_rinkyFingerTip 

STEP 12 

Select the "L_Shoulder" joint and go to 

Skeleton > Mirror joint > Options. In the 

Mirror Joint Options box, for Mirror Across. 

select the YZ axes. Next to "Search For:" type 

L_. For "Replace With:" type R_. Click the 

Mirror button (Figure 14). The arm should 

mirror across the X-axis and automatically 

connect to the "spine6" joint. 

STEP 13 

The next steps will take you through making 

IK handles and building a reverse foot control. 

Go to Skeleton > IK Handle Tool > Options. 

In the options window under IK Handle Set­

tings, next to Current 

Solver, make sure that 

you have "ikRPsolver" 

selected. U sing the IK 

Handle tool, click on 

the "hip" joint and then 

the "ankle" joint. You 

should now have an 

IK handle at the ankle 

that can be moved up 

and down to bend and 

move the leg. Repeat 

these steps on the 

other leg. 

FIG. 16- STEP 13, USING THE IK HANDLE TOOL 
ON THE HIP AND ANKLE JOINTS 



FIG. 17-STEP 13, BUILDING A REVERSE FOOT 
CONTROL. CREATING THE "HEELCONTROL" 

JOINT (1), THE "TOECONTROL" JOINT (2), THE 
"BALLCONTROL" JOINT (3), AND THE 

"ANKLECONTROL" JOINT (4). 

When animating the legs, it's important 

to have the foot bend at the toes. One 

could create another IK Handle, but there 

is a more efficient m ethod that uses a re­

verse foot control. In the side view, zoom 

in on the foot. Select the joint tool and 

click once below the ankle, then again be­

low the toe joints, then back again below 

the ball joint, and finally below the ankle 

control (Figure 17). 

Rename the first joint ··HeeiControl," 

the second joint ·-roeControl,'' the third 

joint "BaiiControl," and the fourth joint 

"AnkleControl:· Using the top or fron t 

v iews, move the reverse foot control 

under the left foot. Copy and paste the 

reverse foot control and place it under 

the r ight foot. 

STEP14 

Select the "AnkleControl" joint on the 

left reverse foot control. Shift-select the 

left leg's IK Handle located at the ankle. 

Go to Constrain > Point (Figure 18). Now 

when you select the "Heel Control" of the 

reverse foot control and move it around 

the leg also moves. 

The next part is to set up some con­

straints for controlling the orientation of 

~rJ"a 3[.} ISSUE 4 
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Point 
Aim 
Orient 
Scale 

FIG. 18 STEP 14. AFTER CLICKING ON THE "ANKLE­
CONTROL" (1), THE IK HANDLE IS SHIFT SELECTED 

(2). CHOOSING CONSTRAIN> POINT CONNECTS 
THE IK HANDLE TO THE REVERSE FOOT CONTROL 

the foot. Select the "BaiiControl" joint on 

the reverse foot constraint. Shift-select the 

anklebone of the foot skeleton and choose 

Constrain > Orient (Figure 19). 

Orient 
Scale 

Select the 'T oeControl" joint on the reverse 

foot constraint. Shift -select the ball joint of 

the foot skeleton and choose Constraint > 

Orient (Figure 20). 

Now all the rotations are connected to 

the reverse foot control. If you try rotating 

the "BaiiControl" joint or the 'ToeControl" 

joint on the reverse foot constraint, they 

w ill in turn rotate the ball and toe joints on 

the foot skeleton. 

Before you start repeating the procedure 

outlined under Step 13 for the other foot, 

you will need to correct the right reverse 

foot control joints' orientation (Figure 21). 

The Y -axis should point up. Note that the 

orientation of the local rotation axis of both 

legs should have the X-axis pointing in 

opposite directions - toward the outside 

of the legs. If you do not fix the local rota­

tion axes on the right reverse foot control, 

the right foot w ill spin around and point 

in the wrong direction when you choose 

Constraint > Orient. Basically , the local 

orientation axes of the reverse foot control 

have to be the same as the ones on its cor­

responding foot joints. 

I 
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FIG. 22- STEP 15, CREATING FOOT ICONS IN THE 
TOP VIEW USING THE EP CURVE TOOL 

SfEP 15 

Instead of trying to find the different 

joints to control the feet during an anima­

tion , it is easier to set up a foot control. 

This control w ill be made in the form 

of a foot icon. Switch to the top v iew 

and go to Create > EP Curve Tool. Draw 

the outlines of a foot (Figure 22). Go to 

the Modeling Menu Set and select Edit 

Curves > Open/ Close Curves. This will 

enclose the outline. Scale it and m ove it 

behind one of the feet. 

SfEP 16 

Before creating Set Driven Keys to 

control the feet, some things should 

be put in order. Delete the history for 

the foot icon (Edit > Delete by Type > 

History). Go to Modify > Freeze Trans­

formation. This w ill reset the Translation 

to 0 and Scale to I in the Channel box. 

Duplicate the foot outline (Control d), 

go to the Channel box, and change the 

Scale X to - I so that the foot icon is mir­

rored. Move it next to the original foot 

icon. Delete its history and f reeze its 

transformation, also. In the Channel box, 

rename the two curves "L_Footlcon" and 

"R_Footlcon ." The advantage to using 

curves is that they will not render. Select 

each foot icon and then go to Modify > 

Center Pivot. Your feet icons should now 

look and be in a similar spot, like the 

ones in Figure 23. 

FIG. 23- STEP 16, SCALING AND PLACING THE 
FOOT ICONS BEHIND THE CHARACTER 

In the Channel box for each foot icon there 

are some attributes, such as Scale and Visibil­

ity, that will not be needed. Therefore, they 

will now be eliminated through the Channel 

Control option box. Select one of the foot 

icon curves, go to Window > General Editors 

> Channel Control (Figure 24). In the Channel 

Control option box, select all the scale and 

the visibility attributes under the heading 

Keyable. Oick the Move >> button on the 

bottom and close the box (Figure 25). Notice 

how the Channel box no longer shows the 

scale and visibility attributes for the foot icon. 

Select the other foot icon and do the same 

thing to it. 

Animate Deform Skeleton Skin Constrai 

General Editors .. 
Rendering Editors 
Animation Editors 
Relationship Editors 
Settings/Preferences 

Component Editor ... 
Attribute Spread Sheet. 

Connection Editor ... 
Visor ... 

Blind Data Editor ... 

Channel Control... 

FIG. 24- STEP 16 CONTINUED. OPENING THE 
CHANNEL CONTROL BOX IN ORDER TO ELIMINATE 
NONESSENTIALATIRIBUTES IN THE CHANNEL BOX 

SfEP 17 

A roll attribute will now be added to 

the foot icons in the Channel box. Select 

the left foot icon and go to Modify > 

Add Attribute ... (Figure 26). In the Add 

Attribu te box, fill in the same values as 

shown in Figure 27 (Next page). The 

Attribu te name is "footRoll." Under 

Numeric Attribute Proper ties, next to 

Channel Control • L_Footlcon 
Options Help 

Keyable 

Non Keyable 
caching 
displayHandle 
displayLocaiAxis 
displayRotatePivot 
displayScalePivot 
ghostPostSteps 
ghostPreSteps 
ghostRangeEnd 
ghostRangeStart 

~:mll[ID'j•• ghostStepSize 
host in 

Close 

FIG. 25- STEP 16 CONTINUED, SELECTING THE 
SCALE AND VISIBILITY ATIRIBUTES IN THE 

CHANNEL CONTROL CLICKING THE MOVE» BUT­
TON MOVES THEM OUT OF THE CHANNEL BOX 

Create Dis 

Transformation Tools ~ 

Reset Transformations 0 
Freeze Transformations 0 
Snap Align Objects ~ 

Evaluate Nodes ~ 

Make Live 
Center Pivot 
Prefix Hierarchy Names ... 
Search and Replace Names ... 

Add Attribute ... I 
FIG. 26- STEP 17, OPENING THE ATIRIBUTE 

BOX FOR ADDING CERTAIN PROPERTIES 
TO THE CHANNEL BOX 

Minimum, type -5. This designates the 

foot will be angled back on its heels w ith 

the toes pointing up in the air. Maxim um 

shou ld be set to 10 so that the foot w ill 

be on its toes with the heel up in the air. 

A value of 5 w ill mean that the foot is 

bent at the ball joint. The Defau lt of 0 

signifies there is no foot roll. Notice how 

the Channel box shows the new attri bute 

"footRoll ." 



Add Attribute: L_Footlcon 
Help 

New ~ Particle ~ Control ~ 
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FIG. 27- STEP 17 CONTINUED. IN THE ADD 
ATIRIBUTE BOX, SETTHE FOOTROLL TO A 
MINIMUM ·5 (THE FOOT IS ANGLED BACK), 

MAXIMUM 10 (THE FOOT IS ANGLED FORWARD) 

SfEP18 

A Set Driven Key w ill be prepared so that 

we can con trol the roll of the foot through 

the Channel box. Select the left foot curve 

and go to Animate > Set Driven Keys > Set 

> Options (Figure 28). In the Set Driven Key 

option box click the Load Driver button . 

This w ill load the "L_Footlcon" as the driver. 

The second column shows the "footRoll" 

attribute that will d rive the reverse foot 

control that, in turn, controls the foot and 

leg r ig. Select that also. 

Skin Constrain C 
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Keeping the Set Driven Key box open, 

select the root joint of the left foot reverse 

foot control (the heel joint). This will select 

the entire reverse foot control. 

If you do not have a shelf button for 

the Mel script "select ·hi," then go ahead 

and make one while the Set Driven Key 

window is open. Click the shelf button with 

the "select -hi " Mel script. This will select all 

the joints of the hierarchy so that you can 

load them altogether into the Set Driven 

Key box. 

The entire reverse foot control should 

now be selected. In the Set Driven Key op­

tion box, click the Load Driven button. This 

loads every joint of the reverse foot control 

under the Driven category. 

Under the Driven heading, Shift-select only 

the Heel, Toe, and Ball controls. We will not 

have to do anything with the Ankle control. 

Oicl( the Driven button again and this will 

eliminate the Ankle control, leaving only the 

Heel, Toe, and Ball controls (Agure 29). 

Set Driven Key 
Load Options Key Select Help 

Driver 

Driven 

transla teX 
transla teY 
translateZ 
rotate X 
rotateY 
rotateZ .. ·. 

Close 

FIG. 29 STEP 18 CONTINUED. USING THE SET 
DRIVEN KEY OPTION BOX TO SET UP 

THE LEFT FOOT CONTROL 

Select only the Heel control under the 

Driven heading. Rotate it up so that the 

heel is down while the toes point up. Look 

in the Channel box to see which axis shows 

a numerical change. This is the axis that will 

have to be keyed later. Undo the rotation 

so that all rotational axes for the heel joint 

are back to 0 , 

In the Set Driven Key box, on the right 

column, click on the name of the axis 

that showed a rotation change when you 

rotated the heel so that the toes pointed 

up. In my example, it was the ·'rotateX" 

axis. This is the axis that will be referred to 

from now on, even though yours may be 

different. The reason your rotational axis is 

different is because the rotational axes on 

your foot control were not set to point in 

the same direction as the ones in Figure 21. 

Press the Key button on the bottom lef t of 

the Set Driven Key box. 

While keeping the Set Driven Key box 

open, did( on the left foot curve to select it. In 

the Channel box, next to "footRoll" type in -5. 

In the Set Driven Key box, under the 

name Driven , select the Heel control. Ro­

tate it up about 20 degrees on the X-axis so 

that the heel is down while the toes point 

up. Press the Key button on the bottom left 

of the Set Driven Key box. 

Test it out to see how the foot lifts 

by selecting the left foot curve. In the 

Channel box, click on the attribute named 

"footRoll." Hold down the m iddle mouse 

button and click and drag left and right 

in one of the view w indows. The foot 

should rotate up and down. At the 

-5 setting in the Channel box, the foot is at 

its extreme up ang le. At the 0 setting, it is 

flat on the ground. In the Channel Box, set 

the "footRoll" back to 0. 

In the Set Driven Key box, select the Ball 

control. RotateX in the right column should 

still be selected. Click the Key button. 

Under the Driver heading, click the 

"L_Footlcon" name that wi ll select the left 

foot curve. In the Channel box, change the 

"footRoll" attribute to 5. 

In the Set Driven Key box, under the 

name Driven, select the Ball control name 

again. Rotate it about 35 degrees up on X­

axis so that the heel of the foot is up in the 
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air while the toes are flat on the g round and 

the foot bends at the ball joint. (Note: if you 

are working on the right foot, the right foot 

Ball control is rotated -35 degrees.) Oick the 

Key button. 

In the Set Driven Key box, under the 

name Driven, select the Toe control nam e. 

Click the Key button. 

Under Driver, in the Set Driven Key box, 

select the "L_Footlcon" nam e. In the Chan­

nel box, next to "footRoll" type in 10. 

Select the Toe control name under 

Driven. Rotate the Toe control up about 40 

degrees on the X-axis so that the toes point 

straight down while the heel is up in the ai r. 

(Note: if you are working on the right foot, 

the right foot Toe control is rotated -40 

degrees.) Oick the Key button and close 

the Set Driven Key box. 

Now you can test the foot roll. Select the 

left foot curve. In the Channel box, click on 

the attribute named ''footRoll.'' Hold down 

the m iddle mouse button and click and drag 

left and right in one of the view w indows. 

The foot and leg skeleton should now have 

the ability to rotate the foot up and down. 

At -5 .. footRoll " the heel is on the ground 

and the toes point straight up. At 0 the foot 

is flat on the g round. When the setting is at 

5 the heel is up while the toes remain flat on 

the ground . A setting of 10 makes the heel 

rise up higher with only the tips of the toes 

touching the ground . In the Channel box, 

set the ''footRoll" back to 0. 

Repeat all the steps outlined in Steps 17 

and 18 for the right foot control. 

STEP 19 

The two foot controls (foot icon curves) 

should now be set up to control the 

heel joints for raising and lowering the 

legs. Bring up the Outliner/ Perspective 

windows. Select the left Heel control joint 

("L_HeeiControl"). This will select your 

entire left reverse foot rig. Middle-click 

its name in the Outliner and drag it on 

top of the left foot curve ("L_Footlcon'} 

Test it out by selecting the left foot curve 

(''L_Footlcon··) and move it up and down. 

This will move the reverse foot control, 

which in turn makes the foot and leg rig go 

up and down. 

Repeat these steps for the right leg. The 

two foot icon curves are the ones used to 

control the movement and rotation of the 

feet and legs and are the ones that are 

keyframed during an animation. 

STEP 20 

Even though most of the leg movements 

are now taken care of, occasionally you 

may need to control the direction that 

the knee points toward. A pole vector 

constraint will be used to accomplish this. 

Polygon primitive objects are going to be 

made that w ill contro l the knee joints. 

Go to Create > Polygon Primitives > Cube 

(Figure 30). Scale it down so that it is about 

twice the size of the knee joint. Place it in 

front of the left hip joint ("!_hip"). Delete its 

history (Edit > Delete by Type > History). 

Freeze the cube's transformation by going 

to Modify > Freeze Transformations. 

While the cube is still selected, hold 

down the Shift key and select the left leg 

skeleton's IK Handle. Go to Constrain > Pole 

Vector (Figure 3 1). This w ill draw a line from 

the left hip joint to the cube. Now when you 

move the cube. the knee will point toward 

whichever direction you desire. Name the 

cube "L_KneePointer." 

Since we do not want the cube to render, 

select it and open up its Attribute Editor. 

Under Render Stats, turn off all the options. 

The cube will no longer show up during 

rendering. 

0 
0 
0 

Scale 0 
Parent 0 
Geometry 0 
Normal 0 
Tangent 0 

Knee 
Controls 

Repeat everything under Step 20 for the 

other knee. This time use a polygon primitive 

sphere and name it "R_KneePointer." Figure 

32 depicts all the foot, leg, and knee controls. 

STEP 21 

This time, the arm controls are going 

to be rigged. Select the "L_UprArm" joint. 

Using the IK Handle tool, click on this joint, 

and then click on the "L_ Wrist" joint (Figure 

33). You can now bend the arm by moving 

the IK Handle. The Shoulder joint is rotated 

w ith Forward Kinematics. An icon can drive 
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FIG. 33- STEP 21 , USING THE IK HANDLE TOOL ON 

THE UPPER ARM AND WRIST JOINTS. NOTICE THE 
SHOULDER JOINT IS NOT PART OF THE IK CHAIN 

each for the up, forward, and back shrug. It 

can also be rotated down to make the shoul­

ders less w ide. W ith IK you have to reach 

some kind of compromise. If the shoulder 

joint was part of the IK chain it would be 

much more difficult to control the motion 

of the arm. The reason for this is that all the 

movements on a chain of bones become 

compressed into a few goal objects. 

Dis Ia Window 

NURBS Primitives 

Subdiv Primitives II> 
Volume Primitives II> 

Sphere 
Cube 
Cylinder 

Cone 

0 
0 
0 
0 

FIG. 34- STEP 21 CONTINUED, MAKING A PRIMITIVE 

FOR USE AS A POLE VECTOR ON THE ELBOW 

In order to have more control over the 

position of the elbow, a pole vector will be 

made. Go to Create > Polygon Primitives 

> Cone (Figure 34). Scale it down to about 

twice the size of the elbow joint and move it 

behind the elbow. Name it "L_EibowPointer."" 

Delete its history (Edit > Delete by Type > 

History). Freeze the cone's transformation by 

going to Modify > Freeze Transformations. 

The cone should be set not to render. There­

fore. open up its Attribute Editor and under 

Render Stats, turn off all the options. 

While the cone is still selected, press the 

Shift key down and select the left arm's 

IK Handle. Go to Constrain > Pole Vector 

(Figure 35). Test the rotation of the arm by 

moving the cone up and down. The arm 

should turn around its X-axis. 

Repeat Step Z I for the other arm. You 

can use a polygon p rimitive torus for the 

right elbow control. The next step wi ll show 

how to create a control for the hand. 
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STEP 22 

Switch to the front view and go to Cre­

ate > EP Curve Tool. Draw the outlines of a 

hand (Figure 36). Go to the Modeling Menu 

Set and select Edit Curves > Open/ Oose 

Curves. This will enclose the outline. Scale it 

and move it behind the left hand rig. Make 

a duplicate of the hand curve (Control "d "), 

move it behind the right hand, and type 

-I next to ScaleX in the Channel Editor 

to flip it. Name them ""R_Handlcon"" and 

"L_Handlcon ... Select each hand curve and 

go to Modify > Center Pivot. While each 

of the hand curve icons are selected, go 

to Edit > Delete By Type > History. You 

should also select each hand icon and go 

to Modify > Freeze Transformations so 

that the Channel Editor only shows zero 

settings for Translate and Rotate. These 

p roperties make it easier to remember the 

hand icons· neutral positions. 

FIG. 3&- STEP 22, THE HAND ICONS MADE WITH 
THE EP CURVE TOOL THESE WILL CONTROL 

THE HAND MOVEMENTS 

Select the left arm's IK Handle. Shift-select 

the left hand icon. Press "p"" to parent them. The 

parent of the IK Handle is the hand icon curve. 

which now controls the movements of the 

arm. You can test the arm motions by selecting 

the ""L_Handlcon"" and moving it around. 

Select the right arm's IK Handle. Shift­

select the right hand curve ("R_Handlcon"). 

Press ""p "" to parent them. 

STEP 23 

Now it is time to set up the fingers so 

that they can be curled closed using the 

hand icon. Select the ""L_Handlcon·· and 

go to Window > General Editors > Channel 

Control ... (Figure 37). In the Channel Control 

option box, select all the scale and the vis­

ibility attributes under the heading Keyable. 

Oick the Move >> button on the bottom 

and close the box (Figure 38). 
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FIG. 37- STEP 23, OPENING THE CHANNEL 
CONTROL IN ORDER TO DELETE EXTRANEOUS 

CHANNEL ATTRIBUTES 

all selected objects of the same type 

Move>> I __ c_Jo_s_e__. <<Move I 
FIG. 38 STEP 23 CONTINUED. SELECTING THE 

SCALE AND VISIBILITY ATIRIBUTES IN THE CHAN­
NEL CONTROL. CLICKING THE MOVE» BUTION 

MOVES THEM OUT OF THE CHANNEL BOX 
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Transformation Tools 11> 

Reset Transformations 0 
Freeze Transformations 0 
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FIG. 39- STEP 23 CONTINUED, OPENING 

THE ATTRIBUTE BOX FOR ADDING CERTAIN 
PROPERTIES TO THE CHANNEL BOX 
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Help 

New 

Attribute Name JlndexFinger 

W Make Attribute Keyable 

Data Type 
0 Vector 0 Integer 0 String 

@ Float 0 Boolean 0 Enum 

Attribute Type 
@ Scalar er Part1cl Array 

r Add In hal State Attnb 

Numeric Attribute Properties 

Minimum Jo 

;..:.l1o~===~ Maximum 

Default Jo 

II 
Add Cancel 

FIG. 4(}- STEP 23 CONTINUED. ADDING THE FINGER 
AND THUMB ATTRIBUTES TO THE CHANNEL EDITOR 

While the "L_Handlcon" is still selected, 

go to Mocfify > Add Attribute... (Figure 39). 

In the Add Attribute option box (Figure 40), 

type "lndexFinger" next to Attribute Name. 

Under Numeric Attribute Prope.rties, next to 

Minimum, type 0. Maximum should be set 

to 10. The Default is set to 0. Oick Add to 

add the Index Finger attribute to the Channel 

Editor. Continuing in the Add Attribute box, 

type "MiddleFinger" next to Attribute Name. 

Under Numeric Attribute Properties, next to 

Minimum. type 0. For Maximum type 10. 

The Default is 0. Oick Add to add the Middle 

Finger attribute to the Channel Editor and 

type "RingFinger" next to Attribute Name. 

Under Numeric Attribute Properties, next to 

Minimum type 0. For Maximum type 10. The 

Default is 0. Oid( Add to add the Ring Finger 

attribute to the Channel Editor, and type "Pin­

kyFinger" next to Attribute Name. Under Nu­

meric Attribute Properties next to Minimum 

type 0. For Maximum type 10. The Default is 

0. Oick Add to add the Pinky Finger attribute 

to the Channel Editor, and type 'Thumb" next 

to Attribute Name. Under Numeric Attribute 

Properties, next to Minimum, type 0. For 

Maximum type 10. The Default is 0. Oid Add 

to add the Thumb attribute to the Channel 

Editor. Exit the Add Attribute options. 

STEP 24 

Go to Animate > Set Driven Key > Set > 

Options (Figure 41). While the ''L_Handlcon ·· 

curve is still selected, clid the Load Driver 

button in the Set Driven Key option box 

(Figure 42). Select the name "lndexFinger" 

from the right side column. 

Skin Conslrain 

FIG. 41- STEP 24, GOING TO THE SET 
DRIVEN KEYS OPTION BOX 

While the Set Driven Key option box is 

still open , select the base joint of the index 

finger ("L_IndexFinger"). Oick the shelf 

button with the "select -hi" Mel script. This 

will select all the joints of the index finger 

hierarchy so that you can load them alto­

gether into the Set Driven Key box. Click 

the Load Driven button. Under the Driven 

heading. it should list all the index finger 

joints. Shift-select all of these and select 

Set Driven Key 
Load Options Key Select Help 

Driver 

Driven 

L_lndexFingor 
L_lndexFingerMiddlo 
L_lndexFingerTlp 
joint20 

visibility 
translate X 
translateY 
translateZ 
rotate X 
rotateY 

scale X 
scaleY 
scaleZ 

Key II Load Driver I I Load Driven II Close 

FIG. 42- STEP 24 CONTINUED. USING THE 
SET DRIVEN KEY OPTION BOX TO SET UP 

THE LEFT INDEX FINGER 

the name "rotateZ" from the right column,. 

Press the Key button to key them in their 

neutral position. 

Under Driver, click the name "L_Handl­

con.'' In the Channel Editor, next to 

lndexFinger, type 10. Under Driven, Shift­

select all the joints of the index finger and 

rotate them on the Z-axis approximately 

-SO degrees so that the tip of the finger 

almost touches the palm of the hand. O ick 

the Key button. 

Exit the Set Driven Key box. Now you 

can test the Index finger curl. Select the 

left hand curve. In the Channel box , click 

on the attribute named "lndexFinger." Hold 

down the middle mouse button and click 

and drag left and right in one of the view 

windows. The index finger should curl 

open and closed. 

Go to Animate > Set Driven Key > Set 

> Options (Figure 41). While the ''L_Handl­

con" curve is still selected, click the Load 

Driver button in the Set Driven Key option 

box. On the right side column, select the 

name "MiddleFinger." 

While the Set Driven Key option box is 

still open, select the base joint of the middle 

finger ("L_MiddleFinger"). Oick the shelf 
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button with the "select -hi" Mel script. This 

w ill select all the joints of the middle finger 

hierarchy so that you can load them alto­

gether into the Set Driven Key box. Click 

the Load Driven button. Under the Driven 

heading, it should list all the middle finger 

joints. Shift-select all of these, and on the 

right column, select the name ··rotatez.·· 

Press the Key button to key them in their 

neutral position. 

Under Driver, click the name "L_Handl­

con." In the Channel Editor, next to 

MiddleFinger, type 10. Under Driven , Shift­

select all the joints of the middle finger and 

rotate them on the Z-axis approximately 

-50 degrees so that the tip of the finger 

almost touches the palm of the hand. Click 

the Key button. 

Exit the Set Driven Key box. Now you 

can test the middle finger curl. Select the 

left hand curve. In the Channel box, click on 

the attribute named "Middlefinger." Hold 

down the middle mouse button and click 

and drag left and right in one of the view 

w indows. The middle finger should curl 

open and closed. 

Repeat all the steps listed under Step 24 

for the rest of the fingers and the thumb. 

You will then be able to curl the fingers and 

thumb into a fist or curl each of them in 

whatever pose you need. After completing 

the left hand, repeat Steps 23 and 24 for 

the right hand. 

If you find that the fingers of the rig do 

not fit the model as they did before using 

Set Driven Keys, then open the Set Driven 

Keys option box and load in the hand curve 

as the Driver and each finger's joint hier­

archy as the Driven. Make sure the Driver 

attributes for each finger and thumb are set 

to 0 in the Channel Editor. Select the joints 

under Driven , rotate them into their correct 

positions inside the hand mesh and press 

the Key button. Repeat this procedure for 

each finger and thumb. 

With Set Driven Keys you can also add 

wrist movements to the hand icon. Start by 

adding movements such as hand up and 

down and side to side to the Add Attribute 
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box (Figure 39). In the Set Driven Key box, 

load the hand icon as the Driver. Load the 

wrist joint as the Driven. Set Keys after 

rotating the wrist. Figure 43 shows all the 

attributes of the hand icon as seen in the 

Channel box. 

Channels Objects 
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STEP 25 

This time the spine will be rigged with a 

spline II<. You can review the previously writ­

ten and illustrated information in the previous 

tutorial under the heading Weighting an II< 

Spline Handle. Figures II - 17 illustrate the 

principles that will be covered in this section. 

To keep the root joint from locking down, 

we will build another joint below it. Switch to 

the side and front views. In the side view just 

below the root joint (the first spine joint), click 

w ith the joint tool just once to make a single 

joint (Figure 44). Rename the first spine joint 

"BaseOfSpine" and the new root joint "Root." 

Root Joint 
FIG. 44- STEP 25, THE NEWLY CREATED ROOT JOINT 

FIG. 45- STEP 25 CONTINUED, PARENTING 
THE HIP JOINTS TO THE NEW ROOT JOINT 

FIG. 46- STEP 25 CONTINUED, AFTER PARENTING 
THE BASE OF THE SPINE JOINT TO THE ROOT JOINT 

Re-parent the hip joints to the new root 

joint. In the Outliner, select the left hip jo int 

and m iddle-dick/ drag it on top of the one 

named "Root." Select the right hip joint and 

I 
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middle-click/drag it on top of the "Root'' 

joint. You should now see a gap between the 

"Root" and the ''BaseOfSpine" joints (Figure 

45). Now select the "BaseOfSpine" joint in the 

Outliner and m iddle-click/drag it on top of 

the "Roof ' joint. This will create a new bone 

between the two joints that points up (Figure 

46). The newly created root joint is the one 

that w ill have the spline IK added to it. 

STEP 26 

Select the IK Spline Handle tool by going to 

Skeleton > IK Spline Handle Tool. Oick on the 

"Root" joint first and then did( the joint named 

;'spine6"; it is the one below the nea joint and 

between the two arm joints (Figure 47). The 

spline curve that is inside the spine joints can 

be used to control them, but the problem is 

that it also moves the root joint, w hich should 

remain stationary. To fix this problem, the 

next step will have you weig h the control 

vertices along the IK spline curve. The 01 at 

the root joint will be assig ned a weight of 0 so 

that the root will no longer be affected. First 

you will need to make some Ouster Handles 

to control three g roups of vertices. 

STEP 27 

At the top of your screen, find the selection 

mode icon for Joints. It has the same icon as 

the joint tool has. Oick the button to turn it off 

so that you will not be able to select the joints 

of the spine. Oid( on the IK Spline to select it 

and go to the view window menu item Show . 

Under Show, select Isolate Select > View 

Selected. This will hide everything except the 

selected IK spline curve. 

Press F8 so that you 

can select the spline's 

vertices with component 

type. Draw a selection 

around all the compo­

nents in your side view. 

You should now see the 

control vertices along 

the spline highlighted. 

Select the bottom three 

vertices and go to 

Deform > Create Ouster. 

This will give you a 

Ouster Handle that will 

move the IK Spline and 

its hidden skeleton. You 

will not see it until you 

go to Show > Isolated 

Select > View Selected. 

Select the next two ver-

tices and go to Deform 

> Create Ouster. Select 

the top vertex and go to 

Deform > Create Ouster. • 

You should now have 

three Ouster Handles 

along the spine that 

can control the way it 

bends (Figure 48). The 

next step will show how 

to get the base of the 

spine to remain station-

ary w hile the rest of the 

spine can be moved. 

c 

• 

c 

c 

FIG. 48- STEP 27, THE IK SPLINE CONTROL 
VERTICES, THE THREE CLUSTER HANDLES, THE 
IK SPLINE, AND THE IK HANDLE WITH ITS WIRE 

STEP 28 

. .. . . 
Options Layout Help 

Weighted Oeformers ]Rigid Skins Smooth Skins SpringsJPartieles J 

cluster1 cluster2 cluster3 
curveSh~ 

ev 0 0.000 
ev 1 0.300 
ev 2 0.600 
ev 3 0.700 
ev 4 0.800 
ev 5 1.000 

~lm::::JO i )1.oo I 

! Load Components II Close I 
FIG. 49- STEP 28, IN THE COMPONENT EDITOR, 

FOR EACH CONTROL VERTICES, USE THE 
SETIINGS SHOWN HERE TO GIVE EACH 

C A DIFFERENT WEIGHT 

Select all the control vertices of the 

spline curve and go to Window> General 

Editors > Component Editor ... Figure 49 

shows the three Cluster Handles listed 

under the Weighted Deformers tab. Type 

the same value into the Component Editor 

as the ones listed in Fig ure 46. Close the 

Component Edi tor. 

STEP 29 

Press F8 to get ou t of component 

type and back to object type. Bring up 

the Perspect ive and Outliner w indows. 

Rename the Cluster Handles. Change 

"cluster !Handle" to "SpineBase.'' Make 

"cluster2Handle" into "SpineMiddle." 

Rename "cluster3Handle" "SpineTop." 

Test the three Cluster Handles by 

moving them around to see the w ay the 

sp ine bends. You can always go back to 

Windows > General Editors > Component 

Editor... to change the weights of the 

vertices. Twisting the shoulders back 

and forth is done w ith the IK Handle at 

the top of the spi ne. 

When you are finished testing the 

spline, it is very impor tant that you undo 

any movements so that you r rig still fits 

into the character. 
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SfEP 30 

Sometimes the Ouster Handles are difficult 

to select. To fix this problem. select one of 

the Ouster Handles 

and go to Display > 

Component Display 

> Selection Handles. 

This will put a small 

plus sign on the 

''C Ouster Handle. 

Press F8 to go into 

component type 

and clicl( the + sign 

(Selection Handles 

Component) at the 

top of the screen. 

Turn off all the other 

component types. 

This will make it 

easier to select the 

cluster + hanclle. 

Draw a selection 

around the selec­

tion handle. Move 

it behind the "(" 

Ouster Handle so it 

will be easy to find 

and select. Repeat 

these steps to make 

selection handles 

for the other two 

Ouster Handles 

(Figure 50). 

IK Handle 

-"""' 
c + 

~ 
'c + 

/, ' ('J. Cluster 
'(j Handle 

Cluster 
~ andle 

t 
c + 

FIG. 50- STEP 30. THE THREE SELECTION 
HANDLES(+ SIGNS) FOR MOVING EACH 

OF THE CLUSTER HANDLES 

SfEP 31 

You probably noticed that when you 

moved the Cluster Handles to bend the 

skeleton the arms remained unaffected 

and stayed behind. This needs to be 

fixed. Select the left hand icon curve. 

Shift-select the "spine6" joint. This is 

the joint that has the Spline IK Hand le in 

it. The two arm bones branch from this 

joint. Press "p" so that the "L_Handlcon .. 

becomes parented to "spine6"- "spine6" 

is the parent and "L_Hand lcon .. is the 

chi ld. Repeat this step with the other 

hand icon. Now, when you move the 

---+"=- M~~~ 3~ ISSUE 4 

Hand 
~Icon 

~ :------
1~ Spine 6 Joint 

FIG. 51- STEP 31, PARENTING THE HAND 
ICONS TO THE SPINE 6 JOINT 

Cluster Handles, the arms also move 

(Figure 51). 

In the Outliner window, select the root 

joint. Press Control "g" to group everything. 

Name the group "Master." Continuing in the 

Outliner window, select the "L_KneePointer" 

primitive (cube), the "R_KneePointer" 

primitive (sphere), the "L_Footlcon" curve, 

the "R_Footlcon" curve, and the spline curve 

inside the spine. Drag each of them on top 

of the group named "Master." This will put 

them inside the "Master" group so that when 

you select the "Master," all the parts of the 

character will move with it. 

Another icon will be made to control the 

overall movements of the character. In your 

side view, behind your character's back, use 

the 01 Curve tool to draw the outlines of 

an arrow that points up. Go to Edit Curves 

> Open/Oose Curves to close the arrow 

icon curve. Center the pivot point of the 

arrow icon (Modify > Center Pivot). Name it 

"RootControl." 

In the Outliner , select the "Roof· joint and 

middle-click/drag it on top of the ·'RootCon­

trol " arrow icon. Now the arrow icon is the 

parent of the root joint. 

Select the left elbow pole vector object (the 

primitive cone named "L_EibowPointer"). In 

the Outliner window, middle-clicl(/drag it 

on top of the "Root Control" (arrow icon). 

Repeat this parenting step with the other 

elbow pole vector (the torus primitive). 

In the Outliner, middle-diajdrag the ar­

row icon "RootControl" on top of the group 

named "Master." The spine curve should also 

be inside the "RootControl" arrow icon. The 

order of objects inside the Master group is: 

Master 
L_KneePointer 
R_KneePointer 
L_Footlcon 
R_Footlcon 
RootControl 

Root 
Spine Curve 

Test the rig by moving the ''RootControl" 

arrow icon. All parts of the body should 

move except for the left and right knee 

pointers and the left and right foot icons. 

Be sure to undo everything to restore the 

rig back to its original position. When you 

need to move the entire rig and all the com­

ponents, select the folder called "Master" in 

the Outliner w indow . Figure 52 shows the 

Show Panels 

~ persp 

~ top 

~ front 

~ s1de 

El D Clusters 

~ 
LwrSpineCiusterHandle 

MiddleSpineCiusterHandle ., UpperSpineCiusterHandle 

El D Master 

• L_KneePointer 

• R_KneePointer 

[±] (\J R_Footlcon 

[±] (\J L_Footlcon 

[±] (\J Root Control 

~ Spine_ikHandle 

(!) defaultlightSet 

(!) defaultObjectSet 

FIG. 52-STEP 31 CONTINUED. MAKING THE MASTER 
FOLDER IN THE OUTLINER. NOTICE THE SPINE 

CLUSTERS ARE LEFT OUTSIDE OF THE MASTER 
FOLDER. THE ELBOW POLE VECTOR PRIMITIVES 

ARE INSIDE THE ROOT JOINT 
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arrangement of all the objects and folders 

as seen in the Outliner. The spine clusters 

can remain outside of the Master folder 

because Set Driven Keys can be made to 

drive those w ith the root arrow icon. This w ill 

be discussed in Step 33. 

STEP 32 

One more attribute will be added to the 

"RootControl" arrow icon. Go to Window > 

General Editors > Channel Control ... In the 

Channel Control option box, under Keyable, 

select scaleX, scaleY, scaleZ, and Visibility , 

and click the Move button to remove them 

from the Channel E.ditor. 

Go to Modify > Add Attribute ... For the 

Attribute Name type in Twist and click OK. 

There is no need to type a value. Under the 

Channel Editor, you should now see the 

word 'Twist'' (Figure 53). 

Go to Window > General Editors > Con­

nection Editor ... In the Connection E.ditor, 

click the Reload Left button to load the vari­

ous attributes for the "RootControl." Scroll 

down all the way to the bottom and click the 

'Twist" attribute name. Leave the Control 

Editor open, and in your perspective view, 

select the spine IK Handle located between 

the arm bones. Click the Reload Right button 

located at the top right. The IK Handle's at­

tributes are now loaded in the right column. 

Scroll down until you see the word 'Twist" 

in the right column and select it. With the 

name 'Twist" selected in both columns, the 

two attributes are automatically connected. 

Close the Connection Editor. You can test 

this attribute by selecting the "RootControl" 

arrow icon, going to the Channel Editor, 

highlighting the word 'Twist." and middle­

click/ dragging in the perspective window 

left and right. The 'Twist'' values will 

change. If you select the IK Handle of the 

spine you w ill notice that next to the 'Twist" 

name in the Channel Editor. it has the same 

value as the "RootControl" arrow icon had in 

its Channel Editor. 

STEP 33 

The "RootControl" can also be made to 

control the flexibi lity o f the spine w ith Set 

Driven Keys moderating the movements of 

the three spine Clusters. 

Select the "RootControl" arrow icon 

and go to Modify > Add Attribute ... In 

the Add Attribute box, next to Attribute 

Name, type the following nam es with a 

Minimum of - 10, Maximum 10, and a De­

fault of 0. Click the Add button for each to 

put them in the arrow icon's Channel box. 

The attributes are: 

Lw rSpineZ 

Lw rSpineX 

MdiSpineZ 

MdiSpineX 

UprSpineZ 

UprSpineX 

After closing the Add Attribute box, go 

to Animation > Animate > Set Driven Key > 

Set > Option. Load the "RootControl" arrow 

icon as the Driver. Select the lower spine 

Cluster Handle and load it as the Driven. 

In the right hand column, under the Driver 

heading. select "Lw rSpineZ." Under Driven, 

select "translateZ" in the column on the right. 

Press the Key button to key the lower spine 

Ouster Handle in its neutral position. 

Under Driver, select the "RootControl" 

and in the Channel box, next to "Lw rSpi­

neZ,.. type 10. Under Driven, select the 

lower spine Cluster Handle and move it 

forward to bend the lower part of the spine 

frontward, which in turn m akes the stom­

ach stick out. Press the Key button. 

Under Driver, select the "RootControl " 

and in the Channel box, next to "LwrSpi­

neZ," type -10. Under Driven, select the 

lower spine Cluster Handle and m ove it 

back to bend the lower part of the spine 

backward, which in turn makes the stom­

ach go in. Press the Key button. 

Under Driver, select the ''RootControl" and 

in the Channel box, next to ''LwrSpineZ," 

type 0 to return the lower spine back to its 

neutral position. 

In the right hand column, under the 

Driver heading, select "Lw rSpineX." 

Under Driven, select "translate)(" in the 

column on the right. Press the Key button 

to key the lower spine Cluster Handle in 

its neutral position. 

Under Driver, select the "RootCon­

trol" and in the Channel box, next to 

"LwrSpineX,'' type 10. Under Driven, select 

the lower spine Cluster Handle and move it 

to the right on the X axis, which makes the 

pelv is tilt. Press the Key button. 

Under Driver, select the "RootCon­

trol" and in the Channel box, next to 

"Lw rSpineX, .. type -10. Under Driven, select 

the lower spine Cluster Handle and move 

it to the left on the X axis to tilt the pelvis 

in the opposite direction. Press the Key 

button. 

Under Driver, select the "RootCon­

trol'' and in the Channel box, next to 

"LwrSpineX,'' type 0 to return the lower 

spine back to its neutral position. 

Select the middle spine Cluster Handle 

and load it as the Driven in the Set Driven 

Key box. Follow all the previous steps to 

make the spine bend in the middle on the 

Z and X-axes. Do the same w ith the upper 

spine Cluster Handle. 

You should now have full control of the 

spine with the ·'RootControl" arrow icon 

(Figure 54 Next Page). The spine Clusters 

can now be hidden either through the At­

tribute Editor or by placing them in a Layer 

with other Clusters. 
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STEP 34 

The two shoulder joints can be controlled 

with Point Contstraints. Create two icons 

such as those seen in Flgure 55. Parent 

them to the Root Control icon. 

left shoul-

delete its ...a-~9"--~~:Q;.,..Jl_,_ 

~J~\co:.e~ 
h i story, 

and go to 

Modify > freeze 

Transformations. While the left 

shoulder icon is still selected. Shift­

select the left shoulder joint. Go to 

Anirncttion>ConrriUn>Point. Select the 

left shoulder icon and Shift select • 

the Root Control arrow icon. 

Press .. p .. to parent the shoulder 

icon to the Root Control arrow icon. 

Repeat this process for the other 

shoulder joint. 

Some of you may p refer to 

just make blend shapes or morph 

targets for the shoulder shrug. The 

advantage to these is that they can 

keep the file size down and also give 

you greater control over the appear­

ance of the mesh. The technique 

for creating blend shapes that 

alter the body to fix unsightly 

deformations at the joints is 

also used for creating the 

shrug. The next issue wi ll 

discuss this topic. 

This completes the IK skeleton set up. Fig­

ure 56 shows the skeleton with all its icons 

and controllers. Notice the extra joints at the 

breasts. They are parented to the .. spineS" 

joint and keep the breasts from collapsing 

when the spine bends. More joints have also 

been added to the torso so that there is less 

time spent painting weight maps. 

The next issue w ill discuss rigid and 

smooth binding as well as creating blend 

shapes (morphs). Character sets and using 

the Trax Editor are also subjects that will 

be covered in future issues. since these 

will get you started with Maya·s way of 

animating digital humans. ~ 
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Even though it seemed a breakthrough technique at the time. 
nowadays it's actually relatively easy to recreate In many 3D packages 
straight out of the box. In fact, these days, it's such a simple trick to 
do that I realized it would be a great opportunity to do something 
unique and interesting with this tutorial. It's something that I've always 
wanted as a reader myself: a side-by-side comparison of the same 
technique done simultaneously in two 3D packages. 

What I'm going to do in this tutorial is try to recreate that floating 
Kling on blood from Star Trek VI, but with the added interesting twist 

of doing it both in Maya and UghtWave 3D at the same time. A lot of 
the time, the biggest blocker for learning a new piece of software is 
finding out where everything is kept or named in the new package. 
and which tools do similar things to what you're used to. For example, 
Ug htWave has Hypervoxels, but it's just a name specifically made by 
NewTek. So, hopefully, by writing the two programs alongside each 
other, I can show you w hat each of the features are (and where they 

are) in each pad<age. This should be a great way for anyone with ex-

MAYA: 

1. INTRODUCilON &.. SCENE SETUP 

Unlike UghtWave, most 3D applications are not split up into 
multiple programs. Maya is no exception to this; however, it's a little 
different in that it groups each of the disciplines together into separate 
menus (i.e. Animation, Modeling, Dynamics, and Rendering). You'll 

notice that the menus at the top change depending on which mode 
you have selected. This is somewhat analogous to having multiple 

CONTINUED ON PAGE 42 

perience in either of the packages to compare each tool side-by-side. 

First of all, though, let's break down the effect that we're trying to 

achieve. Remember, techniques are almost invariably the same no mat­

ter which 3D pad<age you use, so it's important to get into the habit of 
breaking any thing down into its constituent parts and planning ahead. 

At its heart, the Klingon blood is a simple trick made possible 

by the use of M etaballs. Yes. that's Metaballs, not Meatballs. It's 
also sometimes known as Blobby Modeling, or in this case, Blobby 
Particles, when applied to an emitter. Basically , they're volumetric 
objects that attract and deform each other. In UghtWave. these are 
Hypervoxels. and in Maya they are simply called Blobby !'articles. 

With this in mind, there are essentially two parts to the procedure; 
set up some interesting particle interactions using Metaballs, then 
create a purple material/shader and apply it onto the particles to 
finish the look. So, choose your poison and let's jump right in. 

UghtWave: 

C 1. INTRODUCilON &.. SCENE SETUP ) 
-· ----------------------~ 

The first thing you'll no doubt notice Is that UghtWave is split 
into two programs, one for modeling (LW_Modeler) and one for 
setting up the scene and doing everything else (LW_Layout). This 
seems strange at first, and is completely unlike nearly every other 
3D application, but if you think about it, then you'll see that there 
are actually some comparisons w ith Maya. Maya's modules are dis-

CONTINUED ON PAGE 43 



MAYA- CONTINUED FROM PAGE 41 
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FIG A- THE MAYA INTERFACE WHEN YOU LOAD UP 

programs, but all contained in just the one software package. Also, if 

you're coming from UghtWave, it actually makes a bit o f sense; since 

having all the modeling tools in one module, it's similar to using the 

LW_Modeler program and switching back and forth. 

Since there isn't any geometry to model or animate in this tutorial, we'll 

just stay in the "Dynamics" module for most of the tutorial. I'll be using 

Maya 6, but any version above 4 will do fine. Start up Maya, and switch to 

this mode using the dropdown menu on the left of the toolbar (Fig A). 

2. CREATE PARTICLE EMrTTER 

Now that you're in the "Dynamics" module group, select Create 

Emitter from the Particles menu (Fig B). There is a little box next to each 

menu item, which is simply the options panel. but don't worry about 

that for the moment and simply use the default settings. This should 

now create a standard particle emitter in the center of the world. Oicl< 

Play if you want, and you should see particles spitting out of the center. 

It's that simple to set up a particle emitter! In one step ... 

In fact. Maya makes it even easier than that by having the icon tab 

shortcuts just above the main viewport. You 'll notice they 've provided 

a number of presets (General, Curves, Surfaces, and so on), but it's just 

g.Q~i'ii ~~ ISSUE 4 
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FIG C- CLICK ON THE FIRST ICON ON THE LEFT TO CREATE AN EMITTER 

as easy to create your own tab and organize them with your most 

used links. For example, the step above can just as easily be done by 

switching to the Dynamics icon tab and hitting the first icon, w hich is 

the Create Emitter link (Fig C). CONTINUED ON PAGE 44 
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LIGHTWAVE- CONTINUED FROM PAGE 41 

ciplines within the program that effectively split it up into sepa­
rate parts and menus ... so having a separate program for modeling 
is similar to always having to switch back to the modeling module 
in Maya. It's just a different way of thinking. 

LightWave has complete integration between the two programs, 
meaning whatever you model in LW_M odeler will automatically 
update when you switch back to LW_Layout. For this tutorial, how­
ever, since we're not really going to model anything, we'll spend 
all of our time in LW_Layout (Fig 1). I'll be using LightWave 8.2, but 
anything from 6-7 upwards would probably be fine. 

C 2. CREATE PARTICLE EMmER ) 
~-----------------------

Under the Utilities tab, select FX Browser from the Plug lns > Ad­
ditional dropdown menu. This is the utili ty we're going to use to 
create our particle emitter (Fig 2). Like M aya, you can also custom­
ize the interface by creating your own tabs at the top (more on this 
later), which can be a g reat timesaver by having all your favorite 
links in one place. 

In the FX Browser w indow, click on the dropdown menu next 
to Add, and simply select HVEmitter again. This will create a new 

EiJ FX Browser for LWB 

I Option I Add I HVE .. t .. 

-1 <oi!Jco¢ ... Ptem I 

r.; FX_Emltter 

FIG 2- THE FX BROWSER IS A POWERFUL TOOL 
FOR PARTICLE CREATION AND MUCH MORE 

FIG 3- SETUP THE PROPERTIES 
OF THE PARTICLE EMITIER 

particle emitter. If you play the scene, you'll notice the particles are 
being born inside the extents of the emitter. 

C 3. DEFINE EMnTER PROPERTIES ) 
~---------------------~ 

Since we've only created one particle emitter, it's automatically 
selected by default in the FX Browser, so simply click on the Properties. 
This will bring up another window (Fig 3) with a number of tabs along 

CONTINUED ON PAGE 45 
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3. DEANE EMITTER. PROPERTIES 
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FIG D- THE CHANNEL EDITOR IS 
WHERE YOU CHANGE MOST OF THE 

SETTINGS 

Now that we've created our 

emitter, it's a simple matter of 

setting up all the properties. This 

is done in Maya using the Chan­

nel Box/ Layer Editor, which is 

that window docked on the right­

hand side of the interface (Fig D). 

First thing to do is to change the 

Emitter Type to Volume Emitter. 

This will tell Maya that we simply 

want to emit particles from w ithin 

a volume rather than a point. This 

does not change the particle type 

- they are still dots at the mo­

ment, but we'll change that later. 

Next, let's increase the emis­

sion size, which is done simply 

by increasing the Scale to 10 on 

x , y, z. To shake up the particle's 

movement a bit, set the Random 

Direction to something like 3. You 

can also modify the Speed a bit if 

you want. This should give you 

something akin to (Fig E). Now 

we're cooking. 

MAYA- CONTINUED FROM PAGE 42 

4. MAKING THE PARTia.ES BLOBUlAR 

Now that the particles are moving about nicely, let's jump in and g ive 

them that blobular nature. In (Fig E) you'll notice I have the outliner open; 

this is the scene manager and is extremely handy for selecting objects 

in a scene by their name. It's found in Window > OuHiner, but I always 

add it as one of my crudal shortcut icons (Shift-Kirag onto menu). In the 

list, you should see Emitter I and Particle I, which could seem confusing 

at first, but actually makes sense. Maya emits particles from emitters, 

and by having these as separate objects, you can set up their properties 

separately. Think of it as the emitter controlling how all the particles be­

have as a whole (a normal HVEmitter in LW), and the particle controlling 

how each indMdual particle looks (similar to Hypervoxels in LW). 

Select Particle I, and then in the channel box properties on the 

right, change the Particle Render Type to Blobby Surface. In the main 

viewport, this should change the particle dots into d rcles. We've just 

changed the particles from dots to metaballs. If you rendered now, all 

you'd see were spheres in place of the particles. 

We need to change some options to make it appear blobby. For 

this, bring up the Attribute Editor (press Ctri+A) and go into the par­

ticleShape I tab, then under Render Attributes, click on Current Render 

Type, which should reveal "Radius" and 'Threshold" (Fig F. on page 22). 

Change the Radius to something like 4, and change the Threshold to 

0.5. The important setting here is the Threshold, since this affects the 

amount of blending each particle exerts on the other. 
CONTINUED ON PAGE 46 
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FIG E- USE THE OUTLINER AS A SCENE MANAGER 
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the top, and it's here that all the properties are set up for the emitter. 
Let's increase the emission area first, which is done by increasing the 

Generator Size to something like 10m on x , y, z. Leave everything else 
in the Generator and Particle tabs as they are for the moment, but under 
the Motion tab, change the Explosion to 0.2 m/ s, make Vibration 2.0 
m/ s. and set Vibration (min) to about 50%. You can also increase the 
Velocity if you want, but all of this is simply designed to shake up the 
particle's movement within the emission area and make it look a bit 
more erratic. Feel free to play around a bit more, but by now you should 
be seeing something similar to (Ag 4). 

C 4. MAKJNG THE PARTICLES BLOBULAR ) 
-· ----------------------~ 

So, even though the particles are doing something interesting now, 
you'll still get a black screen if you do a test render (just press F9). Let's 

go ahead and give them that blobular property that will make them 
react together like the Klingon blood. This is done in UghtWave with 
a tool called Hypervoxels, which is actually a lot more than just Blobby 
particles, sharing some features with aspects of Maya's new Fluid 
Dynamics, and is q uite an extensible volumetric renderer. 

To add Hypervoxels, go to Window > Volumetrics and Fog Options, 
and then select it from the Add Volumetric d ro)XIown menu. Double­
click on it in the list to open the Hypervoxels settings panel. (Since I tend 
to use it quite a lot, I added it as a direct link in my custom menu tab.) 
H ighlight the HVEmitter that we created earlier, and then dick Activate. 
This will associate the Hypervoxels shader with our particle emitter. You 
can affect numerous particle emitters with just one Hypervoxel shader 
in this way by simply selecting (tid<ing) which ones get affected (Ag 5). 

IS'-P .. ticle• 
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A good analogy for comparing this with Maya is to think of the 
HVEmitter as the ·emitter' object, and the ·particle' object as being 
handled by Hypervoxels. The default settings will automatically cre­
ate a metaball-type particle surface, so doing a test render now will 
show a pretty close approximation o f w hat w e're after already (Fig 
6 , top of page 47). You'll notice that we got to this step just slightly 
faster in LightWave than In Maya. CONTINUED ON PAGE 47 
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FIG F- THE ATTRIBUTE EDITOR GIVES YOU 

EVERY SETTING YOU NEED 

5. SHADING THE PARTIO.ES 

If the Attribute E.ditor replaced the channel box in the step above, 

you can set it up in the Window > Settings/Preferences > Preferences 

to open as a separate undocked window. Let"s render a test frame to 

see what we've got. The blobby surface particle requires a software 

renderer, which is what should be set up as default. You'll see three 

icons on the main toolbar that look like fi lm-clappers. The last will g ive 

you the rendering options, the second is similar to LightWave's VIPE.R. 

and the first icon will render the scene. Try that now, and you'll see a 

bunch of gray particles all joining together when they touch (Fig G). 

Time to apply a shader that will make them look more like blood. 

Unlike LightWave, where this is all handled within Hypervox­

els, we've got to set up a specific shader and apply it to the 

particles. This is where I'll introduce you to the Hypershader, 

which is used for texturing/surfacing everything in Maya. Click 

Window > Rendering Editors > Hypershade to start it up (Fig H). 

At first sight , this wi ll look totally alien to any LightWave users 

and may appear quite daunting. Give it some time. however, and 

you'll soon see how powerful it is. 

Unlike LightWave, Maya splits surfaces into different types. Gen­

erally, a l .amberf shader is for general-purpose matte surfaces with 

no specularity. 'Blinn' is good for metals, 'Phong· works well for glass 

or plastics. and 'Anisotropic' is good for things like velvet or satin. 

For this tutorial. let's just use a Phong, as it will give us some nice 

specular highlights. Oick on it once to create a new shader node. 

~©Wa 3~ ISSUE 4 

Double-clicking on this 

new node will bring up 

the Attribute E.ditor with 

a far more familiar looking 

settings panel that will 

remind you of the Surface 

E.ditor in LightWave. 

Go ahead and play 

around w ith the settings 

- I gave it the infamous 

Klingon Blood purple color 

(249,66, 116), but with a 

hint of red, and ramped 

up the specular and reflec­

tions. My settings were as 

follows (Fig 1): 

CONTINUED ON PAGE 48 
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FIG 1- PLAY AROUND WITH THE SETIINGS 

TO GET THE DESIRED LOOK 
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FIG 6- REMEMBER, THESE ARE METABALLS, NOT MEATBALLS 

C 5. SHADING THE PARTia..ES ) 
~. ----------------------~ 

You may have to play with the Particle Size In Hypervoxels a 
bi t, but I found leaving it around 1.0 seemed fine for the moment. 
Lefs change it from the drab gray look and define the shader a 
bit now. Coming from Maya, where you would now normally 
apply a material to the particle, you may be surprised to see that 
this is all still done within the Hypervoxels interface. 

By the way, if you·re finding it a pain to always have to go to 
the Window > Volumetric and Fog Options > Hypervoxels 3.0 to 
start Hypervoxels, or any other tool for that matter, then simply 
add them as a shortcut to your own tab as discussed earlier. To 
do this, go to File > Edit Menu Lclyout and use the tool to create 
and organize your own menu bar at the top. I find using the 
search function here quite useful, and then I simply add each link 
to the menu. Trust me, this is a real timesaver. 

Back in Hypervoxels, click on the Shading tab, and it should 
give you something similar to Maya shader's properties panel (Fig 
7). This is actually a recreation of the same interface used by the 
Surface Editor (the main surfacing/ texturing tool). In fact, you can 
compare the two (just press FS or click on the Surface Editor link 
on the top left) and see they·re almost identical. The advantage 
here is that with the Hypervoxels panel it really gives you a lot 
of control over fine-tuning the look and surface of the particles. 
There are also a lot of cool Preset settings ready made that you 
can apply. If you're feeling adventurous, save your scene now, 
and apply a few of the presets to try them out (Window > Presets). 
Play around a bit until you're more accustomed to the Interface. 
and then reload again when you 're done. 

I I F .. Refraction I 

FIG 7- THE MATERIAL FOR THE PARTICLES IS 
CREATED WITHIN HYPERVOXELS 

FIG 8- THESE ARE MY INITIAL SETIINGS. BUT FIDDLE A BIT 

first thing to change is obviously the color. The Klingon Blood 
from the film is infamous for being a purplish tinr, but I added 
a tad more red in there too so it would read better. Generally, I 
just played around with the settings co make it look a bit more 
viscous. Unfortunately, unlike Maya, there aren't any shader 
types (such as Phong, Blinn, etc.) that do half the work for you, 
so it's really just a matter of experimenting a bit. 

Here are my final settings (fig 8): 

CONTINUED ON PAGE 49 
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FIG J- MAKE SURE YOU HAVE THE PARTICLE1 OBJECT SELECTED FIRST 

Now that you've got the shader set up, let's apply it to the particle 

node. This is actually quite easy - just select the 'Particle I' object from 

the Outliner (like in Fig E). then with this selected. right-click on the 

material and select Assign Material to Selection from the radial menu 

(Fig ]). Note, you applied the shader to the particle, not to the emitter, 

which I hope makes sense to you. 

6. MORE ADVANCED SHADING 

Your blood should look something like (Fig K), which isn 't quite 

there but it's a good starting foundation. Now we can delve deeper 

into Maya to enhance the look a bit more. The two obvious areas 

are adding reflections and breaking up the surface w ith a bump 

map. and then maybe after that, adding a fractal pattern to the 

color channel to add depth. 
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FIG L- THIS ACTS THE SAME AS A 
TEXTURE-PICKER 

To set up the reflections, let's add an environment cube map to 

the Reflected Color channel. Click on that black and w hite checkered 

box, which is the same as the 'T" feature in LightWave. From the 

Create Render Node menu that comes up, select Env Ball f rom the 

Environment Textures section. Now add an image for the map. 

which could be anything you like, but a general Fractal pattern is 

adequate. I chose Solid Fractal from the 3D Textures section of the 

Create Render Node menu (Fig L). At this point, your Attribute Edi­

tor w ill be in the Solid Fractal settings, and you can click on the two 

funny looking arrows near the top (next to Focus/ Presets) to shuffle 

back up the chain to the main properties for the shader. 

Click on the checkered box for the Bump Mapping channel, and 

add another Solid Fractal into this. However, this time let's change 

the settings a bit and reduce its effect. Bring the amplitude down to 

about 0.3-0.4, and play around with some of the other settings. By 

the way, clicking the animated tick box will make this f ractal texture 

animate over time, which is handy if you want to make a movie. 

Finally, let's repeat the whole process one more time, this time in 

the Color channel. This time, select Layered Texture from the Create 

Render Node menu. Before, we were replacing the channels with the 

CONTINUED ON PAGE 50 

I 



LIGHTWAVE- CONTINUED FROM PAGE 47 

.jl: ; ., .. • :1 1!1 x . . .. i]·-;.. . ... ·-··lm:::ml 

' 
ll![i!ll!l ., \ 

,! 
,, .i ., 

• • • 
• • , ., ., 

' -, 
' 

<It' 
. !, I 

~· 
• 

• 
' • • .. 

FIG 9- GETIING CLOSER. SPICY RED MEATBALLS 

C G. MORE ADVANCED SHADING ) 
------------------------~ 

By now, you'll probably have something like (Fig 9), which is a 
good starting point, but there are a few more things we can do to 
enhance the look. 

First off, let's set up the reflections with an environment map of sorts. 
If you select the Environment tab in the Hypervoxels window, you'll 
see that you have the option of several types of reflection types. For 
this tutorial, I used Ray Tracing + Backdrop, which w ill reflect each of 
the blood cells against each other and also add in a backdrop. To make 
this work, you need to change the background, which can be done in 
Window > Backdrop Options. It's not the best way, but it's fast and 
w ill do the trick for what we want. I added in a Textured environment 
from the Add Environment tab, and used a Fractal Noise pattern. Most 
of the 30 applications these days come with procedural generation, 
but I find UghtWave's to be more extensible and powerful, as it was 
a big feature in much earlier versions. In the layer type, change it to 
Procedural Texture, and you'll have a load of different styles to choose 
from. I kept it on the default Turbulence and only changed the Size 
down to 0.1 on x , y , z. The other Important thing is to set the Layer 
Opacity down to something like 9% so it's not too overwhelming (see 
Fig 10). LightWave's renderer must also be told to turn on Reflections 
I Shadows I Refraction in order for this to show up. This is done in the 
Render Options panel (Render > Options > Render Options). You'll 
see In (Fig II) that I've turned all of these options on. 

Another thing we can do to make it look better Is to break up that 
perfectly smooth surface a bit with a bump map. In fact, we can do this 
in two places. First of all, select the Hyper Texture tab; this is where you 
define the surface of the partides, making them look mottled, smoky, 
or rlpply. From the Texture dropdown, select Turbulence, and leave all 
the default settings as they are, but bring the Texture Amplitude down 
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a bit (Fig 12). The other 

place you can add some 

definition is in the actual 

shader bump map. Back 

in the Shading > Basic 
tab, you'll notice the 

'T' next to each option. 

Oicking this allows you 

to set up a texture to be 

used in the slot. Oick that 

now, and in the Layer 

Type at the top, make it a OPTIONS IN THE RENDER MENU 

·~ HyporVo>01 ls 3.0 
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FIG 12- ADDING A HYPERTEXTURE BUMP WILL BREAKUP 
THE PARTICLES SURFACE 
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FIG M- LAYERED TEXTURES ARE ACTUALLY 
QUITE POWERFUL 

fractal patterns, but in the Color channel we want to have two separate 

layers of colors. What you'll get in the Attribute Editor is an interesting 

concept, whereby clicking anywhere in the red box w ill create a new 

texture layer, and you can edit them separately and blend them to­

gether to create the overall effect (Fig M ).lt's quite useful actually . Give 

the first texture the same color that you originally used for the material 

(249,66, 116), as this w ill be the base layer. Then, add a fractal pattern 

onto the second layer. This time. under the Color Balance > Color 

Gain section, change the color to something with a pink/ purple hue 

(232,2,105). Go bad< to the layered Texture panel and give the second 

layer an alpha of 0 .5 or similar, and keep the blending on Over. 

By the end of all this, you'll probably have something similar to (Fig N), 

but the important thing here is that I really want you to continue playing 

around with all of the different settings inside Maya. For example, add 

some more layers into the Color channel, or define a better reflection 

map. In the end, the best way to learn is by exploring the pad<age. 

7. FINE-TUNING 

So, things are hopefully looking quite good by now. You 've 

learned a bit about Maya's workings, how to set up the blobby 

particles, and played around w ith creating a shader to reproduce the 

look of the Klingon blood. 

The one thing that still isn't correct is that there are still far too 

many particles. You may rem ember in the fi lm that there were only 
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MAYA- CONTINUED FROM PAGE 48 

a few drops of blood floating about. So, even though it's been useful 

having so many particles for prototyping, let's correct this now. 

Select emitter I f rom the Outliner, then in the Channel Box Edito r 

on the right hand side, change the rate to 2-3. A lso reduce the scale 

to something like I on x , y , z. You'll have to move the cam era in 

a bit closer, but you'll no doubt have something similar to (Fig 0 ). 

Also, w ith a bit of playing around with the dynamics of the par­

ticles, you can get it so that the two d rops of blood move together 

and merge into one (Fig P). CONTINUED ON PAGE 52 
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Procedural Texture. This is where the power of UghtWave really 

comes into its own, with the procedurally generated textures. I added a 
Ripple type (Fig 13), just to break up the surface a bit. 

One last quick touch that will really help sell it a bit further is to break 
up the color a bit with some darker shades. Press the 'T' button next to 
Color, and add a Procedural Texture again.! kept the Turbulence and left 
the default settings, but changed the color to a pinky shade (232,2,105). 
This will break up the surface color with a fractal pattern. Feel free to add 
some more layers, as it will only add to create more depth. 

After all that shading work, the blood should now look something 
like (Fig 14). Hopefully, you 'II feel much more comfortable now playing 
around with all the different settings in Hypervoxels. The best way to 
learn something is always to explore and experiment with what can 
be done. 

C 7. FINE-TUNING ) 
~~ ----------------------

By this stage, we should be looking pretty good. By now, you've 
found out how to apply Metaballs onto particles using Hypervoxels 
in UghtWave, and have applied a quick shader to approximate the 
Klingon blood. 

The only thing left to do is to fine-tune the look of the blood drops a 
bit. At the moment, there are way too many. This was good for proto­
typing, but in the fi lm you'll remember that there were only a couple of 
drops of blood floating about. This can be remedied easily enough by 
redudng the particle count, so let's go ahead and do that now. 

In the FX Browser w indow, select the FX_Property of the Particle 
Emitter. Reduce the Birth Rate down to something like 2, and also 
bring the Generator Size down to lm on x. y, z. A lso change the 

Particle Limit to around 2-3. Move the camera in closer a bit more, 
and do a test render and hopefully you'll have something similar to 

(Fig IS). If you play around a bit with the dynamics of the particles, 
you can set up a scene w here the two drops of blood appear to 
merge into one (Fig 16). CONTINUED ON PAGE 53 
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FIG 0- USE THE RELATIONSHIP EDITOR TO HOOKUP BOTH EMITTERS 

8. ONE STEP FURTHER 

So far, so good ... But, did you notice how circular and perfect 

looking the blood looked in Step 7? What about if we tr ied a 

different method that would not only look far better, but wou ld 

also g ive us much more control over how the two blood droplets 

came together? Basically, what we'll do is take it one step further 

and create two particle emitters (one for each drop). 

In the Outliner, select the emitter I object and duplicate it 

w ith (Ctri+D) o r Edit > Duplicate. Move emitter2 away f rom the 

fi rst, and do a test render. The second emitter isn 't rendering , 

r ight? This is because we haven 't g iven i t particles to emit 

yet. Remember. since the par ticles and emitters are separate 

objects, they need to be hooked up to each other. But the nice 

feature here is that we can link both emitters into the one 

par t icle object. 

Select Open Window > Relationship Editors > Dynamic 

Relationships, which is an editor where we can hookup dy namic 

relationships between objects, fields, emitters, and collisions 

(Fig Q). This is the true beauty of Maya - it's modular nature 

and complete customizability to nearly any situation. 

In the Selection Mode, highlight Emitters, and then with par­

ticle I selected, you 'll see emitter I already highlighted in orange. 

Click on emitter2 to link that one to it also. That's it; with a bit of 

f iddling with each emitter's parameters, y ou can create a nice 

animation of the two drops slowly moving towards each other 

(Fig R &. S). The individual particles for each emitter help to cre­

ate a m o re viscous look for the individual drops, and when they 

com e c lose to the other emitter you 'll see them slowly pulling 

on each other to complete the effect. 
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C B. ONE STEP FURTHER ) 
~·----------------------~ 

Let's take this technique one step further. Another good way you 

could improve upon the technique is to use separate emitters for each 

blood drop, g iv ing you complete control over the movement of the two 

coming together. This also has the advantage of making each droplet 

look more authentic, since the individual particles of each emitter will 

join together and break up the d rcular shape we had before. 

First of all, either create a second emitter with the FX_Browser again, 

or clone the first one (Items > Add > Gone). Move It away from the first 

and, if you want, animate the two emitters driving towards each other. 

I found that redudng the particle Generator Size helped to contain the 

individual particles of each emitter close to the center. 

Back in the Hypervoxels panel (fig 17), in a somewhat similar 

way to Maya's dynamic relationship editor, we're going to link the 

particle shader to the second emitter. You 'll see HVEmitter2 in the 

list on the left, and it's literally as easy as hitting Activate. An easy 

way to transfer over the same settings as the previous emitter is 

to simply click Copy and then Paste from the first to the second. 

A lternatively, you can save the shader and reload it. 

The important part here, however, is to create a Blending Group. 

This tells LightWave to include any emitters in the group for blend­

ing together. It's actually quite flexible, allowing you to specify 

additive, subtractive, or intersection. Create a new group and set 

it to additive, then make sure the other emitter is also included in 

that g roup. W ith this set, do a test render and hopefully everything 

should be working nicely (Fig 18 &. 19). 

As you can no doubt see, this m ethod works so much better than 

try ing to control everything with the one emitter , and g ives for a 

nicer looking result. SEE CONCLUSION ON PAGE 54 
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CONCLUSION CONCLUSION 

So there you have it. I was surprised to find out as I w rote this 

tutorial that there seemed to be more tools/windows to exp lain 

to new users of Maya (e.g. Outliner, Hypershader, Attribute 

Editor), whereas Lig htWave was a little more straig htforward 

(using only the Hypervoxels for most of the tutorial). In the end, 

though, I would say that an exper ienced user in ei ther pack­

age would complete the effect in roughly the same time, and I 

couldn 't recomm end either package over t he other. Ultimately, 

they all do the same things; it's just personal preference as to 

which 3D package you prefer. 

For the purpose of th is tuto rial, we just aim ed to make a single 

frame render , so I didn't touch on any factors concerned with 

making it look good when animated . I encourage you to try this 

now, if you've completed the tutorial, and expand you r learning 

of the program's features. 

There are many ways you could improve upon the effect, and 

I hope you' ll con tinue to go beyond the scope presented here. 

Perhaps try using a better reflection m ap. or set up a proper 

environment to reflect. Experiment with the material settings. 

m ake the surface more watery. maybe add an o ily fresnel ef­

fect , or give the particles random sizes ... Similarly, w hy not t ry 
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MAYA & LIGHTWAVE- CONTINUED FROM PAGES 52 & 53 

compositing the blood into live-action footage? Perhaps f i lm 

one of your friends p retending to be a Klingon floating against 

a makeshif t blue screen. The possibilities are endless. 

I hope this tutorial has been usefu l as a starting point for crossing 

over into either piece of sof tware. You've gotten over the hard part 

and taken that inevitable first step. Just remember - there are some 

people who put too much emphasis on this or that particular piece 

of software, claiming it to be superior to others. 

But. in the end, it's not the tools that make the artist, and a brush 

is only as good as the hand that wields it! • 

ALEXANDER SHAREEF HAS BEEN A PROFESSIONAL 
VISUAL EFFECTS ARTIST FOR THE LAST THREE 
YEARS, AND CURRENTLY WORKS AT BIOWARE CORP. 
IN CANADA AS A LEAD VISUAL EFFECTS ARTIST ON AN 
AS. YET-UNANNOUNCED PROJECT. HE WAS INSPIRED 
TO ENTER INTO 3D GRAPHICS AFTER WATCHING BAB­
YLON 5, AND IS COMPLETELY SELF-TAUGHT. THOUGH 
HE HAS USED ALL THE MAJOR 3D APPLICATIONS. 
INCLUDING MAYA, 3DS MAX, AND HOUDINI, HE PRE­
FERS THE ONE HE STARTED OUT WITH, LIGHTWAVE. 

HE MOVED TO CANADA FROM ENGLAND WITH HIS WIFE, AND IS FASCINATED 
WITH ANCIENT CULTURES SUCH AS ANCIENT EGYPT. 
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UVMAPPING 
A COMPLEX 
CHARACTER 

T 
his is my first article for HDRI 3D. I'm very excited about 
contributing to a magazine that concentrates on real pro­
duction solutions for those of us in the trenches. 

That being said, if you regard canned demos w ith skepticism, 
then read on. I'm going to deal with the nitty gritty of UV mapping 
in SOITIMAGE IXSI. 

UV mapping can be a difficult process for complicated characters 
and objects. The arbitrary topology of polygons is g reat for efficient 
modeling, but can create a real nightmare for the texture artist. I'm 
going to go through the process of mapping a full character while 
highlighting most of the cool features that the SOFriMAGE IXSI Texture 
Editor (fE) has to offer. 

First, I'll point out a few rules of thumb to keep in mind when UV 
mapping. Number one: Don't get too precise about every little point. 
It's best to be flexible in the early stages because most of your initial 
mapping will be combined in unforeseen ways and you can waste a 
lot of time tweaking too early. Number two: It's often a combination of 
tools that produces a good texture layout. Many times the first result 
of a tool isn't the best and we're too quid< to hit the old (Ctrl - Z) and 
decide the tool isn't up to snuff. I'm going to indude examples where 
several iterations and combinations of tools create g reat results quickly. 
Number three: Speed is obviously important. Be open to experimenting 
with the latest tools even when you have a decent workflow established. 
Many of the these tools can decrease your production time in a huge 
way if you spend some time getting to know them. 

To get started, I'll include a few quick notes about the map­
ping workflow In SOITIMAGE IXSI. The program synchronizes 

component selections in the 3D viewports with texture sample 
selections in the TE. This is a g reat feature, because you can 
make selections in the TE or use all the best selection methods for 
points, polygons, edge loops, range selection, etc., in the camera 
view. Whether selecting regions of geometry in viewports or 
sample regions in the TE, y ou can then create a sub-projection for 
that region. Sub-projections are represented by a texture support 
object that can be adjusted in the viewports. The resulting sample 
regions in the TE can then be merged with other sample regions to 
create a full texture layout. In this way, you can use the projection 
method that works best for each area of geometry and then piece 
it all back together. It's also a good idea to create polygon clusters 
for appendages and cohesive regions of geometry during model­
ing or before you start the mapping process. Using these clusters 
as selections can save lots of time. 

Now, let's get into mapping. First, we'll apply a phong material 
to the dragon mesh, attach the default image, and use an XZ 
planar map to get something going. Next, we'll set one of our 
views to the TE (Figure 1). 

We'll begin breaking up t he results of the initial planar 
projection by selecting the polygons on the top of the head 
and using a XZ world aligned planar sub-projection in the TE 
(Fig ure 2). There are a few overlapping edges in the creases, but 
we' ll clean that up later. Next, we'll use a few "best fit" planar 
pro jections for the sides of the head. "Best Fit" sub-projections 
are extremely useful for getting quick projections that are au­
tomatically o riented over the target area. Generally, the default 
orientation is good, but the support can be manipulated further 
fo r better results. Our sample region is rotated at an odd ang le, 
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FIGURE 1- FIRST XZ PLANAR PROJECTION 

FIGURE 3-- A COUPLE OF "BEST FIT" PLANAR SUB-PROJECTIONS ARE USED FOR THE SIDE OF THE HEAD 

for manipulating samples. We'll use 

several here. The first is Island Selec­

tion . This toggle selects contiguous 

sample points by selecting one or 

more components in a connected 

sample region . I t can be toggled on 

and off by pressing T' with the cur­

sor over the TE viewpor t. As always, 

getting to know the hotkeys in the TE 

w ill speed your workflow up tremen­

dously. and many hotl<eys are shared 

w ith similar functions throughout 

SOFT! MAGE IXSI. We'll select the jaw 

island we just created and use the 

"Island Heal to Picked'' (>) tool to heal 

the jaw region back to the side of the 

head. The region rotates, t ranslates, 

and heals in one step. Most often we' ll 

toggle on the scale option in the sup­

plied proper ty page. We'll repeat this 

process for the upper jaw (Figure 4). 

.. ' +!u+ . 

FIGURE 4- THE REGIONS ARE HEALED TOGETHER USING THE "ISLAND HEAL TO PICKED" TOOL 

Another useful feature is the Relax 

UVW tool. Relax attempts to adjust 

the area of the samples in the TE to 

be closer to the physical geometry. 

This reduces distortion caused by the 

mapping process. Our eyelid region 

has some overlapping samples, so we 

so we'll rotate the texture support in the camera viewport to get 

better alignment in the TE (Figure 3). 

In addition to pro jections. the TE contains many great tools 

select the points and press (Ctrl - R) to 

relax them. Relaxing samples after pro­

jection can be very effective, and using it once we've got larger 

islands glued together can fix a lot of problems all at once. To 

correct overlaps that don't relax well, we can move the sam ples 

in the TE with (Shift - m) to keep the samples together. 
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FIGURE 5- MOVE POINT TOOL USING CAMERA VIEW AS A GUIDE 

Let's move on to the eyelids using a 

"Best Fit" planar sub-projection (Figure 

5). Everything looks good except for 

a spot on the upper border. Using the 

camera viewport as a guide, we'll fix 

this using (Shift - m) to rearrange the 

points. We repeat this process for the 

eye socket, apply the Relax tool to 

the result, and use the ''Island Heal to 

Picked" tool to merge the socket island 

into the center of the eyelid island. Fig­

ure 6 shows the result with one level of 

subdivision surface enabled. We repeat 

this process to heal the eyelids back into 

the head region. 

FIGURE 7- TWO ROWS OF POLYGONS ARE SELECTED IN THE CORRECT ORDER 

Now let's tackle the tentacle-like 

projections on the back of the head. Until recently , this area of 

geometry would have fit into that "What the hell w as I think­

ing?" category. Not only do the tentacles undulate in space, 

they twist down the length, making the polygons hard to select. 

This was previously a major time commitment to a very small 

portion of the model, but now we have one of my favorite tools 

in the TE, the Contour Stretch sub-projection . As the name 

implies, this projection type stretches like a rubber sheet over 

a roughly rectang ular selection of polygons. The new Range 

Selection feature will also make selecting two sides of the 

tentacle a snap. 

Since the tentacles form a cylindrical patch, we'll leave out a 

row in our selection and pick it up when we're done. The Con­

tour Stretch tool requires discreet bo rders to work correctly . We 

quickly define our polygon region, click the tool using "Walking 

on the Mesh," and then rig ht-click in a viewport to end the pick 

session. The tool will do its best to create a good layout without 

user input, but in this case it failed. Let's try again . This time 

we'll define the boundaries by clicking the points at each corner 

of the rectangular region (Figure 7). Now we've got a g reat 

layout in the TE. It's important to click the boundary points in 

the right order so that the tool knows which corner comes after 

the next. Also, sometimes it's easier to visualize the corners in 

wireframe. A handy keyboard shortcut in the TE is (Ctrl - Shi f t 

- A) to deselect all. It's often hard to see what's selected in a 

complicated mesh and time consuming to deselect samples 

with the rectangular marquee. 

For the last row, we' ll use the same tool. Since this region is 

close to a perfect rectangle, the region is laid out automatically. 

Now we'll use a few more tools to get these regions healed. We 

can 't use "Island Heal to Picked " because ou r row connects to 

both sides of the main tentacle island and we'll get over lapping 

polygons in the result. Projections often rotate the samples at 

incorrect angles. In this case, ou r row is rotated 90 degrees. 
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FIGURE 10- GROWING A SELECTION AND PICKING THE CORNERS FOR THE CONTOUR STRETCH TOOL 

point and polygon selections. In ad­

dition to selecting several points at a 

t ime, polygon selections only select 

the samples within them. If you select 

a region of polygons in the viewports 

or in the Tf. and t ranslate it, the region 

will detach as a separate island. This 

also works in the Tf. with the Move 

tool. So, in the previous operation, 

if we use polygon selection, we can 

quickly separate the incorrect regions 

so they can be re-mapped (Figure 10). 

In addition , if you have a selection you 

are trying to re-map and it just won't 

We'll correct this by pressing the ··r" key once to rotate the 

reg ion 90 degrees clockwise. The colored connectivity tags on 

the region boundary give us a good visual indicator as to which 

edg es match up. We use standard transform keys to scale and 

translate the row r ight up against the boundary of the main 

ten tacle reg ion . Now, we can select the boundary poin ts to heal 

and press (Ctrl - Shift - (number pad) +) (Fig ure 8). 

As you have probably noticed , picking the borders of a re­

g ion can be d ifficu lt w i th twisting o r complex geometry. Som e­

times the Contour Stretch tool creates less than perfect results, 

but we can sti ll use them (Figure 9). The main tentacle island 

looks good except the ends have overlapping points. Instead 

o f star ting over, we can isolate the incorrect rows of polygons 

and use "Best Fit" p lanar projections or another Contour Stretch 

projection to get a better lay out. Then we can " Island Heal to 

Picked·· these areas back into the main island. To aid in this sort 

of repai r , there is an important d ifference in the Tf. between 
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let go, you can isolate the selection by 

clicking the '"Show Selected" icon in 

the Tf. toolbar or use (Shi ft - h). This 

tool isolates your selection so It can be moved of f of its current 

location without dragging connected poin ts. To unhide, click 

the ··show All'" icon or (Ctrl - Shift- h) and you 'll see that your 

selection is now an independent island ready for re-mapping. 

We duplicate the same process for the rest of the tentacles 

and horns and then move on to the mouth region. Here we'll 

use "Grow Polygon Selection .. (Shift +) to get the right area 

defined. We start with two polygons roughly in the center of 

the area we want to select and then grow them out to get all the 

folded su rfaces of the gums and roof of the mouth. We'll then 

deselect the rear area to keep i t clean and the dragon ·s r ight 

side. We're sticking pretty much to the left side of the head 

because we'll be using a great UV symmetry script at the end 

to mirror things over. 

Now we'll use the Contour Stretch tool to g reat effect. We have a 

roughly rectangular area selected in the roof of the mouth. We use 

I 
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'Walking on the Mesh," select the corner points (Ctrl - r) twice to relax a 

few times, and this is the result (Figure II). I even missed a few polygons 

and the result is still pretty good. Impressive. Most impressive. There 

are some overlapping polygons in some of the tooth sockets, etc., but 

a few touchups with some localized relaxes and tweaks with the Move 

tool and it's done. The final step is to get the region back into its original 

U shape. We'll enable proportional modeling and use the Move tool to 

shift the front portion over with a nice smooth falloff (Figure IZ). 

As mentioned before, when using sub-projections to break regions 

up, the results are often misaligned, rotated, or even flipped so that 

they don't heal back together correctly . "Best Fit" projections com­

monly create this sort of problem, but there are several tools to help 

get things back on track. Using the Rotation Transform is an obvious 

choice. The "r" key pressed several times is also a quick way of get­

ting selections rotated into position. Flipped islands are common and 

can be flipped horizontally or vertically using Ctrl (numpad) I and Ctrl 

(numpad)- respectively. Aipping is often the culprit when getting 

bizarre results from an "Island Heal to Picked" operation. The colored 

tabs on the borders of islands help to sort out these problems, but 

specific attachment points can sometimes be hard to visualize. A 

good tool to use when trying to find that specific shared point and the 

direction borders are running is the 'Vertex Bleeding" toggle icon in 

the TE tool bar. 

In Figu re 13, we've selected the last row of the gums, used 

a "Best Fit" planar sub-projection, p ressed "r " twice, and scaled 

the select ion. Points selected on our new island with the "Vertex 
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Bleeding" toggle ON automatically 

selected shared points on the previ­

ous island so you can see the con­

nections. just remember to turn this 

back O FF, as it can really mess things 

up. We heal the regions together 

and we're done with the roof of the 

mouth (figure 14). 

Now let's jump into some of the 

larger regions of the body. I'm not us­

ing previously saved polygon clusters 

in case you're the poor sap in charge 

of texturing a character that doesn "t 

have any. We'll select a polygon ring 

in the center of the neck using range 

selection . We'll grow these polygons 

out a bit and deselect the unwanted 

ends (figure 15). Next, we'll use a 

"Best Fit" cylindrical sub-projection 

and adjust the texture support in 

the camera viewport (figure 16). We 

vertically scale the result and move it 

off to the side. 

The dragon has a fairly complicated 

torso. To get the selection started, 

we'll select a single polygon in the 

ribs region and grow this selection 

out. To clean up this selection, we'll 

use the Paint Polygon tool by press­

ing F I I while in Polygon Component 

mode. Using the r ight mouse button , 

we deselect the upper legs, portions 

of the wing. and other unwanted 

polygons to form a roughly rectan­

gular area (f igure 17). just in case the 

roof of the mouth wasn't impressive 

enough, let's use a Contour Stretch 

projection on this region. We'll need 

to select the corners to get a good 

result (f igure 18). A couple of relaxes 

and a few move point tweaks and 

we're almost done with the torso. 

Our nolcon image shows that the UV 

flow is pretty good except under the 

arm (fig ure 19). A really quick way to 

correct this problem is to select the 

distorted polygons, use a ''Best Fit" 

planar projection, and "Island Heal to 

Picked" to merge them back in (figure 

20). We can use this method to spot 

correct any area that needs some 

extra work. 
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Before we move on to the append­

ages, let's select the half of the body 
we're not concentrated on and most 
of the wings. We'll create a cluster, 

press Enter to pull up the Cluster 

Property page, and rename it to hide. 

Now, press the "h" key and hide the 

cluster. Anytime we want to add or 

subtract from this cluster we can 

select some polygons, (Ctrl - click) 

the hidden cluster, and click t he + or 

- button in the edit panel. This gets 

a large portion of the character out 
of the way so we don't keep running 

into it w ith the camera. Clusters are 

a great way to save collections of 

polygon selections for later use. If we 
select a cluster and (Ait - right-click) 

and select members/components, the 

components that make up the cluster 

w ill be reselected. We can then add o r 

subtract the polygons we need for a 

particular task. 

FIGURE 19-AN AREA OF DISTORTION TO BE FIXED UNDER THE ARM 

Now we'll select a rectangular patch 

on the leg by growing polygons and 

cleaning up the result like we d id on 

the neck. We'll deselect a row of poly­

gons running down the inside o f the 

leg and use the Contour Stretch tool 
(f ig ure 21). As usual, this tool takes a 

FIGURE 20- THE AREA IS FIXED USING A PLANAR SUB-PROJECTION AND ·ISLAND HEAL TO PICKED• 

very rough rectangular patch and does 

a great job. We'll run the same process 
on the row we left out and heal them 

together (fig ure 22). The ankle region 

is a good p lace to make a break to 
reduce distortion, so we'll select out 

the bottom of the region in the TE us­

ing polygon selection, move it down, 

and relax the two regions separately 

(fig ure 23). Looking over the leg. the 

knee needs some work. Let's select out 
the polygon rows making up the knee 

region and use a cylindrical projection 

on it. We adjust the projection in a 

viewport so that the seam is consis­

tent with the rest of the leg. Then we 

scale and move the region so that i t 

FIGURE 21- CONTOUR STRETCH SUB-PROJECTION USED ON THE LEG 

overlaps the lower portion of the leg 

and heal them together (fig ure 24). 
After correcting some overlaps in the TE, we're ready to finish 
off the top of the leg and re-map the claw pro jections. We'll 
select the top of leg and apply a "Best Fit" planar projection 
(f ig ure 25). The Relax tool is great at fixing regions that have a 

lot of stretching at the edges. We'll rotate the planar projection 
a little to the left to favor the skin fold and then use the Relax 
tool (Fig ure 26). Now we just have to tweak one point and heal 
this section to the main leg region . 
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FIGURE 23- THE LEG ISLAND IS BROKEN INTO TWO PIECES USING POLYGON SELECTION AND RELAXED 

PROJECTION AND HEALED BACK IN 

FIGURE 26- THE PLANAR MAP SUPPORT IS 
ROTATED SLIGHTLY TO THE LEFT AND 

THE REGION IS RELAXED 
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Next, we'll use Contour Stretch 

projection on the first claw region . 

Once we have these areas laid out, it's 

not very clear how they fit together. 

Here we can enable Vertex Bleed­

ing ro clearly see the contact points 

(Figure Z7). We repeat the process on 
the next claw. Generally, the default 

type of Contour Stretch projection 

called "Walking Along the Mesh" 

works the best, but there are instances 

where "Regular Quads" works better 

(FigureZB). 

Let's move on to the feet. We' ll start 

with a cylindrical projection on the big 

toe (Figure Z9). We've got some over­

lapping polygons because the scales 
have been included in the model. The 

best way to handle this sort of thing is 

to pu ll out the overlapping polygons, 

run relax on them, clean up the edges 
w ith the Move tool , and heal them 

back in. In addition to this, we'll clean 
up the edges of the holes so that 

healing is even better. Keep in mind 

that the points are averaged when 

healed, so we'll overemphasize the 

scaling of the polygons on both edges 

before healing (Figure 30). For the tip 

of the toe, we'll use a "Best Fit" planar 
projection, relax, and heal it back to 

the main toe region. 

This is a good time to bring up 

repeating elements. If you are 

modeling and texturing your char­

acter, you can save a lot of time by 

jumping into the texture process a 

little earlier. SOFTIMAGE IXSI has the 
ability to carry over UV clusters when 

merging geometry. Now I don't have 
a problem with most people's toes, 

but I don't like doing extra work. 

Ideally we would have textu red this 

toe before duplicating it to form the 
others. We'll go through that process 

now. Let's delete the second toe - (Ait 

- right-click) to extract (keep) the first 
toe- and move it into place (Figure 31). 

Now we merge the two meshes, select 

M erge All Attributes in the property 

page, and we're done. In the UV map, 

the fi rst and second toe are perfectly FIGURE 30- THE SCALES ARE SEPARATED, RELAXED. TWEAKED. AND HEALED BACK IN 
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loops and moving points around, the 

UV map wi ll be fine. 

Now we'll separate the wing surfaces. 

The very first planar projection we ap­

plied will work well for most of the wing 

surfaces and the back of the dragon. It's 

going to be tricky to get just the right 

se.lection on all these overlapping planes, 

so we'll create clusters that we can edit if 

needed. Let's select the top surface first 

and create a cluster. We'll press E.nter as 

soon as the cluster is created to open 

its property page and rename it to top 

main wing. Next, press the "h" key to 

hide the cluster to get it out of the way. 

This makes selecting the other side much 

easier. To get into areas that are hard to 

reach, we'll temporarily invert the mesh 

(Figure 33). We'll go through this process 

for all the surfaces. Hiding the surface 

clusters reveals any missed polygons. 

just select these - (Ctrl - select) the ap­

propriate cluster, click the "+" in the edit 

panel and hide the cluster again. Once 

we're done w ith this, we can use the 

d usters to select our regions in the TE. 

(Figure 34 Next page). Selecting a cluster 

isolates its region in the TE.. We'll select 

each cluster and move its region to a 

new location. Then, we'll select the mesh 

and arrange the result by mirroring the 

bottom halves, rotating , and translating 

where needed. 

Next, we'll use cylindrical mapping on 

the tail, duplicate the process we used 

on the leg to the arms, and we're ready 

for the final stages. Inevitably, there will 

be stray polygons and small regions that 

get left behind when rearranging in the 

TE.. For stray polygons, the fastest meth­

od is to use a "Best Fit" planar projection, 

see where the colored tabs show up in 

the TE., and use "Island Heal to Picked" to 

heal it back into its place. 

FIGURE 33-A WING CLUSTER IS CREATED AND HIDDEN. THE SURFACE IS INVERTED FOR EASY SELECTION 
The final stage is to scale the is­

lands to be consistent in texture cover­

age, mirror our UV layout, and arrange 

all the islands over the image in the TE. 

overlapped . We'll move the second toe over so it has its own 

texture space (Fig ure 32). SOFTIMAGE. IXSI is a very edit-friendly 

application . If we need to alter the toes by adding extra edge 
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like a jigsaw puzzle. We want to maximize this space as much 

as possible so that our texture's resolution is used to the fullest. 

To maintain consistent texture resolution across seams, we need 
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to scale the islands while looking at the 

model in a camera viewport. There are 

a couple of ways to go about mirroring 

our UV cluster. If the character hasn't 

been rigged, we can simply delete the 
dragon's right side and symmetrize the 

geometry on the left half over to the 

right and the UV cluster will duplicate 

automatically. If the character has been 
rigged, we can use the UV mirror script. 

This script works on the UV cluster only 

and doesn't affect the geometry. A few 

things to remember when using this 

script are to freeze your geometry, 

freeze your UV cluster, and get rid of 
extra UV clusters or you can get some 

strange results. A third method is to use 

the UV copy script. This script copies a 

UV cluster from one object and applies 
it to another overlapping object. It is 

especially useful if the geometry of 

the objects are different. Both of these 

scripts were wri tten by M ichael Isner 

and can be found at the Softimage 

Web site at http://www.softimage.com. 

Once we've mirrored the UV cluster, 
we can select the entire right side and 

horizontally flip the selected samples in 

the TE using Ctrl (numpad) /. We need 
to heal islands together that span the 

midline of the character. When this is 

complete we can fit our final layout 
together (Fig ure 35). 

FIGURE 34-ANOTHER CLUSTER IS CREATED. SELECTED CLUSTERS ISOLATE REGIONS IN THE TE 

Although I didn't use a unique UV 

projection type in this tutorial, I want to 

mention it because it can save a lot of 
time under the right conditions. When 

assigning the initial texture projection to 

an object, unique UVs is one of the types 

available. This projection can break up the 

polygons of the object using an ang le 

FIGURE 36- SELECT THE EDGES AND FORCE A BREAK BEFORE APPLYING THE PROJECTION 

g rouping option to form sample islands 

automatically. This works well for smooth 

surfaces. but requires a lot of clean up for regions with sharp angle 
changes and detail work. A good way to approach unique UVs is to 
select edges on the model and disconnect the geometry where you 
want to force a break before applying the projection (Figure 36). As 
you can see, the dragon would require a ton of clean up and much 
more time spent selecting the edges to get better boundaries. 

Lastly, objects can have more than one UV c.luster applied to them. 
This can be useful in mapping because you can create a separate 
unique UV projection and copy over the regions that work. ;. 

BILL BLAKESLEY, M.S. IS A MASTER DEGREED 
MEDICAL ILLUSTRATOR AND HAS OVER EIGHT YEARS 
OF EXPERIENCE IN 3D MEDICAL VISUALIZATION. HE IS 
EMPLOYED AS A MEDICAL ANIMATOR AT SHAW SCIENCE 
PARTNERS AND SERVES AS AN ASSISTANT ADJUNCT 
FACULTY MEMBER AT THE MEDICAL COLLEGE OF 
GEORGIA. BILL ALSO SITS ON THE ADVISORY BOARD 
AND CONDUCTS AN INTRODUCTION TO 3D ANIMATION 

AT AMERICAN INTERCONTINENTAL UNIVERSITY. HE CAN BE CONTACTED 
AT BBLAKESLEY@SHAWSCIENCE.COM. 
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H 
ello and welcome back. I want to discuss a workflow that I use, 

why I consider it to be very worthwhile especially for those 

on a deadline, and why I feel that as 3D artists, we all need to 

have compositing software in our tool box. My compositing software 

is Digital Fusion, but the ideas and techniques should be common to all 

compositing software with a little modification for tools and uses. 

Lets get sti!rted shall we? 

One common thing that most artists do at some point is try 

to do too much inside LightWave directly. This can resu lt in a 

few side effects - side effects like your rendering speed wi ll 

suffer, flexibility wi ll be removed, and just overall , a loss of 

control. For example, I will admit that ear ly on I did a spaceship 

f lying over a nebula heading toward a p lanet in a star sphere. 

Don't laugh- back then that was •the" thing to do. But here's 

w hat happened. On my blazing ly fast Amiga, these frames 

were taking 45min to render. I had over 600 f rames and only 

one computer - this was going to take a while! But I did an 

experiment. I rendered the background - the nebula, the stars, 

the planets- these elements together rendered in about ISmin 

a frame. Then the spaceship alone (rendering with an alpha 

channel) took Smin a f rame. I did the compositing in LightWave 

itself with the background sequence in the background, and my 

foreground w ith the alpha of the spaceship and that rendered 

in seconds a frame. Had my whole animation rendered in half 

the time! I was sold. 

I knew at that point that I needed a compositing application. Why? I 

was able to do the comp in LightWave, why get a second application? 

Let me explain something . 

In a toolbox owned by a mechanic, you'll see socket w renches, 

open end/box end wrenches, and probably a crescent wrench. 

What do all these tools do? They loosen nuts on bolts. That's it. 

But you mig ht ask: if they all do the same thing, why do you have 

all of them? Why not keep one, and get rid of the others? It's 

because they might all do the same thing, but some do it better 

in certain situations than the others. LightWave can composite 

- we all know this from the example scenes that ship with Light­

Wave; you can load in a picture of your house and put a flying 

saucer over it or park a super sports car in your driveway. Those 

are all examples of compositing. Notepad can write letters, but 

I wouldn't want to write a novel in Notepad. It doesn't have the 

tools, the formatting, and the spellchecking that a full word 

processor program w ill give me. Full compositing software will 

have tools that you mig ht have never thought about needing. 

Flexibi lity galore! 

Now, let's do some exploring of what control you will see. One 

thing that I wanted to do w ith this 'tutorial/discussion' is not what 

I see w hen you normally talk about LightWave and Digital Fusion. 

I very rarely render a specularity pass, diffuse pass, shadow pass, 

etc. Only time that I really do that is for a still, or print work. Anima­

tion I do in what I refer to as "element" passes. 
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W hat I 'm going to draw from is a recent project that I did 

for a client that involved some creative dissolve wipes that he 

wanted to be three-dimensional. To work this fully in LightWave 

is possible, but I did it in post because of the control that it 

allows me. 

OK - let's get started! 

First, I'm going to make a few assumptions. This is not a 

beginner tutorial on LightWave or Digital Fusion. So I expect 

you to be able to easily follow along simply by screenshots. 

Adding tools, adding masks, etc. is covered in the Digital Fusion 

manual. 

Let us set up a couple of things to get our elements for our 

compositing exercise. We're going to do a spaceship, specifically 

the Eagle from Space 1999, dissolving into a wireframe. 

What we need first is a background. You can pretty much 

choose any background you want, or create one of your own. 

The specific point here is that it's *only* the background. If this 

were a traveling animation, you would only render the anima­

tion of your backg round with nothing else. I created mine w ith 

a procedural texture on the inside of a sphere to make a nebula 

over a starfield. The tutorial for this is fairly well known, and can 

be found on the Internet. 

Now, we render our Eagle - and save this as a 3Zbit Image - I 

use TGA. One point of note: when you render your elements, make 

sure you render on a pure 0,0,0 black background. I have seen 

strange things when you don't - and it always does nice and happy 

w ith a pure black background. 

For the sake of simplicity, I changed my render from "Realistic" 

to "Wireframe" and re-rendered the Eagle. I saved this as a 3Zbit 

Targa as well. 
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Now for the creative parr. 

For the dissolve, I was not interested in a simple wipe, I wanted it 

to have character. I used Worley's ACID plug-in to create the wipe 

that I wanted. I have always found it easier to work with ACID by 

using a sphere that has a !-meter radius as an effector. I can see what 

r m doing easier. 

Now, w hat I have done is make the Ambient Light 100%, turned 

off Shadows, and m ade the E.agle pure white, w ith an ACID setting 

of pure black. I worked a little setting up an interesting broken edge 

for ACID, and thus my w ipe. 
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This I animated moving over the E.agle, and saved this sequence 

as a 32bit Targa sequence. 

OK - we now have our elements for our transition. Now, just 

notice this; three stills and one animation, and the animation is 

basically black and white - renders very fast. The point here is that 

it was really easy to get the elements; now, in Fusion, we're going 

to have som e creative fun. 

----·t"·· M~~~ ~~ ISSUE 4 

Open Digital Fusion. OK- pick your method for loading in our ele­

ments. Backdrop, Color, Wireframe, and our animation w ith ACID. 

OK, now, fi rst things first- need our Color E.agle to be over our 

background - grab and drag the output of the E.agle to connect to 

our Background- this wi ll set up the first stage of our comp . 

Now, we can look - simple, but realize- if we wanted to change 

anything - we have both elem ents separate. 

I 
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OK- now, our Wireframe goes on top of our color. Same kind 
of contro l. 

Now, here's the really neat part. We're going to use that sequence 
we rendered with AOD to dissolve the Ship from Color to Wlreframe. 

We need to add an effect mask on that last merge that we did. 
Right-click on the title of the merge and choose "BITMAP" under 
the "Effect Mask." Once that is open, drag and drop the "ACID" 
Loader to the "Drop Tools Here" area of the tool. 

Now, if we look at our output- well, nothing has changed. Why?? 
OH, look at the effect mask- it's using the "ALPHA" channel of our 
AOD animation. Well , that never changes. We have a few options 
here - Luminance would work - since we did a black and white 
render. Let's make that choice, and see what happens. 

Well , that works - but it's backwards to what we want. Well, we 
could reverse the Wireframe and the color - let's see. 

ISSUE 4 2-9~~~ ~D -.•=4=•:.a..__ 



Well, that's the right direction - but do you see the ··white 

outline" around our comp? Well, that's because the aliasing of the 

Wireframe made it just a slight bit larger. SO the first way was 

cleaner, but we need a better w ipe. Not to fear, that's why you're 

reading this article. You want to pick up useful tips, right? 

OK - put the flow back the way it was- but we're going to use 

a very cool tool in Fusion. It's called Channel Booleans. We're going 

to use this to make an Alpha channel, instead of Luminance to do 

our w ipe. It w ill also give us more control over any other effects 

that we want to follow the change. 

Hook up the Channel 

Booleans to the ACID 

for both foreground 

and background. 

Now, look at the controls. 

What we want to do is to 

··subtract'· the Luminance 

from the Alpha channel to 

make a new alpha channel. 

Now, if we drag the Channel Booleans into the "Drop Tools Here" 

part of the effect mask .. . 

_....,.... M~~a ~~ 1ssuE 4 

Now, that's what we wanted. 

OK - I was talking about 'flexibili ty' during this article. With 

a little understanding of how layering works, and w here to put 

the effect mask of our alpha, you can easily create other effects 

on top of the basic dissolve. 

By putting the Wireframe over a separate background of its 

own, with a transparent alpha- it's easy to use a "rays" effect in 

addition to the dissolve. 

I 
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I hope that this g ives you an idea of what is possible when 
you use a compositing application w ith LightWave or your 3D 
applicat ion of choice. The f lexibili ty, the ease of rendering, and 
the abili ty of 'creating after the fact' are all valid reasons for 
looking at a compositing application , and you can get all this 
w ithout having to worry about doing a specu lar pass, diffuse 
pass, etc. - just the layering of elements is enough. -. 

JACK "DEUCE" BENNEIT II IS A FREELANCE CGI ARTIST 
WITH A BACKGROUND IN PHYSICAL SPECIAL EFFECTS 
FOR MOTION PICTURES AND TELEVISION. DEUCE HAS 
BEEN WORKING IN THE FILM INDUSTRY HIS ENTIRE 
LIFE, AND HAS SUCH MOVIES AS ROBOCOP, LONE· 
SOME DOVE, AND JIMMY NEUTRON: BOY GENIUS TO 
HIS CREDIT, AS WELL AS TV SHOWS LIKE WALKER, 
TEXAS RANGER. DEUCE HAS BEEN USING COMPUT· 
ERS SINCE HE WAS 9, AND STARTED OFF WRITING HIS 

OWN GRAPHIC PROGRAMS. HE IS A UNIQUE COMBINATION OF PHYSICAL 
KNOWLEDGE AND VIRTUAL KNOW-HOW. 

RE-WRITING THE RULES 
-FACIAL ANIMATION 

BY TIM ALBEE 

T
he phrase, "nothing is perfect," seems to go double 

for 3D applications. We all slog through dealing with 

from th~~~i~a;:::~ven~~i~~~ tam ' ' 6 
to the "supremely frustrating." ~j 
W e're ar tists after all, not pro- mJ 
g rammers, and we're better off 

not moaning about things we 

can 't change, and just do our 

jobs, right? 

Wrong! Rather than "suck-up 

and drive-on," I made a wish 

list and got together w ith a 

programmer to make some 3D 

animation tasks easier, simpler, 

more elegant. 

See the full story behind the 

ensuing partnership and solutions 

www hdri3d.com/xtra/albee. ~ 
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We're always on the lookout for fast and affordable data storage. 
When we saw that Maxtor was releasing a new and improved 
250GB OneTouch drive, we couldn't wait to check it out. 

Portable and USBZ/ Firewire ready. Backups are as easy as pressing a 
button on your way out to lunch. But just how new and improved is it? 

You'll find our complete review 
of the Maxtor OneTouchTM II at 

www.hdri3d.com/xtra/onetouch .• 



L
uckily, there's usually more than one way to skin a cat. Most 

3D artists usually have one aspect of their software that 

they're better at than others. Your modeling is g reat and 

your texturing isn't bad, but you really have to work on your anima­

tion skills. Or maybe your animation is really solid, but you light the 

scene terribly. I've found that it's good to rely on applications other 

than your 3D program to get the job done. 

Let's face it: Nothing comes out of a 3D render engine in final form. 

There's always some compositing or adjustment in a paint program. 

Other programs can play a role in all sections of the production pipe­

line. If you're strong in another application besides your 3D program, 

why not use that to your advantage? That said, what follows is a simple 

tutorial where we'll create some displacement maps in Adobe After 

Effects, rather than UghtWave·s displacementTexture Editor. 

What? UghtWave's texture engine is g reat ... it whips up oceans, 

wormholes in spacetime, human skin, and a million other things really 

well. This is all true, but sometimes you'll find that you can achieve some 

fairly intricate animations with displacement maps animated in After 

Effects. Also, the layering options in the UghtWave Texture Editor are 

robust enough to allow you to use a little of both, if need be. 

We'll break this tutorial into several parts. First, we'll make a 

human artery in M odeler and create a textu re map for it inside 

Photoshop. Then , using that texture map as reference, we'll 

animate a d isplacement and bump map for the texture in After 

Effects. Why an artery? It seemed like a good idea, and medical 

modeling and visualization seems to be a field where you can 

rustle yourself up some work if you're pretty good at it. 

MODEUNG THE ARTERY 

The artery is just a simple cylinder that we'll bend in Layout with a 

couple bones. Figure I (see figure 1) shows the tube in Modeler. You 

have to make the mesh thick enough that it will displace well, but don't 

mal<e it too polygon heavy or you 'II never get your job done. I've settled 

for 20 sides and sixty segments. Don't forget to delete the polygons at 

~tf~a 3~ ISSUE 4 

FIGURE 2-ADD THEM BONES AND BEND THE TUBE OBJECT 

each end of the tube and subpatch the object, then send it into Layout. 

Draw a couple of bones and bend the tube a bit and you've got an 

artery (see figure 2). Note: we're not creating any earth-shatteringly 

I 
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SCREEN SHOTS CAN BE DOWNLOADED AT WWW.HDRI3D.COM 

FIGURE 4- BY SELECTING '(NEW)" INSIDE THE TEXTURE MAP SELECTOR, 
YOU CAN CREATE A NEW UV MAP FOR ANY SELECTED POLYGONS OF AN 

OBJECT. IN THE IMAGE YOU'LL SEE I'VE ALREADY CREATED A UV MAP 
CALLED 'ARTERY_ TEXTURE_01' 

FIGURE 5-- THE UV TEXTURE MAP DIALOGUE BOX PROVIDES 
A NUMBER OF OPTIONS WHEN INITIALLY CREATING A UV MAP 

SHAPES TO VARY THE WIDTH OF THE VEINS IN YOUR TEXTURE 

complex model here, or going into dllY bone deformation tips or tricks. 
We'll focus more on the displacement maps. Remember, the maps will 

work for dllY situation with some preplanning dlld texture/UV map­
ping. Bones aren't the only way to go, they just suit this subject matter 
dlld tutorial. 

TEXTURJNG THE ARTERY 

Back in Modeler, let's create a UV map for the tube (see figure 3). 
Select all of the polygons in the tube then, at the lower right corner 
of the Modeler interface, press the letter 'T'' dlld drag the texture re­
quester to "new" (see figure 4). In the UV dialog box that opens, name 
the UV map something logical, set the mapping to "Cylindrical," set 
the axis to "Z," and press "enter" to create the map (see figure 5). This 
isn't a UV mapping tutorial (and I'm still a bit of a novice at it myself), 
so this is pretty basic. We won't adjust the map at all. Actually, by the 
time we finish this process, the bit of stretching from the map is nice 
because it makes the textured arteries look a little more realistic on the 
sides of the artery wall. 

Using the UV map as reference (mine happens to be 915 by 915 
pixels), make a Photoshop file of the same size. Next, head to the 
wonderful world of the Internet. Flnd yourself a reference of arteries, 
drag them into a layer in your Photoshop document, dlld start painting 
your own arteries in dllother layer. Paint the arteries dark red dlld vary 
the weight of your brush as you go (see figure 6). Once you get a web 
of arteries that you're happy with, duplicate it dlld spread it out over the 

entire image. Duplicate that layer, dlld add a Gaussian Blur to soften the 

edges. Add a Gaussidll Blur to the first layer as well, not as powerful 
as the duplicate, but enough to soften dlly hard paint strokes. Make a 
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background layer, and make it a lighter version of that red (see figure 

7). That should do it for the artery layer; we'll add the rest of the detail 

inside UghtWave. Now, on to the animated displacement maps. 

ANIMATING THE DISPLACEMENT MAPS 

For this tutorial, I'm using After Effects 6.0 Professional without 

any third party plug-ins, but the concepts should apply to whatever 

animated paint/ compositing software you use (however inferior). 

Start off by creating a new comp. Make its dimensions 915 by 9 15 

pixels. We need a turbulent noise background to make the artery 

undulate constantly, but not drastically. Make a solid lay er (Layer 

> New > Solid). In the New Layer dialogue box that opens, make 

sure to hit the "Make Comp Size" button so that the solid is 915 by 

9 15 pixels. Apply the Fractal Noise plug-in to that layer (Effect > 

Noise > Fractal Noise). The Fractal Noise plug-in is the equivalent 

of LightWave's Procedural Texture Generator. If you're familiar 

w ith either, then getting used to the other won 't take long. 

Design is refinement, in my opinion. I'm showing you some settings 

in this tutorial, but in the end it's up to you. You 'll learn the Fractal Noi.se 

plug-in or the UghtWave Procedural Generator by playing around with 

them. Skip that lV rerun that you've seen eight times already. and put 

in some time with the prog ram. Or, just dial up some settings in either 

application and see what the plug-ins can do. Then, let it render while 

you watch Knight Rider episode 24 for the ninth time. 

Leave the default settings on inside the Fractal Noise plug-in and 

animate the Evolutions setting to create a slow undulating procedural 

texture. My entire UghtWave animation will be eight seconds (or what­

ever the doctor orders). Figure 8 shows the composition with just the 

turbulent noise layer applied. Since we're going to cylindrically wrap 

this texture, we don't want to see a seam. As it stands, the edges aren't 

going to match up. So, we'll use another After Effects plug-in to fix this. 

With the turbulent layer still selected, apply the Offset plug-in (Effect 

> Distort > Offset). It works the same as its Photoshop counterpart. It 

horizontally or vertically shifts the edges of a selected image. This way, 

the sides will now match when this texture is wrapped end to end. 

But what about those nasty seams running down the center (see 

figure 9)? To fix those, make a duplicate of the turbulent noise layer 

and remove the offset plug-in. Then, create a mask so that it just covers 

the seams of the image below it. Feather the mask and those nasty 

seams are gone (see figure 10). The very edges of the masked turbulent 

noise layer won't wrap perfectly, but if you mask the layer and feather 

it carefully enough, the result is almost imperceptible. If you do notice 

a little pixel aberration at the edge, you can always apply a soft blur in 

UghtWave's Image Editor. Also. remember, it's a displacement map, so 

as long as the seams aren't painfully obvious, you'll be OK. 

Finally, let's add a solid black layer over the top of the turbulent noise 

layers. This is an easy way to quickly lower the Luminance values of 

the turbulent layers. To avoid having the artery shake uncontrollably 

between heartbeats, set the solid layer at an Opacity of 70o/o to darken 

FIGURE 7- THE VEINS HAVE BEEN DUPLICATED AND SPREAD ACROSS 

THE TEXTURE. MASKING OFF DIFFERENT SECTIONS OF EACH DUPLICATE 

KEEPS THEM FROM ALL LOOKING ALIKE 

·-­·-·· . ··---... ··­·-··­- ·~ 

L;S "' 

FIGURE 8- JUST A LAYER WITH THE FRACTAL NOISE PLUG-IN APPLIED 

·-­·-~­. ··-"• ···­·-··­·~-··-·-­··­·-­., .... 
. :==~ 

FIGURE 9- THE OFFSET PLUG-IN HAS MADE THE EDGES OF THE 

IMAGE MATCH, BUT WE'RE LEFT WITH SEAMS CROSSING THE 

CENTER OF THE IMAGE HORIZONTALLY AND VERTICALLY 
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FIGURE 10- ON THE LEFT WE SEE THE MASKS WE'VE APPLIED TO THE 
TURBULENT LAYER WITH NO OFFSET. ON THE RIGHT WE CAN SEE 

THAT THE FEATHERED MASKS HIDE THE SEAMS QUITE NICELY 

0 

.-- masks 

FIGURE 11- USE THE PEN TOOL IN AFTER EFFECTS TO DRAW MASKS 
THATTRAVELALONG THE VEINS WE PAINTED IN PHOTOSHOP 

FIGURE 12- THE GRAPH EDITOR SHOWS THE ANIMATED START AND END 
VALUES OF EACH STROKED MASK. IN THE PLUG-IN DIALOGUE BOX ON 

THE RIGHT, EACH STROKE IS SET TO CONTROL A DIFFERENT PATH. NEXT 
TO THE "PATH" OPTION IN EACH ITERATION OF THE STROKE PLUG-IN, 

ANY MASKS DRAWN ON THE LAYER CAN BE SELECTED 

FIGURE 13- I'VE RENDERED THE STROKED VEINS ANIMATION AND 
DUPLICATED IT SO THAT IT COVERS EACH COPY OF THE VEINS I PAINTED 

IN MY TEXTURE MAP. USE A FEATHER MASK ON EACH COPY OF THE 
MOVIE SO THEY ALL APPEAR SLIGHTLY DIFFERENT 

the turbulent layers and keep their displacement to a minimum. Now, 

on top of the turbulent noise layers, we're going to create an animated 

bump map to compliment the image of the arteries. First, drag the tex­

ture we created of the arteries into an After Effects comp of the same 

size. Using the Mask tool, create a number of paths that travel along 

the arteries (see figure II). Once the masks are drawn, apply the Stroke 

plug-in (Effects > Render> Stroke) to the layer. Since we've drawn 13 

different masks along the arteries, we'll need to apply the Stroke plug-in 

13 times onto the same layer. Then, assign each iteration of the plug-in 

to a different masked path to control it. By animating the start and end 

values of each path, we can send a stroke traveling down the shape of 

the mask, kind of like blood coursing through an artery. It's also good 

to add a bit of Gaussian Blur to the entire layer and use the Simple 

Choker plug-in (Effect > Matte Tools > Simple 010ker) to smooth any 

rough edges. As shown in figure 12, you should stagger the place each 

stroke's keyframes start and stop on the timeline. This ensures that it 

looks like the stroke is traveling in a logical manner, through the bigger 

tubes and then branching off into the smaller ones. The smaller arteries 

get a smaller brush stroke applied inside the Stroke plug-in. 

Next, pre-render the animation shown in figure 12. Then, take that 

movie file and place it over the other arteries in the texture map. Since 

we've cloned the same painted arteries in the texture map, the bump 

movie will line up on top of everything (see figure 13). Once this comp 

is finished, drag it into the turbulent noise comp and set its opadty 

to a very small number (somewhere between 4- 10%) and then apply 

a Gaussian Blur. I want the veins in the displacement map to distort 

the artery lining a little bit, but I'm more interested in rendering out a 



FIGURE 14- THE DISPLACEMENT MAP IS ALMOST FINISHED 

FIGURE 15-WE CAN EASILY CONTROL THE SPEED OF THE HEART 
BEAT BY ADJUSTING THE SPEED AND FREQUENCY OF THE 

MASKS TRAVELING THE WIDTH OF THE TEXTURE MAP 

hig h-contrast black and white version of the veins movie to apply to 

the artery's bump channel inside the UghtWave Surface Editor. Fig ure 

14 shows a screenshot of the turbulent noise and veins. It's important 

to note that I don't break frame with the arteries in the image. You 

don't want to try to offset images that are too complicated. just make 

sure you spread out the arteries evenly in the texture and it will look 

evenly spaced when it's cylindrically wrapped. 
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FIGURE 17-THE TEXTURE EDITOR FOR THE ARTERY'S SURFACE COLOR. 
A PRETTY COMPLICATED TEXTURE COMPRISED OF THREE 

PROCEDURAL LAYERS AND A GRADIENT LAYER 

OK, just one more step for the displacement map: The heartbeat. It 

should travel the length of the artery and displace the geometry enoug h 

that we perceive some kind of pulmonary action happening. We'll use 

masks to accomplish this again. (You're probably starting to notice a 

pattern here; if you're an After Effects artist you already know how in­

valuable the masking tools are for just about everything. Now if Adobe 

can just get that cappucdno maker plug-in out of beta, the application 

will be perfect...) Make a w hite solid, then mask and feather it. Then, 

keyframe its position to travel the length of thecomp horizontally.ltwill 

tal<e a little rendering and experimenting to get the width and speed 

we want. The nice part is we don't have to apply the offset plug in to 

this layer because it's w hite, ensuring that the masked edges match up 

perfectly. Then, make a duplicate of the solid that travels the width of 

the comp a couple of keyframes later to simulate the little double beat a 

heart makes w hen it's pumping. Once you like the animation of the two 

layers, duplicate them and space them out according to how fast you 

want your patient's heart rate, and you're done (see fig ure 15). 

APPLYING THE ANIMATIONS INSIDE LIGHlW AVE 

Let's apply the textures and displacement maps inside of Ug htWave 

Layout. By play ing around with the surface setting and an image map, 

we can quickly cook up a pretty cool internal tissue texture. Start with 

one of the human skin settings that ship with UghtWave [8] (only 

available with LW [8] and up) and tweak it a bit. Figure 16 (see figure 

16) shows the artery with surface settings applied, but without texture, 

bump, or displacement maps applied. First, we'll apply the surface 

texture. In the Surface Editor, open the options for color and add the 

texture. The skin texture preset that we initially applied to the artery is a 

fairly complicated preset. There are already four different layers inside 

the Color Texture Editor (see figure 17). We'll add the skin texture as the 

second layer in the layer order (as shown in figure 18). 

I 
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TOWARDS THE BOTIOM OF THE STACKING ORDER 

The UghtWave Texture Editor has functions and mix modes that 
are very similar to l'hotoshop. Placing the textured image towards the 
bottom of the stacking order allows any other images or procedural 
textures higher in me order to affect it. figure 19 shows a render of the 
artery with the texture applied, but no displacement or bump settings 
applied. (Note: When we apply the texture, we're using the UV map we 
created earlier.) Use the same UV map with the bump map to ensure 
that everything lines up. 

Next, apply the displacement map to deform the object's 
geometry. Displacement mapping is accessed inside the object's 
Properties panel under the Deform tab. Clicking the ''T" button next 
to "displacement map" opens a texture dialogue box. Inside this 
box, we'll add the displacement sequence we rendered in After 
Effects, and use the UV texture we created to map it onto the tube 
(see figure 20). Back in the Properties panel, select the Geometry 

FIGURE 20- THE ARTERY DISPLACEMENT MAP IS APPLIED IN THE 
OBJECTS PROPERTIES PANEL. THE DISPLACEMENT MAP EDITOR IS 
NEARLY IDENTICAL (AND AS FLEXIBLE) AS ANY OF THE DIALOGUE 

BOXES INSIDE THE SURFACING WINDOW 

DIIPIO!Itloloiloll -latlon 

Rolllltr Hololloll -atloo 

FIGURE 21- MAKE SURE TO SUBPATCH THE OBJECT AFTER 
DISPLACEMENT IN ORDER TO AVOID UNPREDICTABLE 

DISTORTIONS IN THE GEOMETRY 

tab and set the subdivision order to ··occur after displacement 
mapping" (see figure 21). If we don't sub-patch our tube object last, 
the object's geometry can distort in unpredictable ways, producing 
surfacing errors (to put it lightly). 
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FIGURE 22- INSIDE THE SURFACE EDITOR'S BUMP CHANNEL 

WE'LL APPLY THE HI-CONTRAST MOVIE OF THE VEINS TO 

MAKE THE THEM APPEAR TO BE MOVING UNDER THE 

SKIN WHEN THE BLOOD PULSES THROUGH THEM 

DISPLACEMENT AND BUMP MAPS APPLIED 

Next, we'll open the artery 's bump channel inside the Sur­

face Editor and apply the high-contrast artery bump sequence 

(see figure 22). Again , by using the same UV map, we're 

ensuring that everything lines up correctly. In figure 23, you'll 

see the artery w ith texture, displacement, and bump maps 

applied . The bump amplitude we need for the arteries is only 

about .2%. Finally, as shown in figure 24. apply some grain to 

soften the CG look of the rendered image. If you don 't have 

any f ilm grain plug-ins, you can mix up a passable g rainy look 

in After Effects or Photoshop . Searching the Web for tutorials 

w ill turn up a lot of good finds and techn iques. Ah, the beauty 

of tuto rials. Remember, After Effects is pretty much Photo­

shop with keyframes, so don't w ri te off Photoshop tutorials if 

you 're an an imator; some translate into After Effects o r even 

the LightWave Texture Editor very well. 

So remember, there are always different ways to achieve results 

in LightWave by employing your skills from other programs. If it 

saves you time and looks good, then it's justified. After Effects 

adds that extra punch and details that will bring your 3D creations 

to the next level. Get going and figure out a couple of uses for 

animated displacement and image maps. Off the top of my head, 

here are a couple ideas: 

I) An intricate gel-like user interface that extrudes and recesses 

itself in a computer panel. 

2) A number of bullets o r punches deforming a metal door. 

3) A quick solution to leaving some footprints. 

4) Cracks exploding out from an impact and cracking up a tile floor. 

5) A set of speakers that vibrate and distort to an audio track. 

6) A company's logo or name in an interesting font appearing on a 

glass surface. 

7) The vein on a gambler's temple starting to throb during a high 

stakes card game. C 

NOTE: FEEL LIKE PLAYING AROUND WITH THE PROJECT? AARON'S PROVIDED 

THE PHOTOSHOP, LIGHTWAVE, AND AFTER EFFECTS FILES FOR DOWNLOAD AT 

WWW.HDRI3D.COM/RESOURCES 

AARON KENT IS AN AFTER EFFECTS AND LIGHT­
WAVE ARTIST WORKING IN NYC. DURING THE DAY HE 
WORKS AT A POST HOUSE CALLED VIZUALSOLUTIONS 
(WWW.VIZUALSOLUTIONS.COM) IF HE EVER GETS ANY 
OF HIS PERSONAL 3D WORK DONE, YOU'LL FIND IT AT 
WWW.SHIFTLESSDREAMS.COM. HE LIVES IN BROOKLYN. 



Time to upgrade? 
Welcome to Smedge 3, the next generation in 
distribwed processing. 

Rebuilt from the ground up, the next generation of 
Smedge provides unbeatable power and flexibility 
combined with incredible stability. All while 
maintaining the case of usc artists have always loved 
about Smedgc. And combining the power of your 
Windows, Linux and Mac machines will soon be a 
snap with the amazing cross-platform abi lities. 

For more information, please visit: 

http://www.uberware.neVsmedge3/ 

Uberware 
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ARTIST: CHARLI SIEBERT 
HUNTINGTON BEACH, CA 

METHODS : HEAD RENDERED IN POSER 4 AND 

DETAILS ADDED IN PHOTOS HOP 7 

TIME: RENDER: ABOUT 2 MINUTES 

CREATION: ABOUT 10 HOURS 

EDITOR'S NOTES: 

This is a good example of using 30 as a start, a means to an end that is different 
than the medium. I'd love to see the different stages of this creation to see the ele­
ments you used. I like the style of this, though it tends to flatten the frame a bit. 
Having some more depth to the face by adding falloff to the sides of the forehead 
and cheeks would be cool. Also, adding some falloff distortion to the images on the 
face itself would give more of a feeling of depth to the face; for example, warping the 
cheek images to bow back toward the black edges to bring out the cheeks a bit. But 
that totally may not be what you're going for; it's a purely subjective comment. Nice. 
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TITLE: ARSENAL'S FA CUP 

ARTIST: ALEX DINNIN 
SURBITON, SURREY, UK 

METHODS: XSI .. WITH BUMPMAPS AND 

DISPLACEMENT... A TAD OF COMPING IN 

PHOTOSHOP! 

TIME: RE OER: 15 MINUTES 

CREATION: 3 DAYS 

EDITOR'S NOTES: 

Metal is one of the harder surfaces (beyond skin) to light and 
render, and I think you've done a good job here. Artistically I 
wonder what the image is trying to say. That sounds 
pretentious as an observation; I hear every professor I've 
had in the back of my head, but diche or not, ifs true. I'd 
like to know if there is something that you are trying to say 
with the image beyond the nice lighting and rendering. And 
some of that could be said in the composition of the frame, 
how much you choose to reveal with light for example. On 
a pragmatic level, I wonder from where the magenta-tinted 
light is coming in the background to the right of the cup. I 
see a distinct shadow to the left falling on the floor/Wall, so I 
sense a key light coming from the right of frame front, but I 
do not get that sense from the cup itself. The key light should 
be stronger on the right of the cup than on the left; it is too 
even, otherwise you should see a similar shadow also falling 
on the right, and both less sharp. Nicely done. 



TITLE: DUSTMITE 
ARTIST: ERIC KELLER 

WASHINGTON DC 

METHODS: CREATED IN MAYA USING NURBS 
GEOMETRY, PROCEDURAL TEXTURES, 
AND PAINT EFFECTS BRUSHES. BASED 
ON AN ELECTRON MICROSCOPE IMAGE 
OF A DUSTMITE. 

TIME: RENDER: 2 MINUTES 

CREATID : ABOUT A DAY. MOST OF THE 

TIME ON TWEAKING TEXTURES 

EOITOR"S NOTES: 

Nice, I like the detail of focus, gives a nice macro-depth 
to it. I get the sense I'd like to see more of a contact 
between the legs of the bug and the skin of whatever 
it's standing on, the filthy thing. But I buy it, since I 
don't regularly look at microscope footage as a general 
rule. An interesting frame, and a well-executed scene, 
with a very fast render time, mostly based on textures, 
perhaps surface shaders and some incandescence 
mapping. The foreground of the skin he's standing on 
seems to be as soft as the horizon of it; it would be nice 
to see a bit more of the depth of focus work on the skin, 
where you see more in focus closer up than you do 
back there. Helps the depth of field. 

TITLE: SURPRISING MOMENT 
ARTIST: GUNTHER HEINRICH 

STUTTGART, GERMANY 

METHODS: SOFTIMAGEJXSI AND PHOTOSHOP FOR 
COLOR CORRECTION. 

TIME: RENDER : ABOUT 3 HOURS 
CREATION: 3 WEEKS 

EOITOR"S NOTES: 
Awesome. It reminds me of my friend's paintings, Rebekah 
Waites, whom I met on a bus trying to soore a date with on 
one particularly curious afternoon after class. Struck out, 
but she's cool as hell. Anyway, what I liked about her style 
is a subtle warping of how things actually look, and I see a 
lot of that in this frame. The hair looks great, and is lit very 
well with nice subtleties coming from the rim light. The baby 
texture is very nice with a strong sense of a painterly effect 
without being a painterly effect, so I am not judging it on a 
photorealistic level (which is a high bar indeed to clear). Eyes 
are cool, as is the slightly warped expression on the baby's 
face. I really think the harsher lighting you have here sells 
it, with the middle fairly dark and brighter highs on the right 
side of his face. The noise on the skin around the shoulders 
seems a bit much and I'd love to see some translucence in 
the thin cartilage of the ears. Overall, I would be very winded 
to find this as an oil painting. Maybe Rebekah should get off 
her baby fat ass and do a baby like this in oils. 
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I WANT MY HDTV 
BY BRAD CARVEY 

H DTV has been coming 

for a long time. 

Some people would say it has been around 

for a long time, since, officially, it became 

a standard in the late 1990s. Actually, there 

are two standard formats ( 1080i and 720p) 

currently being broadcast, but only a small 

number of viewers are able to watch the 

higher resolution format ( 1080i). 

About ten years ago, I dragged 

A ndrea to NAB (National Association 

of Broadcasting convention). NAB hap­

pens once a year in Las Vegas and is 

the most important tradeshow for video 

in the United States. At the time, there 

were competing standards for High 

Defini tion TV. some of w hich were much 

better than what we have now. One of 

the booths that we passed displayed a 

large fi sh tank. There were lots of very 

coo l fish swimming around in it. We 

approached the fi sh tank to get a better 

look. When we attempted to look at the 

f ish from the side, we realized that it was 

a HD Monitor. I had never seen anything 

like it before o r since. 

Here in my lab, I do have an HDTV 

setup. Well. at least it's kind of an HD 

TV setup. To watch a movie in the 720p 

format ( 1280 X 720 pixels), first I need 

to take my 3.2 GHz Pentium computer 

out to the living room, and connect the 

computer 's analog RGB outputs (using a 

hand built cable) to my GE projector. 

Next, I have to calibrate the 10-year-old, 

(in projector years that's about 100 years 

old), 500-pound projector. I am getting 

pretty good at this and usually can be 

ready to watch a movie in about an hour. 

Then, I go to my DVD collection and try 

to decide which HD DVD feature film I 

want to watch. Fortunately, this does not 

take long. because there is only one HD 

feature fi lm available on DVD (that I know 
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of). My HD DVD collection is complete 

but limited. Looks like I wi ll be watching 

Terminator II: judgement Day (Extreme 

Edition) again. This DVD is encoded using 

M icrosoft's WMV encoder and requires a 

fast computer to playback smoothly. The 

DVD includes the higher resolution HD 

1080i format, but I would need a lot of 

new equipment before I could watch that. 

The movie looks and sounds g reat, but 

unfortunately it is already obsolete and 

may be the only featu re film ever released 

on a WMV DVD. 

Most of the "HD Ready" television 

sets that I see at places like Best Buy 

are touted as HD ready, but are not able 

to actually display a standard HD video 

signal. They are ready but not able. You 

can spend thousands of dollars on an 

"HD Ready" TV that can on ly display 

1024 x 768 pixels. These monitors claim 

to be 16:9, but 1024 x 768 is 4:3, w hich 

has a ratio of 1.33333, in other words. 

the width is 1.33333 times wider than 

the heig ht. HD 720p is 1280 x 720 and 

has a w idth that is 1.7777 times wider 

than the height. We could also consider 

sq uare and rectang ular pixels and make 

things even more complicated. The 

manufacturers choose the words "HD 

Ready" carefully. At Best Buy, the most 

expensive HD Ready TVs are able to 

display the 720p fo rmat ( 1280 x 720). 

but none of them could display the 1080i 

( 1920 x 1080) format. 

But take hear t, things have started 

to change for the better. Comcast is 

starting to offer HD Ready DVRs (digital 

video recorders). At a reasonable price. 

you can watch and record HD broad­

casts on NBC, CBS, ABC, and PBS. The 

Comcast DCTS 100 High-Defini tion Cable 

Converter lists 1080i as one of its output 

resolutions. NBC (and I assume, the 

other networks) broadcast in both the 

1080i and 720p formats. The good news 

is that the networks are ready for the 

"Full Featured HD" TVs. Apple is pushing 

to make it easier for everyone to make 

HD movies, and all new Apple comput­

ers suppor t editing and playback of HD 

movies. Quicklime 7.0 w ill support H D 

formats, when it comes out in the next 

few months, and w ill support H.264, 

which is the standard that has been ap­

proved for the consumer HD DVDs. HD 

camcorders are still too expensive for 

most consumers, but they are getting 

better and cheaper. 

As a dig ital artist, it is about time to 

start thinking of creating conten t for HD. 

QT 7.0 Pro for $29.95 wi ll allow the digi­

tal artist to encode and distri bute their 

v ideos to mainstream consumers, w ho 

will use QT 7.0 player to v iew the HD 

v ideos. I expect to see a big explosion of 

HD content over the next few years. 

I w ill be happy w hen I can have it all, 

an HDTV that supports 1080i, a consum­

er HD DVD player, an HD Camcorder, 

cheap HD DVD rentals, and the Comcast 

HD DVR. Personally , I want my HD TV.~ 

BRAD AND ANDREA CARVEY HAVE BEEN 
DOING COMPUTER ANIMATIONS FOR A LONG 
TIME. IN 1969 BRAD USED AN ANALOG COM­
PUTER. WHICH WAS THE SIZE OF A CAR, TO 
PRODUCE HIS FIRST COMPUTER ANIMATION. 
ANDREA, AN ARCHEOLOGIST, PREFERS TO 
DO SCIENTIFIC ANIMATIONS; HER CRED­
ITS INCLUDE PROGRAMS LIKE DISCOVERY 
CHANNEL'S UNDERSTANDING CARS. BRAD 
IS AN ELECTRICAL ENGINEER AND AN EMMY 
AWARD-WINNING MEMBER OF THE VIDEO 
TOASTER DEVELOPMENT TEAM. HE PREFERS 
TO DO FEATURE FILM WORK. HIS CREDITS 
INCLUDE FILMS LIKE MEN IN BLACK, STUART 
LITTLE, BLACK HAWK DOWN, KATE & LEOPOLD 
AND MASTER OF DISGUISE. 



GfET FOCUSED! High Quality. DVD-ROM. 60+ hours. 

with the 

Training from the author! 

From NASA to the US Army, to NBC and FOX, to hobbyists, 
people around the globe are finally understanding 
the power of LightWave® 30. See for yourself why 
the 30 Garage'" courseware is rated the 
best training you can find . 

Download free tutorials now at 30 GARAGE.com 
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